RR-Track™

for Windows™

M.T.H. RealTrax™ Edition

Advanced graphical sectional track
layout software

version 3.02
Produced by:
R & S Enterprises
POB 643
Jonestown, PA 17038
(717)865-3444
©1994 - 1997 R & S Enterprises, all rights reserved

First printing, June 1999




RR-Track™ for Windows™

release 3.02

Table of Contents

INTRODUCTION ...ttt ittt iiiteteeneeeeseaseseassssassosenssssnssesannas 5
GOALS vt ottt e 5
WHAT’S NEW FOR RELEASE 3.02 . . o oo e e e e e e e 6
TERMINOLOGY INRR-TRACK . . . oo e e e e e e e 7
SYSTEM REQUIREMENTS . & o o o oottt e e e e e e e e e e e e e e e e e e e s 8
INSTALLATION INSTRUCTIONS . .+ & ottt et e et et e e e et e e e e e e e e ettt e 9
INSTALLING RR-TRACK . ..o o oo 10
GETTING STARTED ...ttt iiiiitiitteeeeneeeeeaaseneeneensensensannnns 13
TRACK LAYING TUTORIAL . .« v v e e et ettt e e e e e e e e e e e e e e e e e e e 13
WINDOWS, MENUS, AND DISPLAY S .. ittt iiietteneaereeneseananans 29
RR-TRACKT WINDOWS . .« o vt et ettt e e e e e e e e e e e e e e e e 29
TRACK AND SYMBOLS IN RR-TRACKT | . . e 32
USING THE MOUSE .« « .+« ettt e e e e e e e e e e e e e e e e e e e e 33
RR-TRACK MENUS . . oottt e e e e e e e e e e e e e e e 35
TRACKLAYING PROCEDURES. . ...t ittt it iieteetnaeeneaneennennanss 49
ALIGNING TRACK SECTIONS . .+ e o e ettt e e e e e e e et e e e e e e e e e 49
BREAKING A SINGLE TRACK JOINT . .« oot et ettt et e e e e e e e 52
CHANGING THE LAYOUT SIZE . .« « « « e e e et et e e e e e e e e e e e e e e 53
CHANGING THE DRAWING ORDER . . .« « « e e et ettt et e e e e e e e e e e 53
CHANGING THE WORKING TRACK FAMILY . .+« o e e ettt ettt e e e e e e e e e e e e 54
CLOSING A LOOP OF TRACK . . « « « o e e e et e e e e e e e e e e e e e 54
COPYING TRACK . .+« « « v ettt e e e e e e e e e e e e e e e e e e e 55
COPYING TRACK BETWEEN LAYOUTS . .« « « « e e e ettt e e e e e e e e e e e e e 56
CREATING ,CHANGING, AND REMOVING DRAWING LAYERS . . « « « o e oo eeeee e ee e 56
CREATING A NEW TRACK LAYOUT . .+« « o e e ettt et e e et e e e e e e e e e e e e e 60
CREATING A TEXT LABEL . .+« « t et e et et e e e e e e e e e e e e e e e e 61
DELETING TRACK OR OBJECTS . .+« o e oo oottt e et e 62
DESIGNATING ISOLATED ELECTRICAL BLOCKS . . .« « « « e e e e et ee e et 62
DUPLICATING TRACK AND OBJECTS . . .« « « « e et e oo e e e e e e e e e e e 64
EDITING OBIECTS . .« o oo oo oo et e e e e e e e e 65



FINDING OUT LAYOUT INFORMATION . « « « « e e e et ee e e e e e e e e e e e e 72
FINDING OUT TRACK AND OBJECT PROPERTIES . . « « « « e e et e eee et e e e e e e 72
GROUPING AND UNGROUPING OBJECTS - . « « « e e e e e e e e e e e e e e e 73
JOINING TRACK SECTIONS -+« e e e e eee e et e e e e e e e 74
LOCKING AND UNLOCKING TRACK AND OBIECTS .« « « « e ettt e e et e e e e 75
MEASURING DISTANCES ON THE LAYOUT « « « « « e e e ettt e e e e e e e e e e e e 75
MOVING TRACK AND OBIECTS -« « « e e e e ee et e e e e e e e e e e e 76
MOVING ITEMS BETWEEN LAYERS . . .« « « v e e te e e e e e e e e e e e e e e e e 77
OPENING AN EXISTING LAYOUT .« « « e e et eee e e e e e e e e e e e e 78
OVERPASS TRACK . « « « + + e e e e e e e e e e e e e e e e e e e e e 78
PASTING TRACK INTO THE LAYOUT . « « « « e e e e e eee e e e e e e e e e e e e 79
RELAXING MISMATCHED TRACK . . « + + « e et e e e e e e e e e e e e e e e e e e e e 80
ROTATING TRACK AND OBJECTS . « « + + e e et e e e e e e e e e e e e e e e 81
SAVING A LAYOUT FILE . . . v e ettt e e e e e e e e e e e e e e e e e e 84
SELECTING TRACK AND OBJECTS .+« « « e e e e e e e e e e e e e e e e e e e e e e e e e e e e 85
SETTING GLOBAL OPTIONS . . . &\ttt et e e ettt e et e e e e e e et e e e e e e 87
SETTING LOCAL LAYOUT OPTIONS « « « « « « e e e e et e e e e e e e e e e e e e 90
SETTING JOINING ERROR . . « « « « e e e e e e e e e e e e e e e e e e e e e 92
SETTING OBJECT PROPERTIES . . « « « v v oo e e e et e e e e e e e e e e e e e e 93
SETTING TRACK COLORS . « « « + « e et e e e e e e e e e e e e e e e e e e e 94
SWAPPING SWITCH MACHINES .« . « « « v v e e e e e e e e e e e e e e e e e e e 94
TEARING OFF MENUS .« « « « e e e oo e e e e e e e e e e e e e e e e 95
UNJOINING TRACK SECTIONS .« « « + e e e e e e e e e e e e e e e e e e e e e 96
ZOOMING IN OR OUT ON THE LAYOUT « « « « « v e e e e e eee e e e e e e e e e e e e e e 96
PRINTING LAY OU T S ittt ittt tttttteeennnneoeaeeeeeeeeeeeeesnnnnnnnnnnas 99
SETTING UP THE PRINTER . « « + « e e v e e e e e e e e e e e e e e e e e e e 99
CONFIGURING THE PRINTER PAGE LAYOUT .« « « « « « e e e e ee e e e e e e e e e e e 99
PRINTING YOUR LAYOUT . .+« « v e e e e et e e e e e e e e e e e e e 100
PRINTING TIPS '+« vt e e e et e e e e e e e e e e e e e e e e e 103
MISCELLANEOU S & ittt iiiitttttttteeeeeeennnnnaesseseeeeeessnnsassssaaanans 104
TRACK LIBRARY INITIALIZATION FILES . « « « « v vt oe e e e et e e e e e e e e e e e e e e 104
TIPS AND SUGGESTIONS ..ttt iiiiiiiitteeeeeeeeeeeeeeeeeannnnnnnnnnans 105
MANUAL TRACK JOINING TIPS .+« « « + e e et e e e e e e e e e e e e e e e 105
RELAXATION TIPS . .« o e e eeee e e e e e e e e e e e e e e e e e e e 106



GENERAL TIPS« « « o e e oo e e e e e e e e e e e e e e e e e e 107

APPENDIX ...ttt ittt teeeaseeeaoseeeaseeonsscansseanasaassns 109
TUTORIAL ON CUSTOM CURVE DESIGN . . .« v vt e et ettt e e e e e e e e e e e e 109
CREATING BENCHWORK . « « « + « e et te e e e e et e e e e e e e e e e e e 111
SOFTWARE LICENSE . ..ottt ittt tiieeeeeeeeseeeaseeansssanasans 114






Intr oduction

Thank you for buying RR-Track™ for Windows™, advanced sectional track layout software for
the Microsoft Windows™ 3.1, Windows 95, and Windows NT operating systems. RR-Track™
can lay out sectional track from a wide variety of manufacturers in three-rail ‘O’ gauge, three-rail
standard gauge, two-rail ‘G’ gauge, two-rail ‘S’ gauge, two-rail ‘HO’ gauge, Marklin ‘HO’ gauge,
two-rail ‘N’ gauge, two-rail ‘TT’ gauge, and two-rail ‘Z’ gauge. This is accomplished by way of
the Windows™ graphical interface, allowing you, the designer, to manipulate track sections on
your PC’s display just as you would on the layout. RR-Track is designed as a layout tool for
constructing toy electric train layouts, but is just as, if not more useful, for considering “what if”
situations in existing layouts, both indoor and outdoor, as well as “dream layouts” that are likely to
never see the light of day.

Goals

The principal goal of RR-Track is to enable anyone to quickly, easily, and accurately create a track
layout for toy trains from the principal building blocks, sectional track. Whether the layout be a
simple Christmas display looping under and around the Yule tree, or a complex miniature railroad
consisting of hundreds of pieces of sectional track connecting whimsical towns, village, factories
and farms, it can be designed with RR-Track. RR-Track turns any Windows-based PC into a
sheet of electronic graph paper, allowing for endless combinations and what-if scenarios without
involving messy erasures and clumsy templates. The major advantage of computer-aided-design
(CAD) is that the computer’s drafting table is infinitely erasable and re configurable. Further,
layout drawings may be saved at intermediate points in the design process, making retracing your
steps to an earlier stage fast and easy.

In the course of design of your toy train layout/model railroad you will rapidly discover that it is
much quicker and easier to ‘game out’ track configurations using RR-Track and your PC than to
discover, on the floor, that O-72 curves won’t quite fit between Grandma’s antique china buffet and
the Xmas tree. If the track doesn’t fit in RR-Track, then it won’t fit on the layout. All of the
sectional track in the track libraries is accurate to less than 0.1 inch, making accurate assessments
of clearances and distances easy.

RR-Track supports HO-gauge (16mm) two-rail sectional track from manufactures such as Atlas® ,
Marklin®, and Pilz/RailTech, O-gauge (32mm), three-rail, sectional track from Lionel® and
K-Line® ( O and O-27),Curtis HiRail,Ross Custom Switches, and GarGraves® Trackage. G-
gauge (45mm), two-rail, sectional track from LGB®, AristoCraft®, andMicroEngineering® is
available, and wide-gauge (54mm), three-rail track from Lionel® and Rydin Industries. There are
also libraries for TT-gauge track from Pilz, for N-gauge track from Atlas® and Kato®, and Z-
gauge from Marklin. Any and all of these may be included in one track layout, accommodating
designs which call for mixing various gauges. There are also accessory libraries available for
Lionel® pre-war, post-war, and modern items, American Flyer post-war items, Plasticville® O
and S-gauge accessory items, and Pola® buildings in G-gauge, with other accessory libraries



planned for the future. If your favorite track manufacturer is not available yet, it will probably be
available in the future.

What's new for release 3.02

(1) Multiple document interface: RR-Track™ v3.02 lets you have multiple layouts open for
design simultaneously. This greatly facilitates cutting and pasting between layouts and quickly
creating variations of a given layout.

(2) Layers. Layouts can incorporate up to 64 distinct, named layers (previous versions of RR-
Track used only one drawing layer). You may assign these layers attributes such as working,
active, inactive, grayed, and hidden; as well as assigning default drawing colors for any layer.
Layer attributes may be changed at any time; layers may be added and deleted as needed. Multiple
layers allow you to create very complex layouts without having to view the complexity all of the
time.

(3) Editable objects. All general purpose drawing objects (lines, circles, rectangles, polygons,
trees, boulders, etc.) are now editable. You can alter their sizes and shapes at will after creating
them, as well as scale the sizes of grouped objects. This makes it very easy to draw objects such as
buildings and benchwork as accurately as you like.

(4) Improved printing. RR-Track now lets you choose the printer used by RR-Track without
having to resort to the Windows Control Panel; you may preview where RR-Track will place the
layout on the page. You also have the option of printing your layout to a fixed scale rather than
letting RR-Track automatically scale the layout to the printer page(s).

(5) Multi-function status bar. RR-Track’s status window has been replaced by a multi-function
status bar that shows the cursor position, zoom factor, and lets you quickly access the extended
selection and joining modes, the working layer, the snap state and snap size. The multi-function
status bar also provides access to a list of the last 10 distinct items added to the layout (this is a
generalization of earlier versions of RR-Track which remembered only the last item added).

(6) Drag-and-drop client. RR-Track now register’s itself with Windows as a drag/drop client.
This means you can drag track layout files from the File Manager or Explorer to the RR-Track icon
to open them. You may also open layout files by double-clicking on them from either the File
Manager or the Explorer.

(7) Track library wizards. Most track libraries contain ‘wizards’ which may be used to automate
some aspects of track laying, automatically filling gaps between track ends.

Many other incremental changes have been made from version 3.01 which correct a number of
annoying bugs, and aid the layout design process.



Terminology in RR-Track

active layout or current layout: this refers to the track plan you are presently working with.
RR-Track can have many layouts open at once, but you can only work on the one that is active.
You can switch between layouts, changing active layout at any time by clicking anywhere on it.

block breaks: these are electrical breaks between track sections that are otherwise physically
joined. Block breaks can be either hard or soft. Hard block breaks cannot be removed and are
introduced by using special track from the manufacturer that is insulated at one or more rails. Soft
breaks are breaks that you can set with RR-Track and are usually achieved by either using insulated
connecting pins or rail clamps, or just not having any joining pin or clamp at that junction (there is
no insulation like no insulation).

credits box.: The credits box is a small box printed below your layout view that contains the file
name, date and time, the layout size, the number of track, accessory, and objects the layout, and the
layout scale. The credits are always printed using Arial Bold at 10pts.

drawing depth: The drawing depth is the vertical distance, in feet and inches, of the area you are
allowed to lay track and place objects.

drawing width: The drawing width is the horizontal distance, in feet and inches, of the area you
are allowed to lay track and place objects.

edit points: edit points are the ‘corners’ of a general purpose object that may be moved in order to
resize it. Lines have two edit points (each end), rectangles have four edit points (each corner), and
polygons have an edit point at each vertex.

elevated track: Elevated track is track that is at a non-zero height adjacent to one or more track
sections that are also at the same non-zero height.

extended selection: Extended selections are track sections that are either physically, electrically
joined to the track section under the cursor, or on the same grade or at the same height.

general purpose object: A general object is a shape such as a line, rectangle, polygon, or circle.
There are also specialized general purpose objects such as buildings, trees, ponds, and boulders.
Track sections are not general purpose objects, neither are accessories. General purpose objects
may be grouped to form a more complex object.

grade track: Grade track is track that is at non-zero height and adjacent to one or more track
sections at a different height, usually also non-zero. This track is marked by an arrow symbol to
indicated that is on a grade, with the arrow pointing in the uphill direction.

layer: a drawing layer consists of objects and track that are grouped for the purposes of display.
Layers can be working, active, inactive, grayed, or hidden. There can be only one working layer at
any given time.



lead selection: This is the first item in the selected track list, indicated by bolder control points
symbols. The lead selection in the select list may be changed by clicking the left mouse key will
holding the cursor over the track section you wish to move the origin to.

shorthand menu: this is a menu containing the most commonly used commands in RR-Track and
is called up by clicking the right mouse button.

selected track: Selected track is any and all track sections or other objects that are highlighted in
red on the current view of the current layout.

selection box: The selection box is the rectangle swept out by the cursor when selecting track.

select list: The select list is a list of all track sections and objects that are selected (highlighted) in
the current layout. The lead selection is indicated by bolder control point symbols.

spin buttons: small push-button type controls with up and down arrows. Pressing these allows you
to increment or decrement an associated numerical field by a fixed amount.

track control point: these are the ‘ends’ of the track section to which other track sections may be
joined. A straight or curved track has two, a simple turnout three, and a cross four. Up to six
control points are allowed in RR-Track.

track list. The track list is a list of all of the track sections, types, and quantities that are in the
current layout.

zoom factor: This is the amount by which a view has been magnified compared to the original, full
view of the layout set when the width and height were set. The minimum zoom is 1, showing the
full layout, while the maximum is 64.

System Requirements

RR-Track 3.02 requires the Windows™ 3.1 operating system in order to run. It will not work
under Windows 3.0 since it makes use of dialogs in the Windows™ common dialog library
(COMMDLG.DLL) which is not available in the 3.0 release of Windows™ (although you may
possess it via a third party), and makes use of a number of printer commands which were intro-
duced in the 3.1 release of Windows™. RR-Track is compatible with Windows for Workgroups
3.11, Windows 95, and Windows NT Workstation using either the standard shell or the v4.0 shell.
Under Windows 95 or NT RR-Track enables long filename support.

Hardware: 386/486/Pentium PC, math co-processor suggested for 386 PC’s, but not required.
RR-Track makes extensive use of floating-point arithmetic for track translations and rotations.

Software: DOS 3.x or higher, 5.0 or above recommended. Microsoft Windows™ 3.1 in enhanced
or standard mode, or higher versions of Windows as discussed above.

Fixed disk space: standard release 1.7Mb+ depending on the number of track and accessory
libraries, and example layouts (which are optional on installation). This can range up to 7Mb.



Graphics board: VGA (640x480) or better, at least 16 colors. An accelerated card will speed up
drawing of straight lines segments, but is not likely to enhance curve generation. We recommend
800 x 600 super-VGA as a minimum for adequate viewing of your designs.

Monitor: color highly recommended.
Pointing device: Microsoft Windows™ compatible mouse or trackball, bus or serial.
Installation Instructions

RR-Track is normally distributed as compressed files on a single 3-1/2 inch, 1.44Mb capacity
diskette. This format has become the standard for IBM compatible PC’s. If you have special
requirements, such as 5-1/4 inch 1.2Mb or 600Kb floppy diskettes, please contact R&S Enterprises
to make special arrangements.

File List: Full release

RRTRACK.EXE
RRTRACK.HLP
RR3LIB.HLP
RRTRACK.INI
MUSCROLL.DLL
CTL3DV2.DLL
TEAROFF.DLL
SPINNER.DLL
EFFECT3D.DLL
FADER.DLL
README.WRI

the main application executable
the companion help file

the track library help file
application initialization file
support library for custom controls
support library for custom controls
support library for custom controls
support library for custom controls
support library for custom controls
support library for custom controls
last minute release notes and instructions

one or more of the following track libraries

RR3CHRGG.DLL
RR3RCS.DLL
RR3GGRV.DLL
RR3REGO.DLL
RR3027.DLL
RR3SPRO.DL
RR3MTH.DLL

RR3ATLSO.DLL

RR3AMF.DLL
RR3STD3.DLL

RR3LGB.DLLL
RR3MEC.DLL
RR3ARIST.DLL
RR3LLGS.DLL
RR3TDV.DLL

RR3ATLAS.DLL
RR3MARKK.DLL

0O-gauge
Curtis HiRail O-gauge track library
Ross Custom Switches O-gauge track library
GarGraves® O-gauge track library
Lionel® O-gauge track library
Lionel® 027 gauge track library
LLionel® Super-O gauge track library
MTH O-gauge track library
Atlas O-gauge track library

S- and standard gauge
Am. Flyer/GarGraves/Am. Models S-gauge track library
Lionel®/Rydin standard gauge track library
G-gauge
GB® G-gauge track library
MicroEngineering® G-gauge track library
AristoCraft® G-gauge track library
Llagas Creek G-gauge track library
TDV s.s. G-gauge track library
HO-gauge
Atlas® HO-gauge track library
Mirklin®-K HO-gauge track library



RR3MARKM.DLL
RR3MARKC.DLL
RR3PZ100.DLL
RR3PZ83.DLL
RR3KATO.DLL
RR3HRBHO.DLL
RR3PCOHO.DLL
RR3SHNHO.DLL

RR3ATLN.DLL

RR3KATON.DLL
RR3PECON.DLL
RR3TOMXN.DLL

RR3PZTT.DLL

RR3PECOZ.DLL
RR3MKLNZ.DLL

AC3LNLPR.DLL
AC3LNLPO.DLL
AC3LNLMD.DLL
AC3GLBRT.DLL
AC3MTH.DLL

AC3PLSTC.DLL
AC3PIKOG.DLL

AC3POLAG.DLL

Mirklin®-M HO-gauge track library

Mirklin®-C HO-gauge track library

Pilz code 100 HO-gauge track library

Pilz code 83 HO-gauge track library

Kato® UniTrack HO-gauge track library

Hornby® OO/HO gauge track library

Peco® HO gauge track library

Shinohara® HO-gauge track library
N-gauge

Atlas® N-gauge track library

Kato® UniTrack N-gauge track library

Peco® N-gauge track library

Tomix N-gauge track library
TT-gauge

Pilz® TT-gauge track library
Z-gauge

Peco® Z-gauge track library

Mirklin® Z-gauge track library
Accessories

Lionel® pre-war accessory library

Lionel® post-war accessory library

Lionel® modern accessory library

Gilbert/American Flyer accessory library

MTH accessory library

Plasticville accessory library

Piko® G-gauge accessory library

Pola® G-gauge accessory library

and the track library initialization files, xxxxxxxx.INI.

Installing RR-Track

RR-Track 3.02 comes with an installation program, SETUP.EXE, on the distribution diskette. The
SETUP application asks you questions, and takes care of the details of installing the application
files in the appropriate directory on your fixed disk, and, optionally, sets up an appropriate group in
your Program Manager (PROGMAN.EXE). The following example assumes that your floppy
diskette is in drive ‘A’ while your fixed disk is drive ‘C’ (NOTE: SETUP is a Windows applica-
tion and cannot be run from either DOS or a DOS shell in Windows):

1. Insert the distribution diskette into floppy drive ‘A’.

2. From either the Windows™ File Manager or the Program Manager, start the setup application,
SETUP.EXE, on the distribution diskette. From the Program manager this may be accom-
plished by pulling down the File menu and selecting Run.... In the Command Line box type
“a:\setup.exe” and press the OK button. From the File Manager this may be accomplished by
pulling down the File menu and selecting Run... as with the Program Manager, or by opening
up a directory-file list window, setting it to drive A, and double-clicking with the mouse on the

SETUP.EXE file.
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3. A window appears, such as that to the right. Press the Continue button to start the setup
process. The RR-Track setup utility is similar to that you have seen for other software, leading
you step-by-step through the installation process. At any time you may go back and change
something, or abort the setup process. After pressing Continue, RR-Track Setup prompts you
for an installation directory, and suggests
C:\RRTRACKS3 for the installation directory. If
you do not want to install RR-Track into this
directory, either type in another, valid path, or
press the button to the right of the text box. This
will let you browse through the directory tree on
your PC, similar to the Windows™ Open File
dialog. Using this browsing tool, click on the
folder that you wish to install the RR-Track folder
in. When you are satisfied, press
the Continue button. If you wish to abort the
installation at this point, press Cancel.

4. The installation program copies all of the files in the file list to the installation directory, and
then asks you if you wish to create a Program
Manager group for RR-Track (if you are using Windows 95 or Windows NT 4.0, this will also
create a Start Menu entry). If you do, press Create, otherwise press Skip (you can also tell
Setup to install RR-Track’s icons in an existing group, using the scrolling list window to select
another group). Setup will report the success or failure of the installation, and then you may
exit.

5. The first time you run RR-Track, you will be prompted to enter the serial number from your
installation diskette. RR-Track then registers itself in the Windows Registry. If you have any
need to contact R & S Enterprises concerning your RR-Track installation, be sure and have
this serial number handy. You can find out your serial number by either referring to your
installation diskette, or by pulling down the Help menu and choosing Help|About.. The
ensuing dialog shows the release number, the building number, and your serial number.

Acknowledgments
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Getting Star ted

RR-Track is started by (1) double-clicking its icon in the Program Manager (or whatever Windows
shell you use), or (2) by double-clicking RRTRACK.EXE in a File Manager directory listing, or
(3) by using the Run... command in either the File or Program Manager. For more information on
starting applications, see your Windows 3.1 manual. You may also start RR-Track by double-
clicking on a .RRT file in the File Manager/Explorer, or by right-clicking on said file and choosing

Open.

A number of windows are created when RR-Track starts: the main window, track list window,
select list window, and the status bar. Not all of these are initially visible; initial visibility is
determined by the settings in the RRTRACK.INI file, which are themselves set from the RR-Track
main menu, and are remembered between sessions. RR-Track has two distinct sets of options,
those that affect every layout you open (things like joining defaults, confirmations, default back-
ground colors) and things that affect a single layout (snap settings, extended selection mode
settings, track labels, etc.). More information on the settings in the initialization file can be found
in the chapter on miscellaneous material. In this manual, some of the dialogs and windows you
will see are shown as they appear under Windows™3.1 while others are shown as they appear
under Windows 95; this is so that you are familiar with the appearance of RR-Track under both
Window’s shells.

At startup, RR-Track displays a picture of a toy train layout, and a menu bar with File on the left
and Help on the right. The File menu has three items, New..., Open..., and Exit. Select New... to
start a new track layout, Open... to open an existing layout file (such as one of the example files
included on the distribution diskette). The function of Exit is obvious. The Help menu has items
for Contents, Search For Help On..., Getting Started, and About RR-Track. Selecting Contents
will open up the RR-Track hypertexting help file and show the table of contents, Search will open
up the help file and display the help search dialog, while_Getting Started opens up the track laying
tutorial.

Track laying tutorial

In order to get started building your own layout, the following tutorial will guide you through
building an oval of track, and then editing it to include a turnout and spur. Following this, we will
expand the layout vertically. Finally, we will add and then remove an elevated

track / grade combination from the layout.

If you are reading this, you must have RR-Track running, and are probably staring at a roughly
drawn image of an old steam locomotive or a train layout. The menu bar at the

top of the main window, in this case, will have two entries: File and Help. Pull down the File
menu and select New. This action pops up the Drawing Size dialog. Using the spin_buttons, set
the width of the layout at 10 feet and the depth at 7 feet. When this is done, press the OK button
with the mouse cursor. To give yourself the maximum screen space to work in, press the maximize

13



button on the new layout window. At this point the main window will change to look something
like:

EERR Trackv30 . [T We will build an
Bl Fe Edt Acion o Mies e i Wiep Onme Wides BE5

oval out of
Lionel® O-gauge
three-rail track, but
you could just as
well build the oval
out of LGB®
track, Atlas® HO
track, or any of the
other track
libraries. Pull
down the Library
menu and select
Lionel® O-gauge.
A check mark will
be placed next to
this item, indicat-
.| ing that Lionel®
R A G | 7 ‘O’ is the current

track library. Pull
down the Options menu and verify that Detailed Track Render is checked. If not, select it so that it
is checked. While you have the Options menu down, verify that Selections Include Joints is
checked. Ifitis not, select it so that it is checked. Then, pull down the Options menu and select
Options.... The dialog shows the state of all of the options that apply to all layouts. Check and
make sure the Auto-close Loops option, found in the upper left corner, is checked, as well as Allow
Track Breakaways , Auto-join track , and Proximity joining. Choose Layout options... to bring up
a dialog showing the options you previously manipulated using the Options menu as well as others.
Verify that Detailed Track Render, Label Track, Grade Symbols, and Block breaks are set. At this
point you are ready to begin laying track.

Next, pull down the Track menu and select O-Straight|Single from the list of straight track sections
available. The cursor will change to a diagonal arrow with either the word ‘ Autojoin’ below it.
Without depressing the left mouse key, move the track to somewhere in the lower left region of the
layout, then depress and release the left-mouse key (this depressing and releasing of the left-mouse
button is termed ‘releasing the track’). A straight track will now be drawn at this point with label
‘0:s10’, while the cursor returns to the Windows™ arrow. Repeat this process, except use the Last
Track command from the Track menu to get another piece of 10 inch straight track. Bring this near
(within 12 inches) of the previous track section, depress and then release the left mouse key. The
new piece of track immediately attaches itself to the first piece, forming a combination of two
straight pieces. Again, repeat this process, but this time get the track section by first clicking the
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right mouse button, with the cursor over nothing, to bring up the shorthand menu, and then use the
cursor and click the left mouse button to select Last Track. Bring the new piece near the first
combination, then depress and release the left mouse button, adding the third track section to the
first two. Next, move the mouse cursor to a point on the screen where it is not over a track section,
and double-click the left mouse button. You will see another straight section of O-gauge track
appear under the cursor. Move this to one end of the other three track sections and let it go so that
it automatically joins to them. Finally, go down to the status bar, put the cursor on the button
labeled ‘Lionel O single straight” and press the button. You will see yet another section of O-gauge
track appear under the cursor. Move this to the end of the four track sections and join it to them.
At this point the screen should look something like this:

You have assembled five pieces of

J track using all five ways of calling
1 | up a new piece of track (Track

" i 2k S MenulO-Straight|Single, Track

Menu|Last Track, Shorthand

Menu|Last Track, left mouse double
click, and multifunction status bar last track list.). Now we tackle building the first curve. We will
build a semicircular (180°) curve out of four sections of O-31 track. Pull down the Track Menu
and select O-Curve|O-31 left, bring the left side of the curve down near the right end of the straight
combination and release it, automatically joining it to the other three sections of track. Double-
click the left mouse button with the cursor in a blank area, giving you another O-31 curve, bring
the new curve’s left side near the right end of the previous curve, and release, joining the curve to
the previous five track sections. Repeat this process two more times, giving you four O-31 curves
in all, joined to form a semicircle. The layout should now look something like this:

If the layout does
not look similar to
that in the figure,
look back through
ca the previous section
and see what you
left out. If the last
track section was

=51 joined in an errant
manner (which is
any manner that is
not the way you

<t wanted) you can

: 5 5 T 5 F select the Undo last
= track item on the
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shorthand menu and remove the last piece of track (pop this up by clicking the right mouse button
when the cursor is over nothing).

Pull down the View menu and select Show Track List. The track list window should say you have
five Lionel® O 10 inch straights and four Lionel® O O-31 curves, eight pieces in all. For your
information, both left- and right-hand curves are identical; they are both included to make it a bit
easier for you when you are placing new pieces of track. Left- and right-hand turnouts are not
identical, needless to say. If you do not have five straight sections and four curves, please add/
delete track sections as necessary. When finished, you can dismiss the Track List Window (by
double-clicking on the control menu in the upper left hand corner).

N,OW pul.l down the View menu and S.eleCF Show Selects
List. This window should have nothing listed because no | §jLionei® o 0-31 curve 45° 4.7 izl
track items are selected. Move the cursor over one of the ~ |¢ *Lien=i® S single straight - 30.0in

straight sections and single-click it. The select list window | Total of 9pieces
should now show one O-gauge 10 inch straight. Move the ;‘;miﬁ;;’; E“C;Q'”
cursor over another of the straight sections and double-
click the left mouse button. All nine of the track sections
should highlight at this point, with the Select List Window showing five straight and four curved
sections. Keeping the cursor ver the straight track section, double-click the left mouse button. The
highlighted track returns to the one straight section, which is reflected in the Select List Window.
You can close the Select List Window now, and deselect the highlighted track by single-clicking
the left mouse button in a blank area of the layout. An important item to note is that you moved
between choosing a single track section and choosing all of the connected track sections simple by
single-clicking or double-clicking the left mouse button. Many times you are interested in
carrying out some action on individual track sections, while at other times you want to grab the
entire, contiguous set (for moving or rotating as an example). The ability to move back and forth
between these capabilities is controlled by whether you single-click or double-click on a track
section when selecting it. Single-clicking selects only the item under the cursor, while double-
clicking selects that track section and all of the others that are joined to it in some manner, either
physically, electrically, or in elevation (this is determined by the Selections Include Joints /
Selections Include Blocks / Selections Include Grades items on the Options menu). This is called
extended selecting. The current extended selection mode may be found by either (1) pulling down
the Options menu and checking for a checkmark next to one of these items, or (2) by watching the
multifunction status bar. <<>> It is a good idea to get in the practice of glancing at the status bar
from time to time to check on the state of these features since they control what happens when you
double-click the left mouse button.

We are going to complete the oval by using five more straight sections and four more curves, as
you would expect. This can be done in several ways. The most straightforward would be to repeat
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the process just carried out by serially selecting four more 10 inch straights and four more O-31
curves. A faster way, the one we will use, is to:

(1) copy the existing track,
(2) paste it back into the layout,

(3) rotate it 180°,

(4) join it to the first cane-shaped set of track, and then

(5) close the track loop.

We can merge the first two operations, if desired, by Duplicating all of the track in the layout.

We start by selecting the track. Place the cursor over one of the nine contiguous track sections and
double-click the left mouse button. All nine track sections should now be highlighted in red (if
they are not, pop up the shorthand menu by clicking the right mouse button away from the track
sections and select Selections Include Joints so that it is checked. All nine sections should high-

light at this time.). Pull down the Edit menu and select Copy (or popup the shorthand menu and
select Copy). The track sections have now been copied into the RR-Track clipboard. Next, we
paste the copied track back into the layout, duplicating it. Pull down the Edit menu and select
Paste (or popup the shorthand menu and select Paste). The duplicated cane-shaped track should
now be somewhere in the upper left corner of the layout, and highlighted in red. The layout should

look something like:

11

At this point, we
could pull down the
Action menu and
selection Rotate..
which will let us
carry out a manual
track rotation on the
newly pasted track,
but there is a
simpler and faster
method. We will
make use of the
automatic track
joining capabilities
of RR-Track. Place
the mouse cursor
over the last section
of straight track (the

end section) and depress and hold the left mouse button. After something like 1/2 second, the
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cursor changes to ‘Move’. While holding the left mouse button down, drag the free end of the
straight section to within one track width (1.25") of the free end on the last curve section of the
non-highlighted track (see moving track). (Note: while RR-Track has a capture distance for
joining of 12” for O gauge track when adding new track from the Track menu, the capture radius
changes to 1.25” when joining existing track, that is track already on the layout. This is true for all
track libraries, the capture distance for joining is the track width when manipulating existing track.
This change in the capture distance is to avoid unwanted joining when moving track around in busy
areas). When you have them close enough, release the left mouse button. RR-Track will automati-
cally rotate and join

. N . N o - the highlighted
- o - o - sections to the
/ ot Y existing sections. It
will also find the
other free end,
51 &l notice that it is close

enough to close the
loop, and ask if you
et a want to do so (the

= ﬁ — sections RR-Track
= . - wants to close are
high-lighted in
cyan). Choose Yes (there should be 0.00" of track error). You now have an oval of 18 track
sections which look something like that above.

I
e
I
e
[

Adding a turnout and spur track

Having mastered creating a simple loop, let us now move onto adding a turnout and spur siding.
Move the cursor over the right O-31 curve track on the bottom of the oval, and select it by clicking
the left mouse button once (see selecting track) and holding down the left mouse button. After a
short pause, the track section will highlight and the cursor change to ‘Move’. Continuing to hold
the left mouse button down, drag
this curve away from the rest
about 1/10th of the screen width, e —
and then release the left mouse % i
button. RR-Track will break the

connections and let you move the
curve to its new position. This

single section of track should be E/

highlighted as shown at right:

The single O-31 curve should be a1
off alone, leaving a gap in the
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oval. Zoom in on the gap by pulling down the View menu and selecting Zoom in 2x, centering the
zoom rectangle on the gap, and clicking the left mouse button.

Next, pull down the Track menu and select O-turnouts|O-3 1(modern) left, place it near the gap so
that the turnout curved section is closest to the oval’s track ends (we don’t want to join the turnout
thru track to the oval) and release it. RR-Track joins the turnout to the oval. Since adding the
turnout will also close the loop, RR-Track will do this either by proximity joining or automatic
loop closing since both options should have been set by you at the start. If RR-Track does not
close the loop, you will have to perform this task manually. Do this by selecting the entire loop of
track (double-click on one of the track sections), pull down the Action menu and select Close
Contiguous Loop. After asking you for confirmation, the loop is closed.

An important item to note is that you removed the curved section from the existing oval by using a
continuous click-hold mouse button-drag-release motion. You could have easily reinserted the
curved section you removed by reversing this process: selecting and dragging the curved section
back to the gap in the oval, and releasing it when the ends were within 1.25" of gap sections. Get
used to doing this, it makes if very easy to rearrange track layouts, something useful when you are
trying out new configurations, or trying to find the best arrangement of curved and straight track
that will cover part of your layout.

Now we add the spur. From the Track menu select O-Curve|O-31 left and place it near the turnout
spur, joining the two. Next, select another O-31 curve and add this to the previous curve. Repeat
again, making three curves in all. Now select and drag the old O-31 curve we removed from the
layout, or add another O-31 curve from the Track menu, and place this on the end of the spur to
create a 180° arc, bending back into the oval. At this point your track should look like:

Now we add the last O-31 turnout. Put the cursor over the O-

31 curve on the upper right of the oval, where the turnout will : ==
be going (this should be obvious). Single-click the left mouse

button to highlight this curve, and then delete it using either ! \
the DELETE key or pulling down the Edit menu and select-
ing Delete. This will leave you with three dangling track
ends perfectly positioned for an O-31 right-hand turnout.
Pull down the Track menu and select O-turnouts|O-31(mod-
ern) right and place this such that it joins to all three dan-
gling ends (RR-Track should go through two automatic loop

e

=l / =
3 1L 31
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closing cycles to close both the main oval and the bypass. Your layout should now look like:

Expanding the loop

Now, move the cursor so

that it is above and to the
left of the loop, then,
while holding down the
left mouse button, drag
out a selection box that
includes track in the upper

half of the loop. When

you have completed the selection box, release the left mouse button. All of the track in the upper
half of the loop should be highlighted. Ifit is not, carry out the selection process again until you
have all of the track in the upper half highlighted.

When you have the upper track
highlighted, place the cursor on
one of the sections, and depress
and hold the left mouse button.
Then, while holding the button
down, drag the highlighted track
upwards far enough so that when
you release the mouse button, the
layout will be split into two halves
like:

Now, pull down the Track menu

and select O-Straight|Single, and

join this track section to the far left
vertical on the lower loop half;

select another O-Straight|Single and join this track section to the center vertical on the lower half.
Now, pull down the Track menu and get an O-Straight|Half section, and add two of these to each of
the single straights you just added. Finally, place the cursor on one of the track sections in the
upper loop half, double-click the left mouse and hold the button down. When the entire half-loop
highlights, and the cursor changes to ‘Move’, drag the half loop down close enough so that RR-

20



ﬁ Track can join up the left and
.. middle verticals. Your layout
\ should now look like that to the
left.

This leaves us with a gap on the far
i right passing siding. Select the O-
31 curves that we put on this siding
and delete them. Now, pull down
the Track menu and select O-
CurvelK-Line® O-42 Left, and

* | add this to the lower turnout spur.
Repeat this five times, placing three
curves on the lower spur and three
on the upper spur. Your layout should now look like that to the left.

Next, move the cursor near one of the gapped ends, depress and hold the
ALT-key while depressing and holding the right mouse button. The cursor
will change to a ruler, with an endpoint snapping to the nearest track junc-
tion, which should be one of the track junctions on either side of the gap.
While holding down both the ALT and right mouse buttons, move the cursor
near the other side of the gap, and release the ALT and right mouse buttons.
A dialog appears showing the vertical, horizontal, and total distances
between the two track junctions.

Distance

This should be a little more than 10.0 inches,
just the size of an O-Straight. Choose one of these from the track
menu and drop it in the gap so that it automatically joins to both Vert:|10.00in
sides (you could also go down to the status bar and press the small et} 10.00in
uparrow on the Last Track list button and then choose an O-

Straight from here). This completes the first
part of the tutorial. Your layout should now

" ﬁ look like that below at this point.

You have now constructed a simple oval loop
of track, added a passing siding, and then
expanded the oval vertically using the track
joining/unjoining features of RR-Track. The
next thing to do is add a simple grade to the
left side of this layout. Doing so will familiar-
ize you with the various commands and tools
for dealing with grades, all of which are found
under the Grades menu.

Horz | 0.00in Angle: | 90.0°
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Adding a grade

Start the grade by going over to the far left side of the layout and selecting (you remember how to
do this) all three of the straight track sections, the two half sections and the full straight. Then pull

Change track elevation

77777777777777777777777777777777777777

down the Grades menu and choose
]l Change elevation. The Change Track

P o Elevation dialog appears as shown at
N | - left:
Vo 200— ‘Height inc—— . .
i I © 0.05" The grade preview window on the left
: 100 g e shows the track you have highlighted in
P os00— O o5 red (this is the track whose elevation we
j 1 are going to change), the rest of the

Grade
C1o0x C20x C30x C 40% O 75%
C15% O 25% C 36% @ 5.0% C 10%

'[ ------------------------------------ ] = layout in black, and the edges of the

layout in dashed blue lines. Below the

preview window is a set of radio

buttons that you use to set the required
grade. The fader control on the right of

the preview window, as well as the up/down spin buttons below the fader and adjacent to a panel
readout that shows the change are used to set the elevation of the selected track sections.

——————————————————————————————————————

——————————————————————————————————————

Ci1.0x C 202 C 302 O 40% O 75%
Ci1.5% C 25% @ 35% O 50% O 10%

Leaving the grade set at 5.0 per cent for the moment, and
the height increment set at 0.25 inch, either grasp the fader
slider and move it up so that a height of 2.00 inches is
shown in the panel readout, or click the up spin button eight
times to achieve the same result. The preview window
should now look like that at left:

Notice that RR-Track has calculated you must pick up four
track sections in height on each side of the elevated track
(two O-31 curves and two O straights) in order to satisfy
grade requirements of 5.0 per cent and an elevation of 2.0
inches.

To see the effect of changing the grade without changing
the elevation, go down to the set of radio buttons below the
preview window and select 3.0 per cent as the grade. RR-
Track immediately recalculates the grade track and shows
you that, in order to meet an elevation of 2.0 inches with a
grade of 3.5 per cent, you will have to pick up track

. sections all the way to the turnouts as shown at left:
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Of course, the problem now is that 2.0 inches is not enough clearance for an O-gauge train (here
you need at least 4.5 inches and probably 5.0 inches). It is clear, in order to raise the track up high
enough to clear another train, we will need to either increase the grade, or build a bigger layout.

You can play around both with different elevations

and different grade values to see how they trade

off in terms of track sections that will have to be picked up in order to accommodate the grade.

Go down to the set of grade radio buttons and choose 7.5 per cent for the grade (this is approxi-

——————————————————————————————————————

=
larade ‘

| C10x O20x C30% O40% @

4

redraws these items. Your layout should now look
like that shown at right.

The triangular arrow symbols on the grades show

that this a grade track section; the arrow points in the

direction of increasing height (uphill if you wish).

The tags showing dimensions denote the heights of
the track junction on a given section that is furthest

removed from the elevated track, i.e. the downhill

end. This is the height you would have to make your

structural supports in order to build this layout
design (If you don’t see either the grade symbols o
the junction heights, pull down the Options menu

mately the grade imposed by a Lionel® trestle
set. At the same time, by using either the fader
or the spin buttons, change the track elevation to
5.0 inches. RR-Track recalculates the grades,
and shows you a preview like that at left.

You can see that with a combination of 5.0
inches of elevation and a grade of 7.5 per cent,
we can accommodate the grade without having
to pick up the turnouts as well. To enter this
grade into the layout, press the OK button. RR-
Track now applies the elevation and grade
heights to the affected track in the layout, and

7

%bm
@

T

o %
o

w0
1

and select Options and then Layout Options (or pull down the Control Menu at the upper left of the
layout window and choose Options). When you see the Layout Options dialog, look to the lower
right and make sure that the grade symbols and grade heights boxes are checked).

Pull down the Options menu and select Selections

Include Grades. Then, move the cursor over

one of the elevated track sections (one of the straight track sections to the left which we originally
selected and moved up) and double-click the left mouse button. All three sections should be
highlighted as they are all in one elevation. Now move the cursor over one of the grade track
sections (any one with an arrowhead grade symbol, it doesn’t matter which one) and double-click
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the left mouse button. All of the grade track sections should highlight. Grade information
Now, pull down the Grades menu and choose Information. You will see a
dialog like that at right.

Length| 7337

Track sect: l T 1] 4

It shows a grade length of 73.37 inches comprised of 7 track sections. Ht. change: |53

There is a total height change of 5.0 inches and this works out to a grade

of 6.8 per cent, a little less that the 7.5 per cent we set when we created arade: | 5.8%
the grade. This is because RR-Track picks up track sections wholly;

grades always start at a track junction and end at a track junction and they don’t start in the middle
of track. In this manner you won’t have to bend any track to create the grade, and you will always
get a final grade that is equal to or less that the set grade.

Go back to the elevated straight track and double-click it with the left mouse button. Again,all
three elevated sections highlight. Now we will remove the grade we just put in. Pull down the
Grades menu and choose Remove elevation. RR-Track immediately finds all of the grade track
connected to the elevated track, resets the height to zero, and removes all grade symbols. You will
see a layout that is identical to that you started with for we just took out all of the elevated and
grade track that we had put in. For more information on using the Change Elevation dialog, and
other commands found in the Grades menu, see elevating track.

Using multiple layers

Another feature of RR-Track is the ability to design your layout without having to always see every
detail. This is done by introducing the concept of layers to the track layout. Despite the name,
layers having nothing to do with the height of track, accessories, or objects. A layer is a conve-
nient name for items that are associated in some other fashion (for example you could have a
benchwork layer for all of the support structures, or a mainline track layer, or an upper level track
layer). In order to add, remove, or modify layers, you have to go through the Layer Setup dialog.
Pull down the Options menu and choose Layers...

Every layout you create has

Drawing layers setup at least one layer in it which
<> <default layer> _La}le' aurlbu‘es Add RR—TraCk Sets up for you'
& Working This is the <default layer>,
i R
::AC'“'E S0%¥€ 1| as shown at left. You can’t
Inacti .
Tactve fiename || remove or rename this layer.
" Grayed

Change At the moment, all of the
track that we have added to

N the layout in this tutorial is in
NI Reset the <default> layer. This

layer is also the working
Helo || layer, as signified by the
prepended <W>. The

" Hidden

—Layer colors

Uil
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working layer is the layer in which new items are placed (see Creating, Changing, and Removing
Drawing Layers for more information about layers).

Let’s add a new layer. Press the Add button, and when the Layer Name dialog appears, type in
“upper level track”. Then press OK. The list of drawing layers should change to reflect this
additional layer, as shown at right. The working layer is still the default layer at this time. Double-
click on the ‘upper level track’ layer in order to quickly
change this layer to the working layer, and leave the
<default layer> as active (which means you can do

anything you want to it but add items). The layer list ‘

changes to:

Drawing layers setup

Now that you have added a new layer for some upper level track, press the OK button on the Layer
Setup dialog so that we can get back to laying some track.

Build a loop of O-gauge
track, using the techniques
we just went through, that
looks something like that at
left.

%‘:\\

S

Next, we want to raise this
entire loop of track up to 5

B ————— T
= 5 ==,
s Bt
e
0
AN
Y
%
ER

N inches or so (the exact
y T — = amount doesn’t matter for
W ) this tutorial, but to be
o 8y consistent we will set the

height at 5 inches). Do this
by:

(1) double-clicking on the new loop to select all of the track.

(2) Pull down the Grades menu and choose Set Track Height.

(3) In the Set Track Height dialog,
use the spin buttons to set a height
of 5 inches, and then press OK.
This raises the track sections up
and makes them all overpasses.
Now the layout should appear as at
left.

Note that the elevated track
sections are drawn as passing over
those that are not elevated. Now,
let’s return to the Drawing Layer

25



Setup dialog and change the properties of the ‘upper level track’ layer. Pull down the Options
menu and select Layers to get the Drawing Layer Setup dialog.

The ‘upper level track’ layer should be highlighted since it is the working layer (remember we set
this before we started creating the second loop). Go to the Layer Attributes radio buttons and
check Grayed. As soon as you have done this, press the Change button (changing the layer
attribute to grayed doesn’t take effect until you press the Change button). Notice that RR-Track
automatically makes the <default layer> the working layer when you do this. Then press OK to go
back to track laying. RR-Track redraws the upper level track so that your layout now looks like:

Try going back to the Draw-
ing Layers Setup dialog and
e changing the ‘upper level
track’ layer attributes to
Hidden or Inactive and see

“ what happens. If you want to
change the color of the track
in the ‘upper level layer’,

il press the Draw and Fill

buttons to get the Windows
J

Color Chooser.
You can use RR-Track’s set of general purpose drawing objects to draw in all of the scenery and
structures that you want. The only limit on detail is your own time and patience. To show what
can be done, we will draw a simple building.

i

Creating and editing objects

Make sure the working drawing layer is the <default layer> (you can check this by looking at the
status bar at the bottom of the RR-Track main window — the current working layer is shown in
blue). If the working layer isn’t the <default layer>, make it so by bringing up the Drawing Layers
Setup dialog. Now, pull down the Objects menu, then the Buildings menu, and choose Hip-roof
building. Sweep out a building that is about 8 x 6 inches (the exact size doesn’t matter) somewhere
on the left side of the layout. Next, place the cursor on the building you just created and click the
left mouse button to select it, just as you have for track. The building should look something like
that at right. Notice that each corner has a small red
circle, and the corner at the upper left has an additional
box around the circle. The red circles are the object’s
edit points, while the edit point with the box is the
object’s origin. Whenever an object is the first item
selected, RR-Track displays its edit points so that you
can resize or rescale it.
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Place the cursor arrow point over the edit point on the lower right of the building and depress and
hold the left mouse button until the cursor changes to an arrow with the word ‘Edit’ below it (if you
aren’t exactly over the red circle, you will either get the “Move’ cursor to show that RR-Track
thinks you want to move the building around the layout, or if you miss completely, the building will
be deselected and you will have to start over). Slowly drag the edit point to the right. RR-Track
displays a small window in the upper right corner of the layout window that shows the new size,
and the per cent change in scale in both the horizontal and vertical directions. When you reach the
new size that you want, release the left mouse button. RR-Track redraws the building at the new
size. There is no limit to the number of times you can edit an object.

While this tutorial does not cover every feature in the application, it does introduce you to the
methods of laying track implemented in RR-Track. You can see that it is easy to both build a new
layout, and modify existing layouts using RR-Track. Feel free to examine both the demonstration
layout files that came with RR-Track, and/or the example layouts found in the EXAMPLES
subdirectory. You can use these to play with, to get ideas from, or to use as starting points for your
own layout.
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Windows, Menus, and Displays

Windo ws, Menus, and Displa ys

RR-Track™ windows

RR-Track creates a number of windows in addition to the main layout window. These windows
visibility is set using commands under the View menu.

main frame window

The main frame window

Fle Edt Acton Wiew Track Objects Fonts Grades Livay Options Window Help

[ TEST1RRT

contains the viewing area for
all of your track layout
windows. RR-Track 3.02 is a
Multiple Document Interface
(MDI) application. This
means that the main RR-
Track window is a holding
area for any number of layout
windows that contain the
individual track layouts you
are designing. You can
switch from layout to layout
by clicking on the one you
want in the title area, or by
4| pulling down the Windows
menu and choosing the layout
that you want to bring to the top (this is called ‘setting the input focus’ in Windows). A layout
window can be maximized to fill the main window viewing area by choosing the up arrow button
(for Windows 3.x) or the maximize button (for Windows 95 and Windows NT 4.0).

T za  |ayout window

£ | | The layout window contains the viewing
L area for the track layout as well as

L ON \ d horizontal and vertical scroll bars which

Be == may be used for panning around the

% layout. It is in this window that all track

and objects appear as they are currently

located and connected on the layout.

Using the zoom commands under the

View menu, you may change the magnifi-
cation factor, in increments of two and

29



four, at which the layout is drawn in the main window. The commands on the top level menu bar
act on track and objects in this window. These menu items will change as you change layout
windows from one layout to the next.

track list window

i Tayout track list The track list window displays a list of all the
Copy Action Fotl Hel! track sections in the current layout, sorted both
(417 Lionel® 027 single straight 070 2570 A .

[15) Lionel® 027 0-42 curve 307 130 1350 by type and famlly. For each entry, the number
[ 3) Lionel® 027 0-27 lefthand turnout 1870 5610 : :

(169 Limel® 027 .27 g 45 070 1120 of sections of that type are shown, their cost, as
[ 47 Lionel® 027 O-27 righthand turnout 1870 7480

[ 3) Lionel® 027 O-42 lefthand turnout 2770 8310 Well asa Summary at the end Of eaCh traCk

(2) Liorel® 027 0-42 righthand turnout 770 5540 famlly of both the number ofpleces and the

[ 3) Lionel® 027 track bumper 200 GO0 . .

() Lionel 027 O-42 hlf curve 15° 00 180 cost. The cost for each track item is user

[ 3) Lionel® 027 cut straight no price . . . e e g .

Total of 92 pieces costing $336 60 of LionelK-Ling 0-27 track editable and is found in the initialization file

—— 2l associated with that track library. For more
1nformat10n see the section on 1n1t1ahzat10n files. The contents of the track list window change as
you change the layout window that has the focus (i.e. the layout window you are working on).

You may toggle between showing and hiding the track list window by selecting the Show Track
List item on the View menu. A check mark indicates that the window is visible. It can be moved
around the screen like any other window using the mouse cursor. You may also minimize this
window by pressing the minimize box on its title bar.

The track list window has a menu with four items, Copy , Action, Font, and Help. The Copy
command copies the track list text to the Windows Clipboard so that you may paste it into other
applications for, as an example, preparing an order to one of the track manufacturers. You may
also have the Copy command activate and send the track list information to Windows ™ Write
(this is WordPad in Windows 95) for text formatting and printing. Under the Action menu is a
single command, Hilite. This command is disabled until you click on one of the entries in the track
list window. If you then choose the Hilite command, all of the track in the layout of the chosen
type will be selected and highlighted. This is useful for seeing where you are using a given radius
of curve, or where you have put cut track sections. The Font command allows you to change the
display font used in both the Track List Window and the Select List Window, and is the same as the
List Font command found under the Fonts menu item on the menu bar. The Help command starts
the Windows Help engine and opens the topic to

the items relevant to the track list window.

[§i track item

You may get detailed information about any of the | Copy aetion

Frack types in the list by double-clicl.dng. on th.at o iy dnde Lengtniin) Ac B

item with the left mouse button. This will activate | 320 40 oo 875 =
. . . . . 477 40 o.o® §.73

another track list window which gives detailed 485 373 e 875

information about the location, orientation, and ggg ::; gg g;g

size of each of the track sections of that type. An 47T 447 o0 875

example of this window is shown to the left. Like | 25 21° - a7 =l
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the primary track list window, the secondary track list window has Copy commands so that you
may copy the track information to either the clipboard, or activate and place the information into
Write. The Action command in this window lets you highlight all of the track sections in this list.
This is useful for seeing where you have place various track types, and whether you have placed
cut track sections up against each other.

select list window

! selected track The select list window displays a list of all

! . track sections that are currently in the select list
[ ) Lionel& 027 O-42 curve 30 . . .
......... . and highlighted in red. The total length of each
qurtt:'lzfn;mfgffm“ of the track types is shown in the column at
spprovimately & cars i right, while the total length of all of the selected
track, in inches, is shown at the end of list, as
well as the approximate number of cars of the appropriate gauge which will fit on this length of
track. This is useful for checking on the length of spurs, sidings, and passing tracks in order to see
if their lengths meet your needs.

0.4 Lionele 027 single straight

You may toggle between showing and hiding this window by selecting the Show Select List item
on the View menu. A check mark indicates that the window is visible. It can be moved around the
screen like any other window using the mouse cursor.

multifunction status bar

Curzar, position zelection mode Atﬁg,-close WDrkill'lg layer ;
[1278in 108n [Z1 |[==melan]s010in 4|[ouidings i
Eul:uum .ﬂ.utlél-join =Nap séﬂing popup lazt track popup f

? Ross 0-64 22.57 curve -

RR-Track has a multifunction status bar which appears at the bottom of the main window. The
status window maintains a display showing the current values and state of RR-Track’s most
important settings, as well as short cuts to changing the most popular of these.

To the left is a small pane that shows the current cursor position in the active layout window. Next
to that is a smaller pane that shows the current Zoom factor (in the example the zoom is 1). Next
the Zoom pane is a set of three buttons that both show, and let you change, the current extended
selection mode, the auto-join mode, and the auto-loop close mode respectively. You can cycle
through the extended selection modes (from joints to electrical to grades and back to joints) by
repeatedly clicking the selection mode button. You can toggle auto-join between ON and OFF by
clicking the auto-join button, and you can toggle auto-loopclose between ON and OFF by clicking
the auto-close button.

The next button is the Snap-Size / Mode button. It displays the current snap size, or OFF if snap-
to-grid is toggled OFF for the active layout. By clicking on the button, you can toggle the snap-to-
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grid setting for the active layout between ON and OFF. By clicking over the little uparrow symbol,
you will pop up a list of the available snap settings with the current one highlighted. You can
choose a new snap setting from this list by clicking on it with the left mouse button (choosing a
snap size will also turn snap-to-grid ON if it was OFF). If you don’t want to choose a new snap
setting, click somewhere outside of this list.

The next pane is informational and shows the current working layer (for more information about
drawing layers and their attributes, see Working with layers).

At the right end of the multifunction status bar is the Last I[tem List button. This button displays
the last item (track or accessory, not object) added to any of the layout windows (this last item list
covers all of the layout windows). You can get another of whatever you added last by clicking this
button (this is the same as using the Last Track command under the track menu, or double-clicking
over blank space). You may also click on the small uparrow symbol to pop up a list of the 10 most
recently added distinct items. You can then choose one of these items.

You may toggle between showing and hiding the status bar by selecting the Show Status item on
the View menu. A check mark indicates that the multifunction status bar is visible.

Track and symbols in RR-Track™

To the left and right are shown typical images of track, as displayed by RR-Track. These are,
going down the page and from left to right, an O-gauge 10.0 inch straight track, an O-gauge O-72
curved track, an O-gauge O72 turnout, and an O-gauge, 45° cross. There are other more special-

ized track sections found in some of the libraries,

such as double-crossovers and three-way turnouts,

but these illustrate typical track sections. Three-rail

track is drawn with three-rails and two-rail track is %
drawn with two-rails. The ties are not drawn, since the overhang of
locomotives and long cars goes further to dictate clearances than ties do.

In some track libraries where the track is integral with the ballast, such as Mérklin®-M HO track
and Kato UniTrack®, short lines indicating the

extent of the ballast are drawn at each of the track
o é ends.

— The round, filled circles at the track ends are the
track control points. These are the locations
where track sections are connected to each other. The presence of a filled
circle means that that track end is physically joined to another track section. The presence of a
double circle, larger than the track width, indicates that that track junction is electrically discon-
tinuous, i.e. insulating pins are used at this junction to effect a block break (see designating an
isolated electrical block for more information).
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Using the mouse

The mouse, or trackball, is a vital part of the RR-Track user interface. Windows™ by its nature, is
graphically oriented and does not adapt well to keyboard-only use. RR-Track makes full use of the
graphical nature of the Windows™ environment by deriving little of its input from the keyboard.

RR-Track changes the cursor (the shape of the mouse pointer) to inform the you of what kind of
operation the mouse is currently being used for. If the cursor is the standard Windows™ arrow,
RR-Track is awaiting your instructions. An arrow cursor with the word ‘Break’ under it means you
are to designate a track joint for breaking. An arrow with the word ‘Autojoin’ under it means the
track section you are adding to the layout will be automatically joined to the nearest available track
section when you release the track section by depressing and releasing the left mouse button. An
arrow with the word ‘Move’ below it means you are currently moving an existing or new track
section from one location to another. A box with four inward pointing arrows and the word
‘Zoom’ means you are selecting an area to zoom in on, either by a factor of two or four. A
crosshair with a diagonal arrow and the word ‘Select’ means you are designating a selection
rectangle for the purpose of selecting (highlighting) objects for action. A simple crosshair means
you are being asked to designate the starting point of a rectangular object, a line, or the center of a
circle. When the left mouse button is depressed, the cursor position will be used for this point.
The cursor then changes to an arrow with the word ‘Size’ meaning you are to drag out the size of
the object while holding down the left mouse button. When you release the button the object is
drawn. An arrow with either a small hexagon or a sawtooth line and the word ‘Point’ below it
mean that you are to designate the next point in either a polygon or a polyline (the last point is
indicated by double-clicking the left mouse button).

Left mouse button: The left mouse button is used to select track or objects for further action
such as movement, rotation, joining, aligning, grouping. To designate, you position the cursor over
the item you want to choose, and then click the left mouse button (see selecting track or objects).
If you follow the same script, but double-click rather than single click, you designate an extended
selection. Whether the extended selection includes all physically connected track, all electrically
connected track, or all track at the same height or on the same grade is determined by which
extended mode you have currently set using the Options menu. Double-clicking over an extended
selection collapses the selection back to only the item under the cursor. Double-clicking over an
object ( rectangle, building, tree, etc.) will call up the Object Properties dialog, or, for text labels,
the Text Label dialog, so that you may make changes to the editable features of the object.
Double-clicking over nothing (no track, accessory, or object beneath the cursor) will act as
choosing the Last Track item on the Track menu, and put a piece of track identical to the last
chosen under the cursor for placement. Double-clicking over nothing while holding down the
CONTROL-key will act to choose the last object selected from the Object menu (this is a handy
way to draw a lot of trees or buildings quickly without going back to the Object menu). If you
position the cursor over a non-highlighted item and depress and hold down the left mouse button,
RR-Track will, after a pause of 1/4 to 1/2 second, assume you want to move that item, highlight it
and change to the move cursor, allowing you to drag the object to a new position ( see selecting
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track or objects ). This may also be done when double-clicking a track section to create an
extended selection; just don’t let up on the mouse button after the second click.

To sweep out a rectangular area for selecting objects, to move selected items, or to designate the
size of all general purpose objects you use a depress - drag - release sequence with the left mouse
button. Here you position the cursor over the previously selected item, depress and hold the left
mouse button, move the cursor while holding down the left mouse button to move or designate a
region or size, and then release the button when you are satisfied with your designation (see
moving track for another description of this).

To choose or unchoose track or objects in addition to those already selected (highlighted), position
the cursor over the item, and click the left mouse button while holding down the SHIFT key (see
selecting track for more information).

To cause the view to automatically scroll when you move the cursor, hold down the SHIFT key
without depressing any of the mouse buttons. When the cursor gets near the edge, the view of your
layout will automatically scroll in the appropriate direction.

Right mouse button: The right mouse button is used to measure distances on the layout using
the ruler function, to pop up a short menu (shorthand menu) of the most commonly used com-
mands, to tear off menus from the menu bar for later use, and as a property inspector for both track
and objects.

To bring up the shorthand menu, position the cursor over nothing and click the right mouse button.

To use the ruler function, depress the SHIFT key, position the cursor over the starting point,

depress and hold both the SHIFT and right mouse buttons, drag the cursor to the ending point, and
release both the SHIFT and right mouse buttons. To make the ruler function snap the endpoints to
the nearest track junctions, depress the ALT key rather than the SHIFT key. For more information

see measuring distances.

To find out the gory details about a track or object item, position the cursor over that item and click
the right mouse button. This action calls up a dialog box showing you more than you probably
want to know about that item.

The right mouse button is also used to tear menus off, and leave them on the screen for further use
and reference (see tearing off menus).

Mistakes and pitfalls: probably the biggest source of problems with the mouse functions
comes when you use the Mouse Control Panel Object to reconfigure your pointing device. If you
are having the wrong action occur when you click a mouse button, such as a menu appearing when
you press the left mouse button, check to see whether you have remapped the right and left mouse
buttons. To be sure, use the Mouse Control Panel Object to reset the mouse buttons in the standard
fashion. RR-Track looks for specific mouse messages from Windows; if you remap the buttons
mass confusion can easily result.
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Another set of difficulties arises from either too long or too short double-click times, or too much
cursor acceleration, both of which may be set from the Mouse Control Panel Object. If you are
having trouble single- and double-clicking, check the Mouse settings in the Control Panel. A
number of frustrating events can occur if you have the double-click time set to be either too long or
too short for the actual speed at which you are executing double-clicks.

RR-Track Menus

The main menu bar in RR-Track, running across the top of the screen, contains the commands
which may be used to interact with your layout. These have been divided up into standard
submenus which are discussed in detail below. An additional menu, the shorthand menu called up
by clicking the right mouse button, contains a subset of the most commonly used commands so that
you may quickly access them.

File menu
The file menu contains the commands that create new layout files, open
. existing layout files, save layout files, and print layout files. The file
EW... .
Open. Chl+0 menu commands vary depending on the current state of RR-track. When
T first started, the available commands are:
Save Chikes New...create a new track layout
Save as... L
S ave al Open...open an existing track layout (for example, mylayout.rrt).
Print layat.. Chil+P Close close the active layout window.
Printer...
Fage setup.. Exit close all layout windows and RR-Track.
Export ¥ | When either a new track layout has been created,or an existing layout is
e opened,the file menu changes, adding the following commands:
best]. it Save save the active layout.
zolly3g. it .
kevdnt Save as...save the current layout to a disk file, or save the current screen
In1348a. 1t image to a Windows Bitmap (BMP) file.

Save all saves all of the open layout windows.
Print layout... print the entire layout. You can indicate on the preview window which pages of the
layout you wish to print, as well as configure fonts and labels, and printer and printer settings.

Page setup set up the look and style for the current screen view when printed
Printer..._set the printing characteristics (page orientation, resolution, etc.) of the RR-Track printer.
You can also choose which of your printer(s) RR-Track should use as the RR-Track printer.

Export lets you export the current screen display to a Windows™ Bitmap (.BMP) file.
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Below the Exit (which lets you close RR-Track) command are a list RR-Track maintains of the last
four layouts opened. Press any of these to open the corresponding layout, without having to wade
through the Windows Open File dialog.

At any given time during the course of creating or modifying a track layout, commands in this
menu will be enabled or disabled(grayed) reflecting the courses of action available.

Edit menu

The Edit menu encompasses the commands that operate on track and

(Tl delete! . . .
e other layout objects. As is the case for many menu items, the commands

Cut Culv= | under the edit menu will be enabled and disabled reflecting the current state
Copy L1 of the track layout.

HEgte [Strl

Delete del Undo delete : un-does the last delete of 100 or fewer items. You must undo
St your deletions before you add/subtract further items from the layout, rotate
Duplicate parallel objects, move objects, or make any other layout changes.

Select &l Ctrl+A, Cut delete the selected items from the layout and copy it to the RR-Track

Select all inl Ifa_l,-er... clipboard
Select all visible

Copy copy the selected items to the RR-Track clipboard.

Paste paste the RR-Track clipboard contents into the layout.

Delete delete the selected items from the layout. Deletes of up to 100 items will be placed in the
Undo Delete buffer; deletes of more than 100 items will be confirmed with a prompt from RR-
Track.

Duplicate duplicate the selected items on the layout. This command combines Copy and Paste,
destroying the clipboard contents in the process.

Duplicate parallel creates a duplicate set of track / items parallel to, and offset from, the selected
track. You work through the Duplicate Parallel dialog to set and preview the offset. This com-
mand, like the simpler duplicate command, combines Copy and Paste, and destroys the clipboard
contents in the process.

Select all selects all of the track, accessories, and objects in the layout.

Select all in layer... selects all of the items (track, accessories, objects) in the layer you choose
from a dialog.

Select all visible selects all of the items that are visible regardless of layer (only items that are
grayed or hidden will be exempt).

In order for the cut,copy,delete , duplicate, and duplicate parallel items to be enabled, track or
other layout objects must be selected (highlighted). The paste command is disabled when the RR-
track clipboard is empty, but enabled otherwise. The undo delete command is only enabled
immediately after deleting 100 or fewer items (more than 100 RR-Track asks for confirmation;
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after this you are on your own). The commands in this menu are also accessible using the key-

board shortcuts shown in the drop-down menu.

Action menu
The action menu contains the commands that carry out
Botate.. operations on selected objects in the layout. These operations
Move... consist of rotating track and other objects, creating or breaking
Move o laver... joints between track sections, aligning joints between track
T e p— F5 sections, and moving track sections in order to minimize the
Join to nearsst track FE alignment errors at junctions.

Cloze contiguaus laap

Rotate... perform angular rotations on selected items.

Break. jgint
o N Move... summons the Move dialog (see moving track and

[[n[ g in] . . .

? objects) that lets you move selected items incrementally rather
S i el than drag them around with the mouse. This command is useful
Mgt 2,55 for fine adjustments of position.

IMove to front Chil+F
Send o back Cirl+B Move to layer... summons the Layer chooser dialog, and then
Set/clear black braak moves the selected items to the chosen layer. This command is
Clear all block breaks only useful if you are using more than one layer.
Create block, o L. .

Unjoin selected track break all joints in, and between the
Lock selected items Chil+L

: ) selected track and the rest of the layout.
Unlock zelected iterns  Chrl+Shift+L

Relax selected track configuration...

the nearest unjoined track.

Join to nearest track create a joint between the selected track and

Close contiguous loop closes loops in the selected track. Normal track joining will not close a
contiguous loop since the join command will not allow track to be joined to itself.

Break Joint breaks single joints in the selected track. This is different from Unjoin track, which

breaks all the joints in the designated track.
Object alignment commands:

Align : this submenu allows you to access three commands for aligning track
and objects with the coordinate grid, or other track/objects. The alignment
commands consist of:
Align to coordinate grid: lets you align one or more edges or centers of
the selected track to the coordinate grid at the current snap resolution.

Coordinate grid...
Designated object...
Nearest track

Align to designated object : lets you align the edges and/or centers of the selected track to

another track section or object.

Align to nearest track : lets you align the selected track with the nearest unjoined track. Like

joining, but the track sections are not actually joined.
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Object grouping commands:

Group objects groups all objects in the select list. This does not include track or accessories.
Ungroup objects ungroups the first grouped object in the select list.

Display ordering commands:

Move to front moves the lead selection to the last of the display list so that it will be drawn on top
of all other track or objects.

Send to back moves the lead selection to the first of the display list so that it will appear behind all
other track or objects.

Electrical block commands:

Set/Clear block breaks:sets/clears the placement of an electrical block break at the designated joint
in the selected track. The track is still physically joined. This command is used to set individual
electrical breaks; use the Create block command to set an entire block.

Clear all blocks:removes all of the electrical block breaks in the selected track. The track is still
physically joined.

Create block: sets electrical block breaks at all of the ends of the selected track. The track is still
physically joined. This is a faster way to create blocks than using the Set/Clear block break
command, which is used to set/clear a single break.

Item locking commands:

Lock selected items: locks the selected objects and track into place on the layout. When objects
are locked they can neither be moved nor rotated until they are unlocked. Handy for keeping you
from accidentally moving stuff you have finished with.

Unlock selected items: unlocks all of the selected objects and track. You must unlock locked
items before you can move, delete, or rotate them.

Relax selected track configuration adjust the position of the selected track to

ZoominZ: PgDn | minimize junction alignment errors.
Zoom in 42
Zoom out 24 Fall The items in this menu will only be enabled if track or other layout
ZHT LA objects have been selected (highlighted).
Last vi F3 .
e View menu
OME wigw F2
Fit i witicow

The view menu contains the commands that manipulate the location
and zoom of the RR-track windows. These include zooming in and out on
o S s the track display, redrawing the display at any time, and showing or hiding
g:'jw track st the auxiliary information windows. The center position of the track display
o select st may also be adjusted by using the horizontal and vertical scroll bars at the
Show locked items bottom and right margins.

Redraw F10
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Zoom in 2x zoom in on the layout by a factor of 2.
Zoom in 4x zoom in on the layout by a factor of 4.
Zoom out 2x zoom out the layout view by a factor of 2.
Zoom out 4x zoom out the layout view by a factor of 4.
Last view return to the previous view.

Home view set the upper left corner of the screen to the upper left corner of the layout, and returns
the zoom factor to one. This gives you a full overview of your layout.

Fit in window is similar to home view, except that not only is the zoom factor set to one, but the
overall scaling is set for maximum utilization of the layout window area. This is a very useful
command when you have resized a layout window. It is automatically invoked whenever you
maximize a layout window at a zoom factor of one.

Redraw force a redraw of the current view.

Show status toggle between showing and hiding the multifunction status bar.
Show track list toggle between showing and hiding the track list window.
Show select list toggle between showing and hiding the select list window.

Show locked items highlights all locked track, accessory, and objects.

The four zoom commands, together with the home view and fit in window commands and the
scroll bars at the bottom and left margins, collectively control the display scale for the screen
display. The three show commands control the display of the auxiliary information windows that
show mouse location and display mode, the list of the track in the layout, and the list of objects that
are currently selected (highlighted).

RR-Track has a one item deep view stack, which operates like the stack on a reverse Polish
notation calculator. Whenever you change the view, the previous view is put on the view stack.
When you select Last View, the current view and the view on the view stack are swapped, with the
last view becoming the current view and the current view becoming the last view. You can use this
feature to maintain an overview of your track layout, while zooming in to do some work, and then
darting back out by selecting Last View. RR-Track maintains separate view stacks for each layout
window.

Track menu
The track menu consists of track types available in the current track
Last rack library. This menu changes when a different track library is selected since the
D275Swaight  » | detailed varieties of track sections vary between the different families. In
g;ﬁt;:jms : general, all track libraries have straight sections, curved sections, turnouts, and a
0275pecial > number of special purpose track sections such as bumpers, uncoupling sections,

insulated sections, etc. Some track libraries, due to their complexity, will
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contain more subdivisions than the basic ones shown to the left. The first item on the track menu is
Last Track and simply allows you to add a track section to the layout that is identical to whatever
section was previously added. You may also invoke the Last Track command by double-clicking
the mouse when the cursor is not located on either an object or a track section.

Many track libraries, notably LGB® and Curtis HiRail, allow for custom cut-to-length straight
sections up to the maximum flexible track size in that family, and custom curved sections, where
you can set the radius of curvature, the arc length, and the angle subtended. When you select these
track types, you are presented with a dialog box in which you enter the information required to
produce those track types. By combining both cut-to-length straight sections and custom curves,
you can approximate flexible track sections. You can then select these sections in order to find out
the approximate length of a new piece of flexible track that will accommodate them.

If you place a new piece of track, and decide you do not want it, you can call up the Undo Last
Track item from the shorthand menu. Selecting this item will delete the last track section added to
the track list. Undo Last Track is limited to one level of undo.

When you use the Library menu to change to an accessory library, the Track menu title changes to
Accessories. The entries for the accessories are located in this menu in an analogous manner to
that for track sections.

Changing track libraries destroys any track library submenus that you may have torn off and left up
on the screen.

Objects menu

The Objects menu contains commands that allow you to create

gz:;cin;r;apes : simple geometrical shapes and add them to your layout. The
S » | simple objects available consist of rectangles, circles, polygons and
»

lines. Once placed into your layout, these objects may be selected,
moved, and rotated just as you would manipulate track sections. They
may not, however, be joined to track sections. Somewhat more
specialized objects such as a railroad bridge, turntable, hip-roof building (both subtypes of the
rectangle object), and various trees (a subtype of circles) are available for placement in your
layout.

Special objects

Object drawing properties...

The Objects menu is divided into four submenus: Basic shapes, Buildings,

Scenery, and Special objects, as well as a command use to set object drawing Fectangle
properties found at the bottom of the menu. The submenus may be torn off and Circle
left on screen just as for any other menu in RR-Track. :;inlel.

olyline
Basic shapes: the basic shapes consist of rectangles,circles,polygons, straight Palygon
lines, and_polylines;filled rectangles.filled polygons, and filled circles . Filled rectangle
Polylines are multiple connected line segments and can be considered the same Filled circle
as unfilled polygons without the end points connected. Filled polygan
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Buildings: the basic buildings include a plain building,hip-roof building,a water tower, a railroad
bridge/overpass,and a turntable. Plain buildings are drawn with a single
vertical roof line in the center of the buildings. Hip-roof buildings have the

hip-roof lines automatically drawn in to fit the building rectangle. Water E::.Tc.zrllbdﬁmg
towers consist of a square base with a circular structure fit into the base. wiater bower
Turntables are circular/polygon structures with 24 connection points spaced el e
every 15° and a suitable moving platform shown in the center. Track can be tumtable

placed at the connection points, but there is no facility for joining track to
turntables in the manner that track is connected to other track.

Scenery: these include deciduous trees,evergreen trees,a more realistic tree,a spring time tree, fall
tree, and winter tree. Other scenery consists of embankments, ponds, and boulders. The realistic
tree is drawn with 24 randomized edges in a medium green color, the spring
: tree is drawn with 24 randomized edges in a randomized color around medium
deciduousz hee . . . . .
sveigreen hiee green, the fall tree is drawn with 24 randomized in a randomized color around
realisic hree orange-yellow, while the winter tree is drawn with 24 randomized branches (no

sping  hee foliage). Boulders are drawn with six randomized edges, while ponds and
fal fiee embankments are designated like polygons, but filled in with blue and hatched
wintsr e8| brushes respectively.
bovid . . . . .

e Special objects: these include electrical connections and _text labels.
embankment

pond

" | Object drawing properties: this command calls up a
diatlog which you use to' set the drawing properties gf current and future clectical conmection
objects. You can use this command to change the line style, color, and fill text label. ..

color of the selected object, or the text of a text label, or, if no objects are
selected you can set the default line style, color, and fill color of subsequent objects. An alterna-
tive way to invoke this command is to double-click on the object you want to edit.

To create a new object, pull down the Objects menu and select the type of object you wish. The
cursor will change to a crosshair, indicating that RR-Track is waiting for you to designate the
object origin (this is one corner for rectangles, the starting endpoint for lines, the center for circles,
and the first vertex for polygons). Do this by moving the cursor to the point you wish to place the
object, then depress and hold the left mouse button down. The cursor will change to an arrow with
the word ‘size’ below it. While holding the left mouse button down, move the cursor. The object
is drawn as you move the cursor, with the status window continuously updating the size of the
object (radius for circles, width and height for rectangles, length and angle for lines). When you
have reached the desired size, release the left mouse button. The object is immediately drawn, and
the cursor returns to Windows arrow. You don’t have to get either the size or the location of the
object correct the first time since you can both move and edit objects (see Editing objects for
more information). You may select objects just as you select track for movement and rotation.

Polygon and polyline objects (which include ponds and embankments) are designated in a bit
different manner. Here you click the leftmouse button to designate the first vertex, then move the
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cursor to each successive vertex, clicking the leftmouse button for each one. When you reach the
last vertex, double-click the leftmouse button. RR-Track automatically closes polygon objects;
you don’t have to come back to the initial vertex (polylines are not closed, of course).

The current setting of both the Snap To Grid command and the Snap Size affect all objects and
track. If Snap To Grid is enabled (checked on the Options menu) then the origin and size of the
object you create will be ‘snapped’ to the nearest point that is an integral multiple of the snap size.
For example, if the snap size is set to 0.5 inches, then an object cannot be created with a dimension
finer than 0.5 inches. This applies to designation of polygon vertices as well.

To draw many objects of the same type rapidly (such as trees or rocks), double-click the left mouse
button while both holding the cursor over nothing and holding down the CONTROL-key. In a
fashion similar to calling up the last track selected, RR-Track will call up the last object selected
just as if you had pulled down the Objects menu and done this yourself. The cursor immediately
changes to appropriate designating cursor for that type of object, and you proceed as before.

Fonts menu
The Fonts menu is used to specify the fonts used for various elements in RR-Track.

Track labels. Track labels this command allows you to set the font used for the track labels

List windaows. . and grade heights. The presence/absence of both track labels and grade heights

Statuzwindow..  is controlled with the Global Options dialog invoked by Options command
under the Options menu.

List windows... this command allows you to set the font used for both the Track List and Select
List windows.

Status window... this command allows you to set the font used by the Multifunction Status Bar.
Grades menu

The Grades menu contains the commands used to change track elevations, remove elevated

track, and get information about existing grades and elevated track. Many of these com-
mands will be grayed out unless there is both selected track and the
extended selecting mode is set to selections include grades.

Change elewvation...

Flarners slavation Change elevation... this is the fundamental command for elevating or
Eeconcile grade . . . . . .

[ T depressing a section(s) of track. Choosing this command will bring up
Set track hoight... the Change Track Elevation dialog with the currently selected track
Zero inach Height sections highlighted. You interact with the controls in the dialog to
[HfErmatiar... graphically alter the elevation of the selected track sections while RR-

Calculator. ..

Track automatically carries out grade calculations. For more informa-
tion see elevating track.

Show grade track
Show elewvated track

Remove elevation this command returns the elevated track and all of
its connected grades to zero height.
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Reconcile grade this command examines the selected grade and removes any non-uniformity’s
which may have resulted from the interaction and collision of grades from the elevation of several
pieces of track. The track junction heights are recalculated as a result of this command. You can
also use this command to add and subtract track sections from an existing grade. For more
information see elevating track.

Create grade: this command is used to manually insert a grade into your layout. It may be used in
conjunction with the Set track height command to set or edit grades and elevations. This command
takes the selected track, examines the heights of the connection track at the ends of the selected
track, and smoothly interpolates grade heights.

Set track height: this command is used to set the absolute height of one or more track sections,
objects, or accessories. It may be used in conjunction with the Create grade command to set new
or edit existing elevations.

Zero track height: a catchall command that will take the height of the selected track, regardless of
whether it is connected to other elevated track sections, and set it to zero. This command is used
when all else fails to remove unwanted dangling grades.

Information... summons the grade information dialog which displays the number of track sections,
change in height, total length, and per cent grade for the selected grade. Useful for checking up on
the exact slope parameters for a given grade.

Calculator... summons the grade calculator, a dialog that lets you play around with track height
changes, lengths, and the per cent grade.

Show grade track selects and highlights all of the track in the layout that is on a grade. Graphi-
cally shows you where the grades are at on your layout.

Show elevated track similar to the above command, but instead shows all of the track sections at
non-zero height and not on a grade.

For more information on all of these commands and their interactions, see elevating track.
Library menu

The Library drop-down menu is used to set the active track or

v Lionel® 0-27 [32mim] 4 R X

Lionel® O-gauge (3mm) | accessory library. Entries exist on the menu for al.l of the track

Curtiz HiF ail 0 [32mm)] libraries in your copy of RR-Track; a check mark indicates the

Riess Custom Switches 0 (32mm) | currently active library whose components are represented on the

LD L Wi Track menu. The dimension at the far right, expressed in millime-
I L= f . . .

Lione#®/Rydin std gauge [Sdmm] ters, shows the gauge (distance between the outside rails) of that

Lionel® pre-war accessones cul KL h K and librari

Lionel® postwar  accessories particular trac : 1brar}f The track and accessory libraries are

BerPumen  crecssalss (planned libraries are in italics):

Flasticwille ACCEssolies

43



Options menu

The options menu controls properties of all layout windows. These span a wide range and
include the physical size of the drawing, the type of coordinate overlay, what style of track/object
rendering is desired, and the joining and selecting modes. These com-

Draning size... mands control individual layout options (such as rendering detail,

Legaa.. labeling, snap size, etc.), with the exception of the Options... command,
Ein grid which lets you change settings that apply to all layout windows.

12it grid

24in grid The following commands sets the drawing size and layer attributes:
48in grid . . . . .

No gid Drawing size... allows the physical size of the active layout to be

+ Detaied rack render changed. See changing the layout size for more information.

é:’:?;;c:m Layers... lets you add/subtract layers from your layout and change the
- attributes (visible, grayed, hidden, etc.) of the layers in the active layout
v Snap obiec.:ts to grid window.
Set snap size...
52 oining enar.. The following commands set the scale of the display coordinate grid:

<

Autorjoin new track
Autamatic loop clozing
Selections include joints  F7
Selections include blocks F8
Selections include grades F9

6" grid sets the display coordinate grid to 6-inch boundaries.

L

12" grid sets the display coordinate grid to 12-inch boundaries

24" grid sets the display coordinate grid to 24-inch boundaries.

Optionz...

48” grid sets the display coordinate grid to 48-inch boundaries.

(note: if you have selected the metric units option in the Global Options dialog, these coordinate
grid sizes will be 10cm, 25c¢m, 50cm, and 1m respectively).

No grid turns off the display coordinates. Setting of the coordinate grid size affects only the active
layout (i.e. each layout window’s coordinate grid may be individually set).

The following commands control the layout rendering:

Detailed track render toggles the track rendering between simple and detailed.

Label track : toggles whether labels are drawn with track and accessory items. This is the same as
the label track control in the Global Options dialog. This does not affect the display of track
heights and grades.

Set track color : this calls up a dialog which lets you set the drawing and fill colors for the track
libraries. These colors are used for the entire track library; you cannot set the color of individual
track sections. You can, however, set the default track color for the track in a given layer using the
Layers... command discussed previously.
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The following commands control the designating and placement of general purpose objects:

Snap Objects To Grid toggles forcing track and objects to be snapped to an underlying coordinate
grid set using the Snap Size dialog. This may also be toggled from the multifunction status bar.

Set Snap Size invokes a dialog letting you select the current snap size. The snap size and settings
only affect the placement of objects, or the alignment of isolated track sections. This may also be
set from the multifunction status bar.

The following commands control the track joining and selecting modes:

Autojoin new track toggles the joining mode for newly added track between automatic and manual.
This also toggles the proximity joining of track sections you are moving around on the layout. This
may also be toggled from the multifunction status bar.

Automatic Loop Closing toggles whether RR-Track searches for other track junctions near the ends
of the last added track section, and, if they meet certain criteria, asks if you wish to join these
points and close a track loop. A loop is a contiguous collection of joined track sections that turns
back on itself. Automatic loop closing is distinct from proximity joining, which merely joins track
junctions because they are close together irrespective of whether they belong to the same loop.
This may also be toggled from the multifunction status bar.

Selections include joints sets the extended selecting mode to all track physically connected to the
track under the cursor.

Selections include blocks sets the extended selecting mode to all track electrically connected to the
track under the cursor.

Selections include grades sets the extended selecting mode to all track either (1) at the same height
as the track under the cursor, or (2) on the same grade as the track under the cursor.

You may also cycle through the extended selection modes from the multifunction status bar.

The following command enables access to further application controls that affect all layout
windows:

Options...displays a dialog box allowing detailed control of the track display. You can also access
settings for the active layout through this dialog. See setting global options for more information.

Help menu

The help menu commands control the access to the Windows™
hypertext help utility. The RR-track help file, part of which you are
reading, contains help and information on topics germane to the track
layout application. The help topics may be accessed using the commands
in this menu and the Help button found in most dialog boxes.

Contents F1
Search for Help an...
Getting started

About RR-Track

Contents... starts the help utility and displays the RR-track help table of contents.
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Search for help on...starts the help utility and opens the keyword search window.

Getting started... starts the help utility and opens the track laying tutorial.

About... displays the About message for the RR-track application. The About dialog shows the
release version of RR-Track, the build number (sort of a sub-release version), and your serial
number which you need when asking for assistance.

Control menu

The control menu is the menu that you get when you single-click on the small square (Windows
3.x, Windows NT 3.x) or the miniature icon (Windows 95, Windows NT 4.0) in the upper left
corner of a layout window. Most of these commands are standard Windows system commands
(Minimize, maximize, close, etc.) but RR-Track appends two commands to the system menu:

Options... this command gets you a dialog which lets you directly manipulate settings that apply
only the that layout window (for instance coordinate grid size, track labels, background color, etc.).
This is distinct from the Options command at the bottom of the Options menu which lets you
manipulate settings that affect all layout windows.

Info... this command shows you a dialog which displays some statistics about the layout.
Shorthand (right mouse) menu

The shorthand menu contains a subset of the most used commands from the main menu accessed
though the menu bar. This menu may be called up by clicking the right mouse key when not
engaged in some other graphical operation such as moving track or drawing a selection rectangle.
The cursor must not be over some item when you click the right mouse button, otherwise you will
bring up the Item Property Inspector (used for extracting the gory details some track, accessory, or
object that you have drawn) instead. The commands on the shorthand menu are:

Last track: selects another piece of track identical to the last one added to the track layout. This
item will be grayed out if track families have been changed and a new track section from the
current family has not been added to the layout. This is the same as double-clicking with the
mouse over an empty area, or choosing the last track button on the multifunction status bar.

Undo last track: removes the last track section added to the layout from the track list. This item
will be grayed out if the last track section has just been removed, and another has not been subse-
quently added to the layout.

Copy: copies the selected track or other objects to the RR-Track clipboard.
Paste: pastes the RR-Track clipboard contents into the track layout.
Delete: deletes the selected track or objects from the track layout.
Duplicate: duplicates the selected track or objects.

Rotate...: rotates the selected track or other objects.
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Toggle overpass: toggles the overpass attributes of the selected track. If the track is currently set
as an overpass, the overpass attribute is cleared and the rendering returned to normal; the display

list position is not affected. If the overpass attribute is not currently set, it is now set and the track
rendered as an overpass and brought to the front of the display list.

Layers... lets you add/subtract layers from your layout and change the attributes (visible, grayed,
hidden, etc.) of the layers in the active layout window.

Snap size... calls up a dialog that lets you set the snap size for the layout.
Zoom in 2x: zooms in 2x. Same as the Zoom in 2x command under the View menu.

Zoom out 2x: zooms out 2xX. Same as the Zoom out 2x command found under the View menu.
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Track Laying Pr ocedures

Aligning track sections

You may align track sections with each other in the same manner that you join track sections, the
only difference is that aligned track sections are physically placed together, but their control points
are not marked as joined, unlike joined track where the adjoining control points are marked as
joined.

Three CAD -like commands are available in RR-Track for aligning track, and optionally general
purpose objects, with either the underlying coordinate grid or other track and objects. These three
commands, found under the Align to submenu under the Action menu are:

Align to| coordinate grid : this command lets you align any side or middle of the selected track and
objects with the coordinate grid, at the current snap resolution.

Align to| designated object : this command is similar to aligning with the coordinate grid, except
you may instead align the selected track and objects with another piece of track, or object, which
you designate with the cursor.

Align to| nearest track : this command lets you practice join the selected track to the nearest
available track end. It does everything but actually shove the pins together.

Align To Nearest Track is exactly analogous to Join To Nearest Track,except that the track sections
are not physically joined, just moved into alignment as if they were joined. Alignment of track can
be very useful for what if scenarios, and test configuration of track, saving you the trouble of
breaking joins you don’t wish to keep.

RR-Track scans the non-selected portion of the track list for the nearest unused control point,and

matches that with the closest unused control point in the selected track list. These points are then

brought into alignment as if they were physically joined.

Procedure:

1. Select the track you wish to move into alignment. The track is highlighted in red.

2. Move the selected track near to the track you wish to align with. RR-Track will align in both
position and orientation the closest pair of unused control points.

3. Select Align To Nearest from the Action menu. The track is aligned immediately

You can align the selected track and objects to the underlying coordinate grid by selecting the
_ Align to| Coordinate Grid command found under the Action menu. In
order to align the selected track, they must be free of connections to track

i Align with:
= =W sesmmaze| | thatis not selected, exactly as required when rotations are performed.
[Bavom | cancot | When select the Align To| Coordinate Grid command, you will see the

Select the alignment and

then press OK M d]alog at left:

The following buttons and controls appear on the Align To Coordinate Grid dialog:
Align with group: this contains four check boxes used to designate one or more sides which you
wish align to the coordinate grid.
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Left: checking this box tells RR-Track you wish to align the left side of the selected items to the
coordinate grid.

Right: checking this box tells RR-Track you wish to align the right side of the selected items to the
coordinate grid.

Top: checking this box tells RR-Track you wish to align the upper side of the selected items to the
coordinate grid.

Bottom: checking this box tells RR-Track you wish to align the lower side of the selected items to
the coordinate grid.

These check boxes may be combined in any manner that you see fit. For instance, to align the
upper left side of the selected track or objects to the coordinate grid, check the Left and Top boxes.
In order to align the middles of the selections to the coordinate grid, you check both of the appro-
priate boxes.

Example: to align the left/right middle to the coordinate grid check both the Left and Right
boxes. To align the geometric center of the selections to the coordinate grid, check all four
boxes.

OK : this button aligns the designated side(s) of the selected track to the coordinate grid at the
current snap resolution.

Set snap size : this button lets you change the current snap resolution. See setting the snap size for
more information on this topic.

Cancel : this button lets you bail out without aligning anything.
Help : this button displays instructions for using the Align To Grid command.

Procedure:

1. Select the track or objects you want to align with the coordinate grid, and then select the
Align to| Coordinate Grid command from the Action menu.

2. Check the Align To boxes as appropriate. Be sure and remember that Left means the left side
of the entire selection, not just the lead selection.

3. Press the OK button. RR-Track immediately moves the selected items into the demanded
alignment with the coordinate grid, at the current snap resolution. The Align dialog stays up
until you press the Cancel button so that you may execute multiple alignments without having
to re-invoke the Align command.

You can abort the Align command at any time by pressing the Cancel button.

You can align the selected track/objects to another object which you designate, by selecting the
Align to| Designated Object command found under the Action menu. In order to use this dialog to
align the selected track, none of the selected track items may be joined to track that is not selected,
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i.e. the selected track must be free, exactly as require to rotate it. When you invoke the Align To
Designated Object command, you will see the follow-

Align to track/ohject [ ] 1ng dialog:
Align with: Align to:
|_ Top |_ Top
I"Left I Right| | —Left [ Righ cancel | | The following buttons and control groups appear on
W Bt Batten the Align To Object dialog:

geloctthelsoucalendidostinaion Hep || Align with group: this contains four check boxes used

alignment and then pregz DK and usze the

cursar to designate the reference object to designate one or more sides which you wish align to
another object.

Left: checking this box tells RR-Track you wish to align the left side of the selected items.
Right: checking this box tells RR-Track you wish to align the right side of the selected items.
Top: checking this box tells RR-Track you wish to align the upper side of the selected items.

Bottom: checking this box tells RR-Track you wish to align the lower side of the selected items.
Align to group: this contains four check boxes used to designate one or more sides which form the
reference track or object. This is the object to which the selected items are aligned.

Left: checking this box indicated you want to use the left side of the item as a reference.
Right: checking this box indicated you want to use the right side of the item as a reference.
Top: checking this box indicated you want to use the bottom side of the item as a reference.
Bottom: checking this box indicated you want to use the lower side of the item as a reference.

Remember, these side designations refer to the entire selection and not just the lead selection for
the Align With or source objects, and they refer to the single track or object you designate for the
Align To or reference object. These check boxes may be combined in any manner that you see fit.
For instance, to align the upper left side of the selected track or objects to another object, check the
Left and Top boxes. In order to align the middles of the selections to the another object, you check
both of the appropriate boxes.

Example: to align the left and right middle to another object check both the Left and Right boxes.

To align the geometric center of the selections to the coordinate grid, check all four boxes. These
combinations also apply to the Align To or reference object.

Example: to align the /ef side of the selections with the left/right middle of another object, check
the Left box in the Align With group and both of the Left and Right boxes in the Align To group.

Obviously, it does not make sense to try to align left and right sides to upper and lower sides, and
RR-Track will let you know when you try to carry out a meaningless alignment.

Align: depressing this button causes RR-Track to evaluate the alignment conditions set by the
Align With and Align To check boxes. If a legal alignment is indicated (no attempt to align
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horizontal and vertical features with each other) the cursor changes to an arrow with the word
Align beneath it. At this point you designate the object to align to and RR-Track moves the
selections as appropriate.

Cancel: this button lets you bail out without aligning anything, or terminate the Align To Object
dialog after carrying out your alignments.

Help: displays information on this operation on your screen.

When using the Align To Object dialog, the setting the current snap resolution has no effect on the
alignment of the selected track/objects.
Procedure:

1. Select the track or objects you want to align with another object, and then select the Align to
Designated Object command from the Action menu.

2. Check the Align With and Align To boxes as appropriate. Be sure and remember that Left
means the left side of the entire selection, not just the lead selection.

3. Press the Align button. If the alignment you have set is legal, RR-Track changes the cursor to
an arrow with the word ‘Align’ beneath it. At this point you move the cursor to designate the
object you wish to Align To. This is done by positioning the cursor over the object and
clicking the left mouse button.

4. RR-Track immediately aligns the selected track/objects to the reference object you desig-
nated. The cursor changes to the Windows arrow, while the Align To Object dialog stays up.
At this point you can either carry out further alignments or return to the main menu by
pressing the Cancel button.

If you wish to abort the alignment after you have gotten to the point where RR-Track displays the
align cursor, move the cursor to a spot that is over nothing, and click the left mouse button. RR-
Track will beep to let you know you have designated no reference object, and return the cursor to
the Windows arrow. You can now alter your alignment criteria, or press Cancel and return to the
main menu.

see also:
selecting track,moving track and objects, joining track, marking track control points

Breaking a single track joint

You can break single track joints instead of breaking all of the joints in a track section by using the
Break Joint command under the Action menu. As with other commands under the Action menu,
you must have first selected track in order to break any joints since the Action menu will be grayed
out unless there is highlighted track.

Procedure:

1. Select Break Joint from the Action menu. The cursor changes to a diagonal arrow with the
word ‘Break’. All other menu commands, except Help, are disabled at this time.
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2. Place the cursor on the highlighted track section where you wish to break the connection. It
should be nearest the joint you wish to break.

3. Click the left mouse button. RR-Track will find the closest joint in the track section and
break it at this time. If there are no joints in that track section, or if you click outside a track
section, RR-Track makes no breaks. The cursor returns to the Windows arrow, and the menu
bar is enabled.

see also:
unjoining track, selecting track

Changing the layout size

The Drawing Size command is used to set the lateral (width) and vertical (depth) extents of the
drawing. These extents represent the area that you may lay track in; the area outside this (when
visible) is painted in gray. At any time, you may resize the layout you are working on by selecting
this command.

When you select the Drawing Size command, the RR-Track displays the following dialog box:

— There are four sets of numerical windows which you use

to set the drawing size, one window for feet and one for
'D_L:‘i"::': size = inches for both the width_and depth settings. Spin
buttons are used to set the dimensions for all four
LV = LI values, with the up-button increasing values and the
Depth down-button decreasing values. The OK button tells
nfe B om0 B RR-Track to take the new width and depth values and
resize the layout, while the Cancel button leaves the

layout at its current size.

You may resize the layout at any time simply by
selecting the Drawing Size command. Use the spin buttons to set the new values and press OK.
The layout will be rescaled and redrawn on the screen.

When you change the size of the main window, by grabbing one of the corners and dragging it,
RR-Track does not automatically rescale the layout. If you wish to rescale the layout to the new
window, without changing the layout size, simply select the Drawing Size command as above, and
immediately press the OK button. RR-Track will take the current drawing size and rescale to fit
the window.

Changing the drawing order

Track and general purpose objects such as rectangles, lines, circles, trees, etc. are generally drawn
in the order they have been added to your layout, that is, items first placed are drawn first, and
those placed last are drawn last. This is sometimes inconvenient for accurately depicting vertical
relationships between track and objects or accessories. For example, if you had selected an
overpass or bridge from an accessory library, and added it to the layout after the track sections
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running over it were placed, the overpass would be drawn after the track sections, making the track
appear to run beneath rather than on top of the overpass. The commands Move To Front and Send
to Back under the Action menu are used to change the order in which track, accessories, and
objects are drawn. To use these commands for altering the order of track/object rendering do the
following:

Procedure:

1. Select the track section, accessory, or object you wish to alter using the mouse cursor. If you
select more than one item, only the lead selection will be affected by the subsequent display
list command.

2. Choose the Move To Front command under the Action menu in order to make the object
appear in front of all of the other objects, or choose the Send To Back command to make the
selected item appear behind the other track and objects.

3. The track layout is re-rendered with the new display list order, and the selected items are
deselected.

Changing the working track family

Track is organized into ‘libraries’ in RR-Track. The libraries currently supported are Z, N, TT,
HO, 0-27, O, G, standard gauge, and S-gauge. RR-Track allows joining of O and O-27 track (this
includes Lionel® O-27, Lionel® O, Curtis HiRail, Ross Custom Switches, and GarGraves® at
present), G (this includes LGB® , Aristocraft®, and MicroEngineering), and standard gauge
(Lionel® and Rydin Industries). Any and all track libraries may be mixed in one layout, but
physical joining is only allowed between track of the same gauge, and same electrical layout (you
cannot join Marklin® HO track to Atlas® HO).

Changing libraries is simple. Pull down the Library menu and select the track library that you want
to use. RR-Track places a check mark next to that family, and changes the Track menu to reflect
the components of that family.

Closing a loop of track

When you have a loop of track (simple oval, part of a figure eight, etc.) which you wish to close
upon itself, the various join commands are not usable since they will not allow a continuous set of
track sections to join to itself. For this purpose, you must tell RR-Track you wish to close a loop.
The track list will be scanned for the continuous set of track sections that has the closest pair of
unused ends (control points) with a minimal amount of angular mismatch. You will be asked to
confirm that you wish to close this loop; if so, the unmatched ends are ‘joined’, which closes the
loop.

The more complex the track configuration, the greater the number of loops. A simple figure eight
using one cross has two loops. An oval with two turnouts that are connected by an outside loop of
track also has two loops. A track loop is any set of continuous track sections that is joined to itself.
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Procedure:
1. Select the loop of track you wish to close on itself using the mouse cursor.
2. Pull down the Action menu and select the Close Contiguous Loop command.

3. When a suitable loop is located, RR-Track highlights the ends that must be joined in cyan,
informs you of the mismatch in location, and asks for confirmation. Press OK to close the
loop, and Cancel to abort. If no suitable loop is found, you will be told of this, and the
closing operation aborted.

4.  The loop is closed if confirmed, with the loop left highlighted and selected.

(Hint: If you enable the Automatic Loop Closing option in the Global Options dialog, loops will
be closed automatically by RR-Track for you; we suggest you lay track with this option turned on).

Note: loop closing is not the same as proximity joining. When track junctions are closed by
proximity joining, the only requirement is that the ends be within a certain distance of one another
(1/4 of the track width or gauge) and have less than 2.5° of angular mismatch. No attempt is made
to ascertain whether the track sections are either physically or electrically connected to one
another. In loop closing, RR-Track ascertains that the track sections in question be physically
connected to one another by way of other sections of track (the rest of the loop). In practice, there
is little difference between the two, but they are individually settable options.

see also:
selecting track

Copying track

The Copy command from the Edit menu allows you to copy selected track or objects to the RR-
Track clipboard. Unlike the Cut command, the Copy command does not delete the selected
(highlighted) track or other objects. The copied objects replace whatever was previously in the
RR-track clipboard. Like any clipboard objects, these are available for pasting into the current
layout at any time, using the Paste command.

Procedure:

1. Select one or more track sections or objects using the mouse cursor.

2. Choose the Copy command from the Edit menu, or from the shorthand menu called up by
clicking the right mouse button.

3. The selected track or objects are placed in the RR-Track clipboard. This action enables the
Paste command in both the main and shorthand menus.

Note that you can also use the Duplicate command to quickly replicate the selected track and
objects without separately invoking the Copy and Paste commands. Duplicate Parallel is similar
in action, but goes through a dialog where you specify the parallel spacing between the original and
duplicated track. Items copied to the clipboard can be pasted into any open layout.
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See also:
deleting track, pasting track, selecting track

Copying track between layouts

To quickly clone new layouts, you may wish to copy track from one layout to another. This is easy
to do using the RR-Track clipboard. There is a limitation in that RR-Track can only hold approxi-

mately 400 objects in its clipboard at any given time (if you try to exceed this you will be told you

cannot copy that many items).

Procedure:
1. Open the layout file you wish to copy the track sections from.

2. Select the track sections you wish to copy, and use the Copy command under either the Edit
or shorthand menus to copy this track to the clipboard

3. Open the layout file you wish to copy the track to, or, optionally, create a New layout.

Select the Paste command from either the Edit or shorthand menus. The previously copied
track is pasted into the new layout near the upper left.

A related operation is cloning a layout.

see also:
selecting track,opening a layout file

Creating ,changing, and removing drawing layers

Layers are a feature of RR-Track which allow you to create very complex layouts without neces-
sarily having to be aware of the complexity at all times. A layer is simply a grouping of track and
objects which have some common feature (such as they are all on the ground level, or they are all
on the upper level, or they are all on the inner loop, etc.) A layer has assignable attributes which
govern its visibility, selectability, and color. For example, a train with two levels of track can, at
the very least, have two layers — the layer that has the lower level of track and that which has the
upper level. In this manner you can hide the upper level while you work on the lower level, and
vice versa.

Every layout you create automatically sets up one layer for itself which it names <default>. This
<default> layer can neither be renamed or removed in order to safeguard you against accidentally
creating a layout file with no layers. This is the equivalent of previous releases of RR-Track which
used only one drawing layer. When you create a new layout, the <default> layer is set as the
working layer, i.e. the layer in which items are added. Layers that you subsequently add can have
any name you like, up to 48 characters in length. You should choose names that have significance
for you.

To add a layer, modify a layer, or remove a layer from a layout, pull down the Options menu and
choose Layers... You will see a dialog like that at left:
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Drawing layers setup

— Layer attnbutes

— Layer colors

[] o |

The list box on the left shows the
existing layers in the layout. RR-

f_ :‘;T;‘:E H:::ve Track prependg a .modiﬁer to the .
€ Inactive — layc?r name to mdlcate., ata glanc;, its
 Grayec — aFtr'lbute's (<W> working, -a- active,
© Hidder 9 || -i- inactive, -g- grayed, -4- hidden).

There are two groups of controls that
are used to set or change layer

| flike

Reset

attributes. The set of radio buttons
are used to both set and indicate the
visibility and selection attributes of
the layer that is highlighted in the list
box. The command buttons in the Layer Colors group are used to set and clear the default layer
drawing colors. The command buttons on the right compose the set of actions that can be taken on
the layer attributes.

[]_f |

Layer Attributes: a layer can have one of five attributes (listed in decreasing order of activity):
working, active, inactive, grayed, and hidden. The working layer is the layer that items are added
to when you add track, accessories, or objects to your layout; there can be only one working layer.
You can select items in the working layer, move them, join them, unjoin them, rotate them, and
delete them. Obviously, the working layer is visible. An active layer is the same as a working
layer, except that items are not added to an active layer, only to the working layer. As for the
working layer, items in an active layer can be selected, moved, joined, unjoined, rotated, and
deleted. Any number of layers can be active layers; active layers are visible. An inactive layer is
visible, just as for the working and active layers, but items in inactive layers cannot be selected (the
are invisible to the mouse), and hence cannot be manipulated (until you change the layer
attributes). Inactive layers are similar to Windows wallpaper; you can seem them but you can’t
touch them. A good use for inactive

layers is for benchwork while you are

working on the track. Grayed layers are Attribute | Visible | Selectable | Additions
like inactive layers but items in grayed

layers are drawn using a pale gray pen; working Yes Yes Yes
objects and accessories are only drawn 3

. . active Yes Yes No
in rough outline form. Grayed layers

are useful when you need to see inactive Yes No No
underlying items for the purpose of

registration with other items, but you grayed sort of No No
don’t want to be plagued with all of the hidden No No No

details. Hidden layers are just that; they
are not visible at all. Hidden layers are
useful when you don’t want the details of upper level track to bother you while you are working on
the lower level. The table above summarizes the properties of the different layer attributes.
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Layer colors: layers can have a default drawing and fill color which will override the intrinsic
color for a track library (but not for the intrinsic colors used for accessories and objects). In this
manner you can change the default color of track by assigning the track to another layer, and then
setting the default layer colors to that which you want for the track. For instance, if you have two
loops of track, one of which is the outer mainline and the other the inner mainline used for connec-
tion to yards, sidings, etc., you could place the track in the outer loop in a layer (called Outer
Mainline) and the inner loop in a layer (called Inner Mainline). If the assign the Inner Mainline
layer a drawing color different from that normally used by the track library (set using the Set Track
Color command found under the Options menu, see setting the track color) then the two loops of
track are drawn with different colors.

If you are adding a new layer, removing an existing layer, or modifying the attributes of an existing
layer, you will use the controls in the Layer Attributes section of the Layer Setup dialog. The
Change button is only enabled when one of the attributes radio buttons is clicked.

To add a layer:

To add a layer to a layout you use the Layers... command found under the Options menu. The

Drawing Layers Setup dialog will be displayed, at which point you choose the Add button to create

anew layer.

Procedure:

1. From the menu bar, select Options and then Layers... from the drop-down menu. RR-Track
displays the Drawing Layers Setup dialog.

2. Press the Add button. RR-Track shows the New Layer Name dialog. Enter the name you want
for the new layer and press OK. If you decide not to add a layer, press Cancel. If you pressed
OK, RR-Track creates a new layer with the name you chose, sets its attribute to inactive and
adds it to the list.

You can then change the new layer’s attributes to whatever you want. When you are finished with
the set up of the layout’s layers, press the OK button on the Drawing Layers Setup dialog.

To remove a layer:

As for adding a new layer, you remove an existing layer using the Layers... command.

Procedure:

1. From the menu bar, select Options and then Layers... from the drop-down menu. RR-Track
displays the Drawing Layers Setup dialog.

2. Using the mouse, choose the layer you want to remove by single-clicking it with the left mouse
button.

3. Press the Remove button. If there are no items in the layer, RR-Track immediately removes it.
If there are items in the chosen layer, you will be advised of this and informed that the layer
cannot be removed until those items are either deleted or moved to another layer.
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To rename a layer:

Renaming a layer is similar to both adding a layer and removing it. As for adding and removing,

you start with the Layers... command.

1. From the menu bar, select Options and then Layers... from the drop-down menu. RR-Track
displays the Drawing Layers Setup dialog.

2. Using the mouse, choose the layer you want to rename by single-clicking it with the left mouse
button.

3. Press the Rename button. RR-Track shows the New Layer Name dialog. Enter the name you
want for the new layer and press OK. If you don’t want to change the name, press either OK
without typing in a new name, or press Cancel.

When you are finished with the set up of the layout’s layers, press the OK button on the Drawing
Layers Setup dialog.

To change a layer’s attributes:

Laver attributes
* working
 Active

" Inactive
" Grayec
€ Hidder

As for the layer creation, deletion, and renaming, modifying a layer’s
attributes starts with the Layers... command.

Add
Remove
Procedure:

1. From the menu bar, select Options and then Layers... from the
drop-down menu. RR-Track displays the Drawing Layers Setup
dialog.

2. Using the mouse, choose the layer you want to modify by single-clicking it with the left mouse
button. As you change the chosen layer, the Layer Attributes radio buttons change to reflect
the current attributes of the chosen layer.

3. Go to the Layer Attributes radio buttons and select the attribute you want from the choice of
working, active, inactive, grayed, and hidden.

4. Press the Change button. RR-Track changes the layer attributes, and, if necessary, reduces the

status of the former working layer to active.

Rename

il

[Ehatae

Whenever a layer’s attributes are changed to working, the previous working layer is switched to
active, meaning that you can still choose and manipulate items in that layer, but newly added items
will go into the new working layer. A quick way to change the working layer is to combine steps 2,
3, and 4 above by double-clicking rather than single-clicking on the layer you want to make the
working layer.

To change a layers default colors:

As mentioned in the introduction, you can also set the default drawing Layer colors

colors for a layer. If a layer has defined drawing colors, it will use them Draw |

in lieu of the standard track library colors when rendering track. When il | ﬂl
you modify a layers drawing colors, you use the command buttons in the |=
Layer Colors group:
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As usual, you start with the Layer Setup dialog.

Procedure:

1. From the menu bar, select Options and then Layers... from the drop-down menu. RR-Track
displays the Drawing Layers Setup dialog.

2. Using the mouse, choose the layer you want to rename by single-clicking it with the left mouse
button.

3. Press the Draw button to change the outline drawing color (this is the color used for the rails
and outlines of switch machines, etc.), or press the Fill button to change the fill color (this is the
color used to fill in switch machines and joining symbols). RR-Track displays the Windows Color
Chooser.

4. Select the color you want and then press OK. If you don’t want to change the color, press
Cancel. If you press OK, RR-Track takes the new color and makes it either the outline drawing
color or the fill color as denoted above. The layout is not redrawn until you press the OK button
on the Layer Setup dialog.

If you want to reset the layer colors to the defaults (that is, draw the track with the standard track
library colors), choose the layer using the above procedure, but press the Reset button rather than
the Draw or Fill buttons.

Creating a new track layout

You may create a new layout at any time using the New command from the File menu. The
drawing size dialog will be displayed, at which point you set the new layout’s width and depth
(these may be altered at any time using the Drawing Size command in the Options menu).

Procedure:

1. From the menu bar, select File and then New... from the drop-down menu. The current
layout, if any, will be saved.

Using the spin buttons set the width and depth of the new drawing.

3. Click the OK button if you are satisfied with the new dimensions, or Cancel if you change
your mind and wish to return to the RR-Track main window.

see also:
opening a layout file, saving a layout file
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Creating a text label

You can create and place text labels in our layout using the Text Labels object under the Object
menu. Text labels are like other objects and may be moved and grouped as you see fit (but not
rotated). Text labels may also be edited through the Object Properties dialog. When you choose
this object, you immediately see a dialog like that to the
left:

You enter the text you want to add to the layout in the
large edit box in the upper left, including carriage returns
if you want multiple lines. The other controls are used to

Jackcolor] | set the properties of the text label.
Cancel

Default font

Justification
AaBbCe ® left

C center
C right

Font... pressing this button calls up the Windows Font
Chooser letting you select the type face, size, color, and

[ bord K
o other attributes of the font used for the text label.

[ opague bkgnd

) [k

Default font : pressing this key sets the currently selected
font as the default font for any subsequent text labels. You do not have to use the default font, but
if you want a lot of labels with a certain type face and size, this is useful.

Back color: pressing this button calls up the Windows Color Chooser so that you can select the
background color for the text label. This is only active if you have checked the Opaque Back-
ground button.

Border: draws a rectangular border around the text the same color as the text color.

Opaque Background: sets the background opaque rather than transparent, which is the default.
When you check the Opaque background button, you may now also set the background color by
pressing the Background Color button.

Justification group:

Left, centered, and right : these control the current text justification setting with left justified the
default.

Cancel: aborts creating a text label.

OK: takes the current setting of the dialog, and the text in the edit box and creates a text label.
The dialog disappears and a box which bounds the text appears under the cursor. You can move
this box to wherever you wish, placing it by single-clicking the left mouse button. A text label
object is like any other object, and may be moved around as you wish. You may even edit the
content and properties after you have created the text label by setting the cursor over the text label
and clicking the right mouse button. This will call up the Object Properties dialog which shows
you the details of the text label object, and has an Edit button. Pressing the Edit button will allow
you to go back and change the text label and its associated properties.
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Note: RR-Track stores the font information that you use for labels as a physical height, rather than
a pointsize. This is because the fonts must be scaled as you zoom in or out, and when you print.
One of the effects of this is to change the font size as seen by Windows when you create a text
label and then zoom in or out. If you go to edit this label at the new zoom factor, you will see a
font size reported by Windows that is different from what you previously set. This is not some-
thing to be concerned with; Windows always reports the font size in screen pixels and not in
printer points, or some other fixed system.

see also:
setting object properties

Deleting track or objects

The Delete command from the Edit menu allows you to delete selected track or other objects.
Unlike the Cut command, the delete command does not copy the selected (highlighted) objects to
the RR-Track clipboard. The contents of the RR-Track clipboard are not changed by this com-
mand. You may also delete objects by pressing the keyboard’s delete key.

Procedure:
1. Select one or more track sections using the mouse or other pointing device.

2. Choose the Delete command from the Edit menu, or from the shorthand menu accessed by
clicking the right mouse button. From the keyboard you may use the delete key.

3. The selected track/objects are removed from the current layout and the track list, which is
updated to reflect this change. The contents of the select list are cleared, with the select list
window reflecting this change.

When deleting track and objects, you will be asked for confirmation if the Confirm All Deletes
option is set in the Global Options dialog. In any event, you will always be asked to confirm
deletes of more than 100 items. Deletes of less than 100 items may be recovered using the Undo
Delete command under the Edit menu. RR-Track maintains an undelete buffer for each layout
window; track deleted in one layout does not affect deletes in another layout.

see also:
copying track, selecting track

Designating isolated electrical blocks

You may designate and change electrical blocks in two ways. The simplest is to use the Create
Block command to set block breaks at the ends of all of the selected track, and the Clear all block
breaks command to remove the electrical breaks within, and at the ends of, the selected track.. The
second method uses the Set/Clear block breaks command to individually designate or destroy
electrical breaks. The display of block breaks, denoted by a double circle, is set or cleared using
the Global Options dialog, accessed with the Global Options command under the Options menu.
You may only set and clear electrical blocks in track sections that are highlighted, the same as for
any other command under the Action menu.
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RR-Track distinguishes between soft block breaks, which are those that you create using the Create
block and Set/Clear block breaks commands, and hard breaks which are associated with special
pieces of track found in some manufacturers track libraries that are not electrically continuous at
one end. You cannot remove a hard block break.

To set, and clear, individual block breaks, you use the Set/Clear block breaks command found
under the Action menu. The Set/Clear block breaks command lets you toggle the electrical
continuity of the nearest track joint in the selected (highlighted) track, while the Clear block breaks
command removes all electrical breaks in the selected track sections.

To set or clear a single electrical break:
1. Select the track sections containing the electrical break junction.

2. Pull down the Action menu and choose Set/Clear block breaks. The cursor will change to an
arrow with the words ‘Block break’ under it.

3. Move the tip of the arrow close to the joint you want to change the electrical continuity status.
Click the left mouse button. If the cursor is not inside any of the selected track sections, you
will here a beep advising you that no joint can be found, otherwise the electrical state of the
nearest joint will change immediately, with a double circle indicating a break (only if you
have enabled displaying block breaks in the Options dialog).

4.  The cursor returns to the Windows arrow with the new status of the block displayed. The
track sections remain selected.

To create an electrical block with the selected track:

1. Select the track sections containing the electrical breaks you wish to clear.

2. Pull down the Action menu and choose Create block. Break points will be placed at the ends
of the selected track; breaks interior to this are unaffected.

To clear all breaks in the selected track:
1. Select the track sections containing the electrical breaks you wish to clear.

2. Pull down the Action menu and choose Clear all block breaks. All break points will immedi-
ately be removed and their status updated.

To display electrical block breaks:

In order to display electrical block breaks on your drawing you must enable this option through the
Options dialog which may be accessed either through the Options command in the Control Menu,
or the Layout Options button in the Global Options dialog. In this dialog you change the display
status of electrical blocks by checking or unchecking the Display block breaks option.

It is useful to be able to selected track sections which are not only physically joined to one another
but also electrically contiguous. You can change the extended selecting mode of track to electri-
cally connected track by using the Selections include blocks commands under the Options menu.
By choosing Selections include blocks you place an additional constraint on the selection of
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adjoining track sections by requiring they also be electrically connected. For example, if you have
set Selections include blocks and double-click on a track section between two block breaks, you
will highlight that track section under the cursor and all of the track connected to it that is between
the two block breaks. This makes it easy to see which sections of track you have tied together
electrically.

Soft block breaks are automatically removed when you unjoin a track section that is at a block
break. This, of course, does not apply to special isolation track sections in some manufacturers
libraries that set a sard block break at a junction.

see also:
global options dialog, selecting track

Duplicating track and objects

The Duplicate item on the Edit menu lets you duplicate any items that you have selected (high-
lighted). RR-Track pastes a copy of the items starting at the last point the left mouse button was
clicked on in the layout. The duplicated items are highlighted. This is basically a one mouse-click
combination of Copy and Paste, except that the duplicate command clears the RR-Track clipboard
contents.

A more specialized duplication of track occurs when you choose the Duplicate parallel command
from the Edit menu. This command is used to replicate track parallel to, and offset from the
selected track. When you choose the Duplicate parallel command you will see a dialog like the
one below:

The Duplicate-track parallel dialog
has a preview window to the left

soo— [ which dynamically shows you the

Duplicate track - parallel

;gg:— position of the newly duplicated

200— track. There are a number of
1 00— Increment

0.00— Coa controls to the right which are used
L e A1.00— ® i to both set and display the offset

e C 05" distance, as well as control the

-4 00— Ci1ot offset increments.

[ S| gpp—
= The vertical control to the right of

RN - E the preview window that looks like
a stereo amplifier’s fader is used to
set the offset distance. Positive values correspond to offsets that raise the track up, while negative
values correspond to those that push it downward (for horizontal track). Directly below the fader
is a panel readout which is used to display the current offset distance, with up/down spin buttons
adjacent to the panel readout. The radio buttons directly below the OK and Cancel buttons,
labeled as an Increment group, are used to set the current increment resolution for the offset
distance. As you select different increment values, the range of available offsets shown on the
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fader control change. The fader control can reach any offset in the range shown, while the up/
down spin buttons increase/decrease the offset by the value indicated with the radio buttons in the
Increment group. Using the up/down spin buttons, you can reach any offset distance, and are not
limited to those shown by the fader.

Procedure:

1. Select the track you wish to create a parallel duplicate of.

2. Pull down the Edit menu and choose Duplicate parallel. The duplicate parallel dialog appears.

3. Using the fader control, and/or the up/down spin buttons, set the parallel offset that you want.
The preview window updates every time you change the offset so that you can see exactly
where the parallel trick will be placed.

4.  When you are satisfied with the parallel offset, push the OK button. The selected track is
parallel duplicated in the indicated offset position. The selected track remains highlighted
after duplication and you are returned to the layout window. If instead you wish to abort the
parallel duplication, press the Cancel button.

see also:
cut, copy, paste, selecting track and objects

Editing objects

RR-Track allows you to edit any general purpose object that you create, and to rescale any set of
grouped objects. This editing capability means that you do not have to draw an object exactly
correctly the first time; you can go back at any time and resize or rescale it. Resizing refers to
moving an individual corner or edit point, resulting in an over all shape change. Rescaling refers
to changing the overall size of an object at equal scale in all directions.

All editing in RR-Track is done with the mouse. You use the mouse to ‘grab’ an edit point on the
object your are editing, and then drag it to where you want it, letting go when you X
reach the desired size or position. This is similar to the way that you move an object

around the screen, except here you move just one part of an object.

Ordinarily, RR-Track does not display the edit points on an object. When you select

the object, RR-Track not only highlights it but displays the object’s edit points, as for the rectangle
at right (when selecting multiple objects, RR-Track shows the edit points of the lead selection if
the lead selection is an editable object). RR-Track draws an object’s edit points as
small, filled circles. Here there are four edit points, one on each corner. One of the edit
points, that at the upper left, has a box drawn around it. The box signifies that this edit
point is the origin of the object, but you may move this edit point as you would any of
the other three. At left is a six-sided filled polygon. Each vertex is

an edit point, with the left-most vertex also the origin of the polygon. Atright |
is a group consisting of three rectangles. The edit points for the group are the
corners of the group bounding box; note that the origin is not at any of the edit
points.
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When resizing or rescaling an object, the current snap settings are in affect, but they are applied in
the coordinate system that is intrinsic to the object. For rectangle objects (and buildings which are
derived from rectangles) and grouped objects, the intrinsic coordinate system is along the width
and height of the bounding box, even if you subsequently rotate the object. For all other objects,
the intrinsic coordinate system is the same as the overall coordinate system for the layout. In order
to resize or rescale an object, the following routine is recommended:

Procedure:

1. Select the object you wish to edit. RR-Track highlights the object and displays the edit points.

2. Place the cursor over the edit point that you want to move (it must be over the point in order to
grab it) and depress and hold down the left mouse button. RR-Track changes the cursor to an
arrow with the word ‘Edit’ below it to indicated that you are about to resize or rescale the
object (if you miss the edit point, the cursor will change to an arrow with the word ‘Move’
below it indicating you are about to move the entire object). At the same time RR-Track
shows a small readout window in the upper right corner of the layout window. This readout
window shows the relevant current and changing size settings of the object.

3.  While continuing to hold down the left mouse button, drag the edit point to the position you
want. While you move the edit point, RR-Track continuously updates the readout window,
telling you the size and position, and the per cent change in size or position.

4.  When you reach the desired size or position, release the left mouse button. RR-Track immedi-
ately updates the objects new size, and dismisses the readout window.

You can repeat the above procedure as many times as you like; there is no limit to the number of
times you can edit an object. Grouped objects can only be rescaled isotropically; this is enforced
by RR-Track. Polygon objects (this includes trees and turntables) allow each of their individual

vertices to be edited; this can upset the overall symmetry of these objects if carried to an extreme.

Elevating track

RR-Track allows you to change the elevation (height) of a section or sections of track while
performing the calculations for the grades on either side automatically. RR-Track distinguishes
track that is not at zero height (flat on the table or ground) as one of two types; elevated track or
grade track. Elevated track are those sections, which are contiguous, that are all at the same height.
Grade track are those sections, on one or more sides of an elevated track, that have both non-zero
height and a non-zero slope (i.e. the track sections one either side are at different elevations).
Grade track is denoted by a small arrow symbol at the center which points in the direction of
increasing elevation. There are four commands, all located under the Grades menu, which change
the elevation of track: Change elevation, Remove elevation, Set Track Height, and Zero Track
Height. Another command, Reconcile grade recalculates the track junction heights of an existing
grade. In order to use most of the commands on the grade menu, except for the Change elevation ,
Set Track Height, and Zero Track Height commands, you must have the extended selecting mode
set to Selections Include Grades.
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In order to change the elevation of some track, you first select it with the mouse and then choose
the Change track elevation command found under the Grades menu. When you do this, you will
see the dialog shown below:

Description: below is
Change track elevation E .p .
- . a preview window

500— [ which shows a rough
S drawing of the track
00— Height inc— | layout zoomed out so
flm= O 0.05" that the entire layout is
el C 01" visible. Existing
2.00— ® 0.25" elevated track is
e C 0.5" shown in dark red;
-5.00— existing grades are
e shown in magenta.
_ E The track you have

hosen to el i
C10x C20x C 30 C40x O 75% chosen fo elevate 1s

C 15z O 25% O 35% @ &% C 10 shown in red. As you

change elevations, any
new grades are shown
in orange if they are above table level, or blue if they are below table level.

Immediately below the preview window are a set of radio buttons in the Grade group that are used
to both indicate and set the required grade. These grades are expressed in per cent. Per cent grade
is an engineering term which merely indicates the ratio of the rise of the track to the run along the
table (for example, a five per cent grade means that the track rises 5 inches for every 100 inches
along the table). You have fixed grade choices ranging from 1.0 to 10 per cent. Keep in mind that
a five per cent grade is steep; most real railroads try to hold this to 1.0 or 1.5 per cent and hi-rail
layouts to 2.5 per cent — Lionel® trestle sets use grades between 7.5 and 10 per cent.

To the right of the preview window is a fader control similar to that on a stereo amplifier. Immedi-
ately below the fader control is a panel readout which shows the change in elevation for the
selected track. The up/down spin buttons next to the panel readout work, in conjunction with the
fader, to let you vary the change in elevation. The set of radio buttons to the right of the fader, in
the Height Inc. group, are used to set the incremental height changes used both by the fader control
and the up/down spin buttons.

The Change Track Elevation dialog is designed to let you graphically change the elevation of the
selected track, highlighted in red, while RR-Track dynamically calculates the number and height of
the grade track sections on either side which are required to accommodate this height change. You
can change the grade by selecting one of the radio buttons in the Grade group and instantly have
RR-Track update the preview window, showing the track sections that will be picked up to accom-
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modate this grade. You can leave the grade fixed, and vary the height using either the fader or the
spin buttons. Similar to the interaction between the fader and the distance increments in the
Duplicate Parallel dialog, as you change the height increment with the radio buttons in the Height
Increment group, the range on the fader updates (to get a larger fader range, increase the incre-
ment). The spin buttons are not bound by the fader range, and can change the height to any value
in increments set by the radio buttons in the Height Increment group.

When RR-Track changes the elevation of track sections, by using the Change Elevation command,
the Remove Elevation command, or the Zero Track Heights command, the track display list is
sorted to force rendering the track with the lowest elevation first, and that with the highest
rendered last. This automatically makes higher track sections appear to pass over lower ones,
although you will still be required to set overpass characteristics for the grade track. RR-Track
automatically sets the elevated portion to overpass status.

To change an existing track elevation
To change the elevation of track, use the following method:
Procedure:

1.
2.

Select the track section(s) you wish to elevate.

Pull down the Grade menu and choose Change Elevation. The Change Track Elevation dialog
appears, as shown above.

Using the fader and/or the spin buttons, move the selected track to the required elevation. As
you change the elevation of the track, RR-Track will show the grade track sections on the ends
of the elevated track that are required to accommodate the grade set in the Grade group.
Manipulate a combination of the grade buttons, fader, and spin buttons until you reach both an
elevation you want, and the grade that you can live with.

When you are satisfied with your grade design, press the OK button. RR-Track immediately
applies the grade changes to the layout track, updating the layout display. If you decide you
do not like your choice of grades, press Cancel to return to the layout with the track elevation
unchanged.

Another way to change track elevation is to use the Set Track Height command discussed a little
further on in this manual. In contrast to the Change Elevation command, when using the Set Track
Height command, RR-Track does not automatically create grades on the ends of the elevated or
depressed track.

To remove an existing track elevation

In order to remove an existing track elevation, carry out the following steps:
Procedure:

1.

2.

Pull down the Options menu and change the extended selecting mode to Selections Include
Grades, if it is not already set so.
Select the elevated track (not grade track) which you wish to return to zero height.
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3. Pull down the Grades menu and choose Remove Elevation. If this command is grayed out,
return to step one and make sure the extended selecting mode is set to include grades.

4. RR-Track immediately zeros the elevation of the elevated track and all grade track contiguous
with it, reordering the display list as necessary to reflect the new heights.

Getting details on grade and elevated track

After you have set some elevations and grades in a layout, getting some detailed information on the
elevated track sections, and especially the grade sections, is quite useful. You can access this
information with the Information command under the Grades menu. Doing so is straightforward:
select the elevation or grade you want to examine by double-clicking on it with the extended
selecting mode set to Selections Include Grades. The pull down the Grades menu and choose the
Information command. When you do so you will see one of two dialogs depending on whether you
have selected elevated track or grade track:

Elevated track informat... B
Length:] 11.75in

Track sect: I 1
Height:l 1.00in

For elevated track, you will see the total
length, the number of track sections in the
elevation, and the elevation height. For grade | Lenath:| " 20.00in

track you will see the total length, the number | Track seet:|~ 2 | 0K
of track sections, the height change (from low [ion

Ht. change: 1.0in

to high end), and the exact per cent grade.

Press OK to dismiss the dialog and return to grade: ["50%
your track layout. Note that the grade shown in the Grade Information

dialog may be somewhat less that that you requested when you used the Change Elevation dialog
to set the elevation and grade originally. This is because RR-Track creates grades by picking up
integral pieces of track, and does not bend a track section in the middle somewhere. RR-Track
chooses the number of track sections necessary to create the chosen grade, but not a grade steeper
than the chosen grade.

Reconciling grades

When several elevations are introduced into a track layout, it is quite common to end up with a

non-smooth grade between adjacent track elevations (a non-smooth grade is a contiguous set of

grade track with an unequal per cent grade, i.e. some track descends and then changes to ascending

as you traverse the grade). You can see this if you have RR-Track display the track junction

elevations on grade ( see Global Options). You can have RR-Track smooth out the grade and

recalculate the track junction heights by using the Reconcile grade command. In order to reconcile

a grade, carry out the following steps:

Procedure:

1. Pull down the Options menu and change the extended selecting mode to Selections Include
Grades, if you have not already done so.

2. Select the grade track you want to reconcile by double-clicking on it with the left mouse
button.
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3. Pull down the Grades menu and choose Reconcile grade. RR-Track immediately recalculates
the track junction heights in the grade and shows you the Grade Information dialog.

4. Press the OK button on the dialog when you are finished viewing the grade information. You
are returned to the layout with the newly smoothed grade.

Manual Grade editing

While automatic grade calculation during creation of elevated track is simple, there are many
situations in which you would like to gain some further measure of control over the grades and
elevations in your layout. The following topics cover common grade editing procedures that use
the Set Track Height, Create Grade, and Reconcile grade commands.

Adding to and subtracting from grades: You can use the Reconcile grade command, in conjunc-
tion with some of the other commands, to both add to and subtract from an existing grade. Since
RR-Track creates symmetric grades (i.e. the grade track on both sides of elevated track has the
same slope), this is a way to create asymmetric grades.
To add to an existing grade:
1. With the extended selection mode set to Selections Include Grades, select the grade you want
to add to by double clicking on one of its track sections. The grade will then highlight.

2. Select the track section(s) you want to add to the grade by adding them to the selected track
(hold down the SHIFT key while clicking on them with the left mouse). Any track you add to
the grade must be contiguous with the grade (RR-Track will check for these and advise you if
you err).

3. Pull down the Grades menu and choose Reconcile grade. You will see a dialog which shows
the composition of the new grade, as well as its slope. Click the OK button. RR-Track
immediately updates the grade, adding the new track sections.

To subtract from an existing grade:

1. Choose the track sections you want to remove from the grade by clicking on them with the left

mouse button.

2. Pull down the Grades menu and choose Zero Track Height. RR-Track immediately sets their
height to zero, and recalculates any connecting grades to reflect changes precipitated by
setting the selected track to zero height.

Setting the absolute track height: You can use the Set Track Height command to set the absolute
height of one or more track sections, accessories, or objects.
This command is useful for creating asymmetrical grades, or
Average ack height setting up intermediate elevated areas on existing grades ( for
[ oooin ] more complex grade systems). When you choose the Set

Height inc Track Height command, you will see a dialog box like that at
{ O 0.05" @ 01" C 0.25" C 0.5" left:

The readout control shows the height of the selected items
(this will be the actual height of a single item, or the average height of any multiple selections).
The up/down spin buttons are used to change the height in the readout control. The increment used
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by the spin buttons is determined by the radio buttons just below the readout control. Use the up/
down spinner to set the new height, and press OK to have RR-Track set the new height, or Cancel
if you decided not to change the height.
To set the absolute track height:
1. Select the track sections, accessories, or objects whose height you want to set.

2. Pull down the Grades menu and choose Set Track Height. The Set track height dialog
appears.

3. Use the up/down spin buttons to set the new height, and then press OK. RR-Track sets the
selected items to the set height, and automatically recalculates any attached grades.

Manually setting grades: You can use the Create Grade command to manually place a grade in
your layout. This command is generally used in conjunction with the Set Track Height command,
which is used to manually set the absolute track height. Track sections selected for a new grade
must not include objects or accessories or existing grades sections.
To create a grade:
1. Select the track sections you want to include in the grade, taking care that they are contiguous.
They must not include existing grade sections, accessories, or objects.

2. Pull down the Grades menu and choose Create Grade. RR-Track analyzes the selected track
for continuity and other restrictions, and then displays a dialog showing the calculated per cent
grade, number of track sections, and height change.

3. Press the OK button. RR-Track immediately creates the grade.

Note that you can use the Set Track Height and Create Grade commands to not only insert new
elevations and grades into your layout, but also to edit and fine tune existing elevations and grades.
For instance, you can use these commands to set intermediate elevations on existing grade sections
created when you used the Change elevation command.

Notes and limitations: RR-Track measures heights and elevations from the layout base which is
either the top of your benchwork or the floor for layouts on the floor. This position is considered
zero height; track that descends some below your benchwork level is a negative elevation as far as
RR-Track is concerned. RR-Track is restricted to changing the track elevation of selected track
with 16 or fewer ends, and is also limited to a maximum of 200 track sections in each grade on
those ends. These limits will meet almost all grade situations. RR-Track is further limited to
calculating simple grades; that is if RR-Track encounters a non-simple track section on a grade
(such as a turnout or any other track section with more than two ends) it will continue the grade
calculation using only the straight-through path (for a turnout this is the thru track) and will ignore
any other ends. For these cases you will need to break up the grade into a combination of eleva-
tions (using the turnout as one of the elevations) with connecting grades.
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Finding out layout information

You can find out statistical information about a layout by pulling down the Control Menu for that
layout and choosing Info... RR-Track then displays the

Layout Information dialog, as shown at left.

Size

1320n « 4800 The Layout information dialog displays the size of the
- Track———————— layout, the total number of track sections of all types, the
total number of accessories of all types, and the total
number of general purpose objects of all types. The track
sections are further broken down into quantities of straight
kiobptes: | 23 3 | track, curved track, turnouts/switches, and other track
(crosses, uncoupling tracks, power tracks, etc.). When you
are finished studying the layout information, press the OK
button.

Track sections:

Finding out track and object properties

You can access the details on a given items properties by positioning the cursor over it and clicking
the right mouse button. When you do so over track, you will see a the Track Properties dialog like

that below:
Position group: this tells you the location of the origin for

the track and its current orientation (angle) in degrees

measured counter-clockwise from the horizontal axis.
Properties group: this shows you the length, and arc angle

(===

:“’l‘""’;m anq radius for a curved tr.a‘ck section; and the total length and

[ Ton o[ G0 rad1u§ for a turnout trap51t10n track.

e Details button: pressing the

Length: | am P ook Details button will show you the
Are: connection properties of all of the ~ [unetions——— [ #k_]

Radius: Cost [§1.50° track junctions in a dialog such as || {erries [cance |

library build 240022

that at right:

Junctions group: this shows you the joining and block break status for
each of the track junctions. Straight and curved tracks have two
junctions, turnouts three, crosses four, etc.

The overpass, locked, and in some track libraries swap switch machine check boxes show the
current overpass status, locking status, and whether the switch machine has been swapped for this
track section. You may change these track properties by checking or unchecking all of these
controls. If you set the overpass status of the track section, RR-Track will redraw it and bring it to
the top of the display list immediately after you press the OK button. Pressing the Cancel button
will cancel any changes you have made to the locking, overpass, and switch machine status. For
more information on changing overpass attributes see overpass track.
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The cost readout tells you the cost of this item, as set in the .INI file for that track library. You may
change the cost, on-the-fly, by pressing the Change button. When you do so you will see a dialog
like the one at right:

Simply type in a new cost (dollars and decimal cents) and press the OK Cost [000

button. To dismiss the dialog without changing the price, press Cancel. Enter the new
Price changes take effect immediately. ST s

When you click the right mouse button while over a drawing object, you
will see a dialog like that below:
Position group: this shows the position and

turntable orientation of the drawing object in the current
[Posttion units system. As for track, angular positions are
H: [ ao.oin v:[105 5ir measured around counterclockwise from the

Angle: I 0.0° horizontal.

Properties group: this shows the relevant
EoE=ie: (Eltre dimensions for the object (length for lines, radius
Length: | 15.00in || Draw: |EETIKOCICENE| | for circles, etc.).
width: | 13.00in i Colors group: this shows the drawing (outline)
and fill colors, if applicable, for the object.
For text label objects, there is an Edit button which
you can use to bring up the Text Label dialog and edit the text label.

Pressing the OK button dismisses the dialog and returns you to RR-Track.

see also:
creating text labels

Grouping and ungrouping objects

In order to build up more complex drawing objects out of the basic shapes of lines, rectangles, and
circles that exist under the Object menu, you may group them so that they are treated as a single
object by RR-Track. When grouped, they may be selected and moved, rotated, copied, and deleted
as a single entity. This makes creating complex diagrams of structures and accessories on your
layout a more simple task. Even more complicated objects can be created by building them up
from groups of simpler groups, for instance a combination watering, coaling, and sanding station
put together from separate watering, coaling, and sanding facilities.

Procedure:

1. Select the objects you wish to group using the pointing device. The easiest way is to sweep
out a selection rectangle around the objects you want to group.

2. Pull down the Action menu and select Group Objects. The selected objects are redrawn with
a dashed rectangle around them indicating they are grouped. This dashed line only appears
when the grouped objects are selected and highlighted.
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You cannot form a group from a single object, and track sections are not allowed in a group and
will be ignored if they are included in the selected objects. RR-Track maintains a distinction
between track and objects since objects have spatial extent, but do not have junction points with
positions and directions.

In order to ungroup a grouped object, simply select it and choose Ungroup Object from the Action
menu. The first grouped object found in the list of selected objects will be ungrouped and redrawn
without its telltale dashed grouping rectangle.

Joining track sections

Joining track sections is the most common operation carried out when building a toy train layout
other than adding new track sections. RR-Track makes a distinction between physically joining
track sections, which it then treats as a single entity when selecting, moving, or rotating, as
opposed to aligning the track sections, which merely means the appropriate track control points are
physically placed together, but not marked as joined (see aligning track sections for more
information on aligning track).

There are two distinct methods for joining track: you may join selected track to the nearest unused
track control point that is not contained in the selected (highlighted) track, or you may enable
automatic track joining and simply bring the two ends you wished joined to within a track width of
each other (this is 1.25” for O-gauge and 0.625” for HO track). The second method is the simpler,
and is the most often used way of joining track sections.

The Join to Nearest Track item is the user initiated analog of automatic track joining ( see the
Options menu and see the section on moving track). RR-Track scans the track list for the smallest
distance between unused track control points in the select list and the rest of the track list. When
found, the track in the select list is joined as a unit to the nearest track in the unselected portion of
the track list, if the distance is less than the capture radius for that track library ( the capture radius
when adding new track is 6.0” for HO track, 12.0” for O track, 18.0” for G track, etc. RR-Track
uses a different capture radius when moving track which is equal to the width of the track i.e.
0.625” for HO, 1.25” for O-gauge, etc.). If confirm track joining is enabled, the closest track and
joining points are highlighted in cyan, with a line drawn between the chosen control points, and
user confirmation is asked for.

Procedure:

1. Select the track you wish to join. The track is highlighted in red.

2. Move the selected track near to the track you wish to join. RR-Track will join the closest pair
of unused control points.

3. Select Join To Nearest from the Action menu. The track is immediately joined, subject to
confirmation if that has been enabled.

To use the second, and easier method of joining track, simply bring them near each other, and
make sure the automatic track joining option is checked in the Global Options Dialog. When
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automatic track joining is turned on, you only have to move the track ends you wish to join within
a track width of each other. I recommend this method (RR-Track automatically starts up when first
used in this mode).

see also
selecting track,moving track, aligning track sections

Locking and unlocking track and objects

The Lock selected items and Unlock selected items pair of commands lets you fix track and objects
on the layout so that they cannot be accidentally moved or rotated. As an example, you may have
constructed an outside loop of track, and now wish to work on inner loops or yards, and want to
reference the new track to the outside loop. To keep from accidentally moving the outside loop,
you can lock it in place. Later on, when you are done, or want to move it, you can unlock it by
selecting it and using the Unlock selected items command.

To lock items in place:
1. Select the items you wish to lock down using the mouse.

2. Pull down the Action menu and choose the Lock Selected Items command. RR-Track sets a
lock on the selected items, keeping them from any subsequent moves or rotates.

To unlock locked items:
1. Select the locked items you wish to unlock using the mouse.

2. Pull down the Action menu and choose the Unlock Selected Items command. RR-Track
removes the lock on all of the selected components.

If you try to move or rotate items in which some are locked, you will be advised of this condition
and the requested move/rotation will be ignored.

Measuring distances on the layout

Often it is useful and even crucial to know the distances between objects and track sections on the
layout in order to correctly space switchyards, unloading docks, or find out what length of track
you need to fill a gap. Distances are simply measured using the measuring tool in RR-Track.

Procedure:

1. With the cursor showing the Windows arrow (i.e. you aren’t in the middle of some other
operation such as drawing an object), place the tip of the arrow where you wish to anchor one
end of the distance line.

2. While holding down the SHIFT-key, depress and hold the right mouse button. The cursor
will change to a ruler with a small star which denotes the aiming point. This signifies that
you are using the measuring tool.
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3. Still holding the SHIFT and right mouse buttons, move the aiming point to where you wish to
end the measurement. RR-Track draws a line showing the distance that will be measured.

4. Release the SHIFT-key and right mouse button. A dialog, like that shown below, will tell you
what the total distance is, the angle, and the horizontal and vertical components of this
distance. Press the OK button when you are finished studying the measurement. The cursor
returns to the Windows arrow.

Distance Performing the previous set of steps while holding down
the ALT-key rather than the SHIFT-key will cause the
Custom track measuring tool to snap the endpoints to the nearest track

W 3 50in points. This is useful when you want to know the exact

distance between track ends. While you are making the

Horz: 3825|n

: ; <stock track> " :
I 38.41in L measurement, the x- and y-position readouts in the status
<radiuz curvc? . . . .
et <general curves window change from showing position to showing the

instantaneous measured distance, handy for getting
feedback on how far you have displaced the cursor.

The Distance dialog also contains command buttons, in a control group labelled Custom Track,
which are used to engage any track wizards which the current track library, or the track library
containing the two track sections that are connected by the measurement. Stock track tells the
wizard to fill the gap with stock track sections, radius curve to fill the gap with the largest radius
curve that will fit, and general curve to fill the gap with a general curve (a curve of constantly
changing radius, like an easement).

Moving track and objects

Moving track sections and objects is very easy with RR-Track. Movement is done entirely through
the mouse cursor in a what-you-see-is-what-you-get manner. The procedure is simple and straight-
forward.

Procedure:

1. Select the track or objects you wish to move.

2. Place the cursor over, or in, one of the track sections or objects you wish to move (for a
general purpose object this will have to be on one of the drawn lines). Depress and hold the
left mouse button. The cursor will change to a diagonal arrow with the legend ‘Move’.

3. While holding the left mouse button down, move the cursor to where you want to place the
track or objects. The track will move with you, with control points indicated, so that you may
see exactly where the track will be placed.

4. When you reach the destination, release the left mouse button. The old track/object positions
will be erased and the new ones drawn. The track sections remain selected; you must
manually deselect them unless automatic track joining is enabled and a track join occurs.

If you have enabled automatic track joining, found both on the Options menu and in the Global

Options dialog, then all you have to do to have track automatically join when moving sections
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around is to bring the free end of the track you wish to join within one track width of the target
track section. RR-Track will automatically join the track sections if you bring them to this proxim-
ity. For example, if you are using LGB® G-gauge track, you need to bring the track sections to
within 1.77” of each other. For O-gauge track, the capture distance is 1.25”.

_Hint: you may combine selecting an item and moving it into one mouse motion

by placing the cursor over the object you wish to select and move, then depress

and hold the left mouse button. After approximately 1/4 to 1/2 second the item

will be highlighted and the cursor change to the move cursor (an arrow with the

word move below it). At this time you drag the item where you want it, and

release the left mouse button.

Using the Move command: If you are not comfortable with moving items using the mouse, you

can also move selected items by using the Move dialog, accessed by choosing the Move command

from the Action menu. When you choose the Move command, you will see the Move dialog as
shown to the left:

The readouts at the top show how far you have moved the selected items vertically and

horizontally respectively. These are relative movements; that is the horizontal and
- vertical readouts show how far you have moved the selected items since you chose the
Move Move command.

A The four buttons with arrows are used to move the selected items one step in the
|4|i"° »|| indicated direction, where the step size is the current setting of the snap size in your
hd layout. Each time you press one of these buttons, RR-Track immediately moves the
[ % step selected items so that you can see where they are now located. You can access the

Snap Size dialog to change the snap size by pressing the inc button.

The check box labeled “1/2 step”’ is used to change the move increment to half of the
—— | current snap size. You can turn this on or off as many times as you like during any
given move session.

When you are finished moving the selected items, press the OK button. If you decide you do not
want to move the selections, then press the Cancel button. RR-Track will then return the selections
to their starting position, and return you to your layout.

see also:
selecting track

Miove selcted items o.. Moving items between layers

~umper el rack — Whep you create a new layer, or wfant to get rid of an
ﬁum .| existing layer, you will more than likely want to move
loger pou some items in existing layers to the new one, or move
Tevetoona | 1tems in the old layer to some other layer so that you can
o Pes remove the layer. In order to do this, you use the Move
to layer command found under the Action menu. RR-
= Track displays the Layer Chooser dialog so that you can
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choose the destination layer, and then moves the items. As soon as they are moved, they inherit the
properties of the new layer. In other words if you move items from a visible layer to a hidden or
grayed layer, they are redrawn as hidden or grayed.

Procedure:

1. Select the items you want to move to another layer.

2. Pull down the Action menu and choose Move to layer... The Layer Chooser dialog appears.

3. Select the destination layer from those in the list and press OK. Or, double-click on the
destination layer combine choosing a layer and clicking OK. If you decide not to move the
items, choose Cancel. RR-Track immediately moves the items to the destination layer.

See creating, changing, and removing layers for more information on layers.
Opening an existing layout

To open an existing layout file for viewing or editing, use the Open... command from the File
menu. The current layout file, if any, will be closed. If any changes have been made to the current
file since it was opened, you will be asked if you wish to save it. After taking action on the current
file, RR-Track displays the Windows Open File dialog at which point you may indicated the
drive, directory, and file you wish to open.

Procedure:

1. From the menu bar, select File and then Open... from the drop-down menu. The current
layout, if any, will be saved.

2. From the choices shown in the Open File dialog, select the layout file (yourname.rrt) which
you wish to open by manipulating the drive icon, the directory folder icon, and selecting the
layout file from the file names listbox.

3. When satisfied with your choice, click the OK to open the file, or Cancel if you have changed
your mind and wish to return to the RR-Track main window.

RR-Track remembers the names and locations of the last four layout files opened. These are found
at the bottom of the File menu, in the order of recent use. You can quickly open one of these
simply by clicking on the layouts file name.

see also:
saving a track layout file

Overpass track

RR-Track normally draws track as a see-through item; only the rails and end lines are rendered, as
well as track joining accents, track and grade labels, and switch machines. However, when one
track section is passing over another, it is visually useful to show the overpass track blanking the
track underneath. In order to do so, you can set the overpass attribute for any track section on the
layout. You may also remove the overpass attribute at any time; the overpass attribute is an
editable characteristic in release 3.02 in contrast to earlier releases of RR-Track.
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When you set the overpass attribute, RR-Track immediately moves the track sections with the
overpass attribute to the top of the display; removing the overpass attribute has no effect on the
position of a track section in the display list.

To change the overpass attribute:

You can change the overpass attribute in one of two ways, either by using the toggle overpass
command found on the shorthand menu summoned from a right mouse click, or using the track
property inspector summoned by a right mouse click when over the desired overpass track section.

Procedure when using the toggle overpass command:

1. Select the track section(s) whose overpass attribute you want to change.

2. Position the cursor over an empty screen space and click the right mouse button to bring up
the shorthand menu.

3. Choose the toggle overpass command. RR-Track toggles the overpass attribute of all selected
track sections; those that are not overpasses are set as overpasses, and those that are over-
passes are cleared. You are returned to the layout with the selected track still highlighted.

Procedure when using the track property inspector:

1. Position the cursor over the track whose overpass attribute you wish to change. The track
section does not have to be selected.

2. While over the track section, click the right mouse button to bring up the Track Properties
dialog.

3. Find the overpass check box and check it if you want the track to be an overpass, or clear it if
you don’t.

4. Press the OK button to apply your changes, or the Cancel button if you have decided to not
make any changes. You are returned to the layout.

Pasting track into the layout

The Paste command from the Edit menu allows you to paste track sections or other objects from
the RR-Track clipboard into the current layout. The pasted items will be placed at the upper left
corner of the current view, and automatically selected (highlighted), replacing any previously
selected objects. The contents of the RR-Track clipboard are not changed by this command. If the
clipboard is empty, this command will be grayed out and you will not be allowed to select it.

Procedure:

1. Select the Paste command from the Edit or shorthand menus, or hit Ctrl-V from the key-
board.

2. The track or other objects in the RR-Track clipboard will be added to the track layout near
the upper left corner of the current view, and will be selected (highlighted). Both the track
list and the select list are updated reflecting this change.

See also:
copying track, deleting track
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Relaxing mismatched track

If you have been assembling sectional track for any length of time, you have noticed that the final
“fit” for a closed loop is not necessarily exact, and may in fact have quite a bit of error, well over an
inch if all of the sections are properly joined. This residual ‘slop’ is soaked up by ‘adjusting’ the
fit of a number of track sections on both sides of the closure point. The purpose of the Relax Track
command is to do just that; incrementally adjust the location and rotation of track sections in order
to minimize the mismatch at joints, i.e. spread the error out so that it is not concentrated at one
junction.

RR-Track models the track sections that you tell it to ‘“fudge’ as a set of fixed length objects that
are connected by springs. It then moves the track sections searching for a configuration that
minimizes the overall forces and ‘energy’ stored in the track-spring system. While not perfect, the
resulting configuration isn’t far in most cases from what you would do yourself. As a bonus, RR-
Track displays statistics, both during the relaxation process and at the end, which can be used to
judge for yourself whether this resulting configuration will be usable. While a minimized track
configuration will always be found, large residual mismatches in both angle and displacement
mean that the real track configuration will be rather strained, and likely to come apart in use unless
well fastened to support of one kind or another.

When you select the Relax
Selected Track command
from the Action menu, a

¥ dialog like that at left
Restore appears:

Selected track relaxation

— Relaxation parameters — | [ Feedback

Hoveahlel 3 Avg energy:
Iteration count - [t EeEEr:

Avg gap:

X

— Relaxation rate [ Max movement Done There are a lot of informa-
Max gap: . . g
< Full " 0.5in tion displays on this dialog
" 0.25in Avg angle: starting at the upper left.
" Small &0 1in Max angle: Help._

fLRE]

Relaxation parameters:
here there are two items
displayed, Moveable which shows the number of track sections you allowed RR-Track to move
around, and Iteration count which is the number of times RR-Track has gone over the moveable
track and adjusted them for better fit.

Relaxation rate: here you have a choice of full, normal, and small. Normal is the default and is
usually the best choice; when you are in the final stages of relaxing the track you can try changing
this to small.

Max movement: this sets an upper limit on the distance RR-Track can move a piece of track on
each iteration, regardless of how far it would like to move it. A maximum limit is set to minimize
the chances of ‘bouncing around’ between two or more similar track configurations. Here you
have a choice of 0.5 inches, 0.25 inches, and 0.1 inches. The default choice is 0.25 inches; when
you are in the final stages of relaxing the track you can try changing this to 0.1 inches. RR-Track
also adjusts this dynamically depending on the maximum gap error that it finds.
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Feedback: RR-Track dumps out a lot of number to try to guide you through the relaxation process
which is as much an art as it is a science. There are six parameters displayed: average energy,
max energy, average gap, max gap, average angle, and max angle. The two most important of
these are the average gap and the max gap. The average and max energy readouts show the
current average energy and the maximum energy (in arbitrary units) of the movable track sections.
If the average and maximum energies are similar, then the error is pretty much uniformly spread
out over all of the movable track (which is what you are aiming for). The average and max gap are
the track junction gap errors (in inches) of the movable track sections. Again, you are trying to
make these nearly the same. If the maximum gap is a lot more than the average, this means one
track section is stuck with most of the error. The average and max angle are the track junction
angular errors ( in degrees) for the movable track sections. Here you are usually interested in only
the maximum angle since this shows you the worst aligned track junction. The greater this error,
the more of a ‘jerk’ trains will experience when they traverse that junction. 5° is a very large
angular error; you want to keep this below 1.5° if possible.

Command buttons: you have four actions you can take. X1 makes one pass over the track
sections at the current relaxation parameters adjusting the fit, and then displays the results. X5
makes five passes, adjusting the fit each time, and then displaying the results. Restore is used
when you decide you have hopelessly messed up the movable track sections, and want to get back
to the starting configuration. Press Done when you are finished and want to go back to laying track.
Press Help to bring up the help topic on relaxing track.

Procedure:

1. Select the track you wish to allow RR-Track to move in order to minimize joint mismatches.
It is usually a good idea to choose a few track sections on either side of the joint with the
biggest error; this is usually the point where the loop was closed (see closing track loops).

Select Relax Selected Track from the Action menu. The Relax Track dialog appears.

3. Set the Relax Track parameters as you desire and begin iterating the track minimization by
pressing either the x1 or x5 buttons. It is usually a good idea to start with large maximum
movements, and then steadily constrain the amount that RR-Track can move track. See
Relaxation Tips for more information and suggestions about relaxing track sections.

4. When the maximum track error has reached an acceptably low value, around 0.1 to 0.2
inches, or whatever you like, press the Done button.

For further information, study the Relaxation Tips topic.
Rotating track and objects

In order to rotate track or other objects, you must first select the track as you would in order to take
any actions. The Action menu on the main menu bar will then be enabled, allowing you to select
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the Rotate... item. After selecting this item, you are presented with a dialog like that shown at
left:

There are four primary control groups in the rotate dialog.

. .
= hrgle Direction The angle controls are on the left side, extending from top

C 7E(MB) & 45 | L to bottom. The direction controls are immediately to the

CADN/36e) O B | right of the angle controls, and at the top of the dialog.

; 12 ggﬁc&d : 675 1) -Fr;ftatg about | Immediately below the direction controls are the rotate

e WA o ?gu“[:j;]c] r_ Z!i':;r about controls, while below these, at the bottom of the
dialog, are the coordinate controls. There are four push

" other — Coordinates —

|— - aneoute || DUttons at the bottom labeled Rotate, Done, Undo, and

& relative Help... At the left bottom is a readout which displays the

- — relative angle that the selectejd items are rotated tlTrough.
——l —l —l Angle controls: when rotating track, or other objects, RR-
Track ‘thinks’ in terms of angles, expressed in degrees and

decimal degrees, just like those on a common school protractor. However, when assembling
sectional track, people tend to think in parts of a circle i.e. 12 sections to a circle, 16 sections, and
so on. The angle controls contain a number of preset rotation angles which may be selected by
pressing the button next to the angle you wish to rotate track. These span from 7.5° to 180°, and
are chosen to represent the angular arcs that most sectional track systems have. For convenience,
these preset angles are also labeled in terms of the fraction of a circle equivalent to the angle ( for
example, 15° is 1/24th of a circle, 45° is 1/8th of a circle, 90° is 1/4th of a circle). If the angle you
wish to rotate through is not found in the list of preset angles, you may select other. This action

puts up a text cursor in the box immediately below the other radio button, at which point you type
in your angle (in degrees).

Direction controls: you may also rotate track, or other objects, in either direction, clockwise (cw)
or counterclockwise (ccw). RR-Track defaults to counterclockwise, but clockwise rotations may
be selected by clicking the cw button.

Rotate about controls: you may also tell RR-Track the point you wish to rotate the objects about
(the center of the rotation circle). The choices consist of the origin and the center. The origin here
is the origin of the /lead selection. This will be the end of the track which is under the cursor when
the track is first added to the layout ( if you watch, you will see that new pieces of track have one
end at the mouse cursor). If you select center, the rotation will be about the center of the lead
selection.

Coordinate controls: finally, you may select whether the rotation you have chosen is to be
absolute or relative. Absolute rotations rotate the selected track to an angle in terms of the overall
coordinates of the track layout, i.e. 0° is horizontal running from left to right, 90° is vertical,
running from bottom to top, 180° is horizontal, but runs from right to left. Relative rotations rotate
the selected track by the chosen angle relative to the current angle of the track, not the overall
layout coordinates. For example, if you have track that is oriented at 45° and you choose a 30°
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counter-clockwise relative rotation, the new track angle will by 45° + 30° = 75°. Had you chosen a
clockwise rotation instead, the new angle would be 45° - 30° = 15°. RR-Track defaults to relative,
counter-clockwise rotations.

When you have finished selecting your rotation, apply it by clicking the Rotate button. The
selected track will be rotated to its new position, and the angle readout will be updated. When you
are finished rotating the selected items, press the Done button. If you need help while selecting
your rotation options, click on the Help button. Press the Undo button to remove any applied
rotations. When joined track sections are rotated, the track is rotated as a contiguous unit about the
origin or center, as chosen, of the lead selection. 1f items in the select list are joined to items not in
the select list, RR-Track will not carry out the rotation unless the allow track breakaways item in
the Global Options dialog is checked.

Procedure:

1. Select the track sections or other objects you wish to rotate.

2. Pull down the Action menu , and choose the Rotate... item.

3. Inthe Rotate Options dialog, click the radio buttons that correspond to the angle you wish to
rotate, the direction, the origin, and whether the angle is relative or absolute. RR-Track
defaults to counter-clockwise relative rotations about the track origin.

4.  Click the Rotate button. The selected track rotates to the new position. The Rotate dialog
stays up until you press the Done button to dismiss it. In this manner you can perform several
trial rotations to get the angle right before leaving the Rotate dialog. If you
want to return the track to its starting configuration, press Undo.

Another method: RR-Track also offers an alternative way to rotate items. You -

access this method by choosing the Rotate... command found in the shorthand menu

(the shorthand menu pops up when you put the cursor over and empty area and press {a30=

the right mouse button). When you choose the Rotate command from the shorthand 15302

menu, you will see the Quick Rotate dialog, shown in the figure at right, at the right IFone

edge of the active layout window.. EEE

The Quick Rotate dialog has most of the features of the standard Rotate dialog, and b

has a fader control that you can grab to rotate the selected items anywhere between =L

+ and - 180° from their current orientation. 350=
-450—

The readout at the top shows the current orientation of the selected items, relative to e

their starting orientation. The fader control has markings every 15° to aid you in e

positioning the slider. The slider only chooses angles that are integer multiples of yrire

the angle increment. The two buttons directly below the fader let you rotate the esns

selected items one increment in either direction. The middle left button, labeled 2.5° = 2820

in the figure, is the angle increment, and lets you toggle between the standard N

rotation increments, which are 1, 2.5, 5, 7.5, 15, and 22.5°. Each time you press the 25 ﬂl

angle increment button, RR-Track changes the angle increment to the next higher _help |

value, wrapping back around to 1° when you reach 22.5°. The label changes to
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indicate the current increment. The middle right button, labeled Org in the figure, lets you toggle
the rotation center between the origin of the lead selection (Org) and the geometric center of all of
the selected items (Ctr). RR-Track displays a 0 on the layout window to show the current origin.
To change origins simply press the button. When you are finished rotating the selected items, press
the Done button.

Procedure:
1. Select the track sections or other objects you wish to rotate.
2. Pop up the shorthand menu, and choose the Rotate... item.

3. Inthe Quick Rotate dialog, grab the slider and move it to the angle you wish to rotate
through. As you move the slider, the readout at the top shows the current angle. When you
release the slider, RR-Track rotates the selections by the angle displayed in the readout. You
can also rotate the selections in units of the angle increment by pressing the + and - buttons.
You can rotate the selections as many times as you like.

4.  Repeat step 3 until you are satisfied with the orientation of the selected items. You can
change the angle increment at any time by pressing the middle left button; you can toggle the
rotation center between the lead selection’s origin and the geometric center of all the selected
items at any time by pressing the middle right button. The Quick Rotate dialog stays up until
you press the Done button to dismiss it.

see also:
selecting track and objects, moving track and objects

Saving a layout file

The Save... command from the file menu allows you to save to disk the current layout. This
command will be grayed out if no changes have been made to the layout since either opening it or
saving it. After saving the file, RR-Track disables this command (graying it out) until a change has
been made to the current layout.

Procedure:

1. From the menu bar, select File and then Save as... from the drop down menu. If the Save as...
command is disabled (grayed out), there have been no changes to the current layout since
either opening it or saving it.

2. RR-Track displays the Windows Save File dialog. Using the drive and directory folder
icons, and the names in the file name listbox, you select an appropriate file name ( such as
myfile.rrt). You can also manipulate the file types icon in the lower left corner to change
between saving as a track layout file (RRT) or a Windows bitmap file (BMP).

3. When you are satisfied with the file name you have chosen, click the OK button to save the
current layout, or the Cancel button if you have changed your mind and wish to return to the
RR-Track main window.
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If you have chosen .BMP as a file type, RR-Track, rather than saving the layout, saves the current
screen image to a Bitmap file. This Bitmap file can subsequently be included in other documents
by either importing it, or copying it to the clipboard and then pasting it into the document.

see also:
opening a file

Selecting track and objects

Before you can do anything useful with track sections you have already placed in the layout, they
must first be selected. Track items must be selected before they may be moved, copied, cut,
deleted, rotated, joined, aligned, closed, and relaxed. Track selection is an action performed
entirely with the mouse cursor, but is modified by the enabling/disabling of the Selections Include
Joints item, the Selections Include Blocks item, and the Selections Include Grades item on the
Options menu. These properties are called extended selections. Extended selections occur when
you double-click the left mouse button instead of single clicking. The current extended selection
mode is denoted by a check mark in front of it on the menu. When the extended selection mode is
set to Selections Include Joints, then all of the track physically joined to the track under the cursor
will be highlighted when you make an extended selection. When the extended selection mode is
set to Selections Include Blocks, then all of the track sections electrically connected to the section
under the cursor are highlighted. This mode is very useful for checking the arrangement of
electrical blocks on your layout. When the extended selections mode is set to Selections Include
Grades, all of the track at the same height or on the same grade is selected.

Among track in the selected track list, the first track section is called the lead selection. This
section is highlighted with larger control points than the secondary selections, and drawn using a
double-width pen. The graphic below illustrates this:

Note that the leftmost section
has the large, filled squares
denoting its control points.

]| Circles denote points that are
joined, while hollow squares
are unused control points.
The lead selection is the track
section about which rotations occur, moves are referenced to, and which determines who is moved
to whom when aligning or joining track and there is more than one possibility for movement.

Selection may be carried out in two distinct ways. The first allows you the select all of the track
and general purpose objects in a rectangular region.
Procedure:

1. With the Windows arrow cursor showing (i.e. you aren’t in the middle of some other proce-
dure), position the cursor in an area where there are no objects or track sections, and you wish
to start the select rectangle.
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2. Depress and hold the left mouse button. The cursor changes to a diagonal arrow with the
word ‘Select’.

3. While continuing to hold down the left mouse button, sweep out the rectangle containing the
objects you wish to select. It will be drawn as you move the cursor.

4. When you are satisfied with the region you have drawn, release the left mouse button. All
track and other objects wholly within this region will be placed into the select list and
highlighted. The cursor returns to the Windows arrow.

Using this method, the lead selection will be the first track section found in the track list that is in
the region. Note that using the selection box does not select track that is not in the box, regardless
of the setting of the extended selection mode.

The second method consists of manually moving the cursor over each item you wish to include in
the select list. While slower than the first method at adding track to the list, it allows you to be
more precise.

Procedure:

1. With the Windows arrow cursor showing (i.e. you aren’t in the middle of some other proce-
dure), position the cursor over the track section or object you wish to select and click the left
mouse button. The object is highlighted in red.

2. To add objects or track sections to the select list, position the cursor in turn over the next
objects and, while holding down the SHIFT-key, click the left mouse button. The new object
is highlighted.

3. Repeat step two until you have highlighted the track or objects you wish to select.

You may both select and move at item in one operation by placing the cursor over that item, then
depress and hold down the left mouse button for 1/4 to 1/2 second. RR-Track will assume you
want to move the object(s) under the cursor, highlight them and then change to the ‘move’ cursor.
In this manner you do not need two separate mouse clicks to initiate moving an object.

Making extended selections

RR-Track has three different extended selecting modes which may be set by pulling down the
Options menu. These three modes are selections include joints, selections include blocks, and
selections include grades. These modes select all of the track physically connected, electrically
connected, and at the same height or grade respectively. To make an extended selection, you
double-click the left mouse button when over the first track section you want to select. Depending
on which extended selection mode is currently set, RR-Track will choose the track section under
the cursor and all of the others joined to it, modified by the extended selection mode. If more than
one track section is currently highlighted, and the left mouse button is double-clicked, RR-Track
collapses the selected track to only that track section under the cursor, regardless of whether the
multiple selections occurred because of a previous double-click or not. In other words, to return
multiple selections to only the track under the cursor, you can double-click when over this section
rather than manually deselecting track items using the SHIFT-left mouse combination. Identical to
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single-clicking the left mouse to make a selection, double-clicking and holding down the left
mouse button after the second click will cause RR-Track to change to the ‘Move’ cursor after 1/4
to 1/2 second. In this manner, a single double-click allows you to select a chunk of track and then
move it to a new location.

Changing the lead selection

In order to change the lead selection of track that has already been selected, position the cursor
over the track section you wish to become the lead selection and single-click the left mouse button.

Deselecting objects

To deselect items, position the cursor over the already selected object and, while holding down the
SHIFT-key, single-click the left mouse button. The object will be removed from the select list.

see also:
moving track

Setting Global Options

Selection of the global options item invokes a dialog box, like that below, which controls the
selection and deselection of features related to the display and response of RR-Track. Global
options consist of those items whose settings are
applied to all layout windows. This is in contrast to
local options (which you can get to either through

RR-Track global options
k layi

—Background color

: * spstem . .
e "1 & vehite the Global thzons dza?og or the Control Menu on
I¥ autn-rcings Innps  nff-white the layout window) which affect only that layout.
I proximity joining Displaywpe— | You access the Global Options dialog by choosing
I” confim al track joining | | = ygA colos the Options... command from the Options menu.
I" confirm al deletes - Rione
—Move delag time IR The cpntrols are grouped into sections which
& short(150ms) [ autosave lagout every || CONtain related features.
" long(500ms) 515 min . .
B - Track laying options:
reakaway distance 10 min A
9% of screen & 30 min allow track breakaways controls whether a single,
5% of screen joined track section may be moved without moving
©10% of screen all track joined to it. When a track section is
Set library colors... physically joined to neighboring track sections, it is
Set joining error... | Cancel | usually not in your best interests to allow the joined
Layout opiions... | Help... pieces independent motion. However, it is also

convenient to not have to manually break track
junctions in order to move some track out of part of
the layout (usually because you want to make some minor rearrangement). Checking this item
will lift this restriction. The default state is to prohibit the independent motion of joined track. If
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you do enable this option, you can break track away by selecting it and moving it at least 10 per
cent of the current screen size. If you do this, RR-Track severs the junctions between the track
ends and the rest of the layout automatically. If you don’t move the track 10 per cent of the screen
size, then RR-Track will not permit the track to be moved.

autojoin new track toggles the joining mode for newly added track between automatic and manual.
RR-Track can join track either automatically, or manually. If automatic joining is enabled, the
cursor will change to an arrow with the term ‘autojoin’ when a new track section is selected from
the Track menu.

When joining track automatically, which occurs only when placing new track sections, RR-Track
scans the track list for the closest available joining point (unoccupied track end) to the joining
points (track ends) on the new piece. As the left mouse button is released, the tracks are joined.
The best way to get the joint configuration that you desire is to move the new track section close to
the point you wish to join it, and RR-Track will proceed from there.

If automatic track joining is enabled, and you do not wish a new track section joined to the
existing track layout (for instance, starting a branch line, a second level, or an independent loop),
simply press the Escape key on the keyboard before you place the new track section. The cursor
will change to an arrow with the term ‘move’ indicating that automatic joining is not enabled. As
soon as the new track is placed, automatic joining will be re-enabled.

auto-close loops: toggles automatic loop detection and closing. When turned on, RR-Track
checks for loops whose free ends meeting the criteria for closing ( less than a track width apart and
aligned within 2.5° and physically contiguous) as each new track section is added to the layout. If
RR-Track finds a pair of free ends that meet these criteria, they are highlighted and you are asked
to confirm the closing of this loop.

proximity joining: toggles track proximity joining. When turned on, RR-Track checks all of the
ends non-joined ends of a piece or pieces of track when they are moved. If it finds unconnected
track junctions that are in close proximity with other track junctions (the proximity joining criteria
are 1/4 track width spacing and 2.5° misalignment) they are automatically joined. Proximity
joining is distinct from automatic loop closing in that the free track ends do not have to be physi-
cally connected through a loop (for instance, they could be the other pieces in a siding).

confirm all track joining toggles user confirmation for all track joining on or off. You may select
whether you wish to be consulted at every track joining operation. If you have chosen to confirm
all track joining, RR-Track will highlight the two track sections it is about to join, and draw a line
showing which ends will be used. If you wish to proceed, press the OK button; if you do not
accede to the proposed joining, then press Cancel and the joining will be aborted. Confirmation of
joining may become intrusive at times, especially when you are in autojoin mode,rapidly selecting
and placing track sections. Typically joint confirmation is turned off, and only enabled when in
critical sections.
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confirm all deletes toggles user confirmation for all track and objects deletions. If left off, RR-
Track will not ask for confirmation when you delete track or objects, unless you are deleting more
than 25 items, in which case confirmation is always required.

Background color:

These are set of radio button which allow you to pick the background color that RR-Track uses
when displaying the track layout. The choices are the system color, which you may set using the
Windows Control Panel, while, and an off-white color. All are standard system colors which are
available in any Windows display mode from 4-bit, 16 color VGA through 16.7million color, 24-
bit true color. If you find that white and off-white are too boring, then set some psychedelic color
of your own using the Windows Control Panel and selection the system color. Bear in mind that it
is of fundamental importance for the background color to allow the foreground colors, i.e. those of
the track and objects, to be easily discernible. This background color is the default color that is
used if no specific background color is chosen for the layout. You can override this by setting the
layout background color in the Local Options dialog.

Display type:

This set of radio buttons lets you choose whether you want the display colors associated with VGA
color monitors, or the set of colors chosen for monochrome monitors. The default setting is VGA
color, which is used for desktop systems. The monochrome setting is useful if you are using a
laptop machine with no color display.

Move delay time

You can choose whether you want a long delay (1/2 second) or a short delay (1/6 second) between
when you depress and hold the left mouse button down when selecting a track section, and when
the cursor changes to the “Move” cursor, letting you move the track. The way you want to set this
will depend on how adept you are at single-clicking, double-clicking, and in general using the
mouse cursor.

Breakaway distance:

You can set the size of the jitter for track breakaways by choosing either 2 per cent, 5 per cent, or
10 per cent of the screen width (previous versions of RR-Track were fixed at 10 per cent). The
breakaway jitter distance dictates how far a piece of track that is joined to other pieces of track
before RR-Track decides you really want to disconnect it.

Automatic layout backup:

If you want RR-Track to automatically create a backup file of your open layouts, check this box.
You can then choose the time interval for backups, from 5 minutes to 30 minutes. RR-Track will
create at backup file with the same name as the layout file, but with a file type of .RRB. Like
layout files, whose type is .RRT, backup files are registered with Windows 95 and Windows NT as
belonging to RR-Track. If RR-Track terminates prematurely, you most recent work will reside in
the layout backup file. If you close the layout normally, RR-Track deletes the backup file.
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Set Track Colors:
This command button calls up the Set Track Colors dialog, the same as if you had pulled down the
Options menu and chosen Set Track Colors. See Setting track colors for more information.

Set Joining Error:

This command button calls up the Joining Error dialog which allows you to set a gap between track
junctions to simulate junction expansions that you create when joining the real track on your
layout. For more information see Setting joining error.

Layout options:

This command button calls up the Layout Options dialog which lets you configure those settings
which are variable on a layout to layout basis. See Setting local layout options for more informa-
tion.

Other settings in RR-Track, principally those which control the appearance of the layout windows
and the appearance of the track can be configured on a layout to layout basis by using the local
options dialog discussed in the ensuing topic.

Setting local layout options

RR-Track distinguishes between settings that are applied to all layouts and settings that apply only
to the current or active layout. The settings which are configurable on a layout to layout basis are
generally those that govern the appearance of the layout in the layout window in distinction to
those which govern track laying.

Coordinate overlay:

RR-Track layout options [<]
ez Tay Spacing
;D:?:Z'f: = '_F::':;mi::'s (';"E“:g“sh This .control group ser the cqordina.te grid si;e.
© 24" gid lnos || " ct0sses € Motric 6" grid sets the coordinate grid to 6 inch spacing.
(" 48" grid lines | |  single point 12" grid sets the coordinate grid to 12 inch spacing.
(" no grid lines 24" erid sets the coordinate grid to a 24 inch spacing.
 Display items and symbol Miscell 48” grid sets the coordinate grid to a 48 inch spacing.
Fpomia Pt || Uselulfor large garden ayouts.
I conterabes P—— no gridlines turns off the coordinate grid.
E:::k";::is Coardinate color__| | [ The 6", 12", 24", 48”, and none grid size commands
¥ grade symbols under the Options menu also set the size of the coordi-
B  Setlayout dofauk | | pa(c grid displayed on the layout for view purposes only.
TGE ] cancel | Appiy | Hele.. | | The coordinate grid drawn when the layout view is

printed is identical to that displayed on the screen; this is
a change from release 2.3. In order to specify a 6", 12", or 24" coordinate grid, select the appro-
priate item with the mouse. A check mark will be displayed alongside the current grid size. If you
wish to dispense with the coordinate grid (which you may want from time to time), select the None
item. Note that setting the Units to metric will change these coordinate grid options to 10, 25,
50cm, and 1m respectively.
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Fine symbols
This control group sets the symbol used for the fine grid, which is drawn every 6 inches, and may
be toggled on or off with the display fine grid selection.

crosses uses small crosses as symbols
points uses single points as symbols

display fine 6" grid toggles the display of the fine-scale, 6 inch grid. The fine-scale grid is an
additional coordinate grid which may be include with main coordinate grid. Here points or
crosses, as specified in the dialog, are drawn on six inch boundaries to aid in locating and position-
ing track an other objects.

Units

You can set the measuring units to either English (using feet and inches) or metric (using meters
and centimeters) with these radio buttons. If you select metric units, useful for European track
systems, then all distances will be displayed in meters and centimeters.

Display items and symbols group:

detailed track render toggles the track rendering between simple and detailed. Track may be
rendered, both on the screen and the printer, at two levels of detail. When this option is selected
track will be drawn at full detail. This implied three-rail track drawn with three rails, two-rail with
two rails, ground throws or control boxes drawn for turnouts, guide rails, etc. All track types are
drawn at their actual size between the rails. To this end, O-gauge track will be 1.25" wide, G-
gauge 1.77"(45mm) wide, and standard gauge 2.125"(54mm) wide. At this time, ties are not
drawn. This detail, of course, requires additional time, slowing the display speed. From time to
time, especially on slower PC’s, you may wish to turn off detailed rendering. This reduces all track
sections to single lines, greatly increasing drawing speed at the expense of detail. Bear in mind
that even accelerated Windows video cards, while they are fast at rendering straight lines, are slow
at rendering curves. The longer the curves, the slower the rendering. This option may also be set
using the Detailed Track Render item on the Options menu.

Underneath the Detailed track render check box are two that are labeled Track and Objects. These
control whether track and objects are rendered or not. Checking the Track box renders all track
sections, while checking the Objects box renders all objects. The default mode is rendering of
both track and objects. Sometimes it is convenient to turn one or the other of these off for special
purposes (such as only showing track items). If both are left unchecked, nothing is rendered.

label track sections toggles whether track and accessories have abbreviated labels drawn centered
on them. The font used for the track labels is controlled under the Fonts menu.

block breaks toggles whether electrical block breaks are displayed. When they are visible, block
breaks are marked by a double circle.

solid joining symbols toggles whether the joining symbols between tracks are solid, filled circles or
outline circles.
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grade symbols toggles whether track on a grade is rendered with an arrowhead which points toward
the uphill direction of the grade. This useful to visually mark grades.

grade heights toggles whether elevated and grade track heights are displayed. When checked the
heights are shown using the same font as that used for track labels. The heights for track on grades
is given at the junction furthest removed from the elevated track sections. These will be the
heights track supports at these junctions.

Miscellaneous

The miscellaneous settings are the Snap To Grid and Snap Size, the layout background color, and
the layout coordinate grid color. Checking the Snap To Grid box is the same as choosing Snap To
Grid from the Options menu. When set, all items are moved about on an underlying grid whose
spacing is determined by the current snap size. The current snap size can be set by pushing the
Snap Size button.

A layout may have an individual background color which you can set by pressing the Background
color button. Pressing this calls up the Windows Color Chooser which you use to select a back-
ground color for your layout. You can also choose a coordinate grid overlay color different from
the default dark gray by pressing the Coordinate color button.

Applying settings

Pressing the Apply button applies all of the settings in the dialog to the layout; pressing the OK
button does the same, but dismisses the dialog while the Apply button leaves the dialog up so that
you can change more settings if you want. Set as default takes the current layout options, and
makes them the default options for any further layouts that you open.

Setting joining error

One of the sources of discrepancies between layouts designed with CAD software like RR-Track

and layouts you actually assembly is the accumulation of joining errors in track junctions. When

RR-Track joins two pieces of track, it joins them exactly with no gap errors. The reality of track

joinery is that is can be difficult to get pieces of track to join perfectly,

even if you use the assistance of special track joining pliers, or beat on it | Fer——=G—p—

with a hammer. For this reasons, RR-Track will let you set a constant ~Error

small amount of gap error in each junction, if you like. |
Cancel |

In order to set a non-zero joining error (zero is what RR-Track starts
with), you have to bring up the Track Junction Error dialog, as show at C0.05in
right. RR-Track displays the current setting of the junction error (it is set
to zero it start). You then choose your junction gap (0.20 inches or Smm
is the maximum allowed) and then press OK. Press Cancel if you don’t
want to change the error setting, and select 0.00 if you want to go back to no junction error.

Every track junction formed after you press OK will now include this amount of additional gap,
effectively lengthening the track by the amount of the junction error.
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Setting object properties

To set the drawing properties of general purpose objects, you use the Set Object Properties
command found on the Object menu. Choosing this command displays the following dialog:

The property setting controls are organized into

dth Style olor three groups: line width, line style, and drawing

® 1pizel H ® solid | === colors. A sample view of the current drawing
ancel

g 2:::2:2 g e line is displayed between the line width and

. e style radio buttons, while a sample of the
current outline and fill colors are shown to the
right of their respective buttons.

Line Width: these radio buttons let you select a line width of one to four pixels. RR-Track
defaults to one pixel on startup.

Line Style: these radio buttons let you choose between solid, dashed, dotted, and dash-dot line
styles. Note that only the solid line style is allowed for line widths greater than one pixel (this is an
internal Windows 3.x limitation).

Color: these two push buttons, one for outline or line colors and one for fill color, let you set the
object drawing colors. Pushing the appropriate button calls up the Windows Color Chooser, where
you may select the color graphically.

The Set Object Properties dialog has a dual-mode action, depending on whether an object is
currently selected (highlighted) or not. If no objects are selected, then the dialog displays the
current setting of the default drawing values, and any changes apply to the default values. This is
how you change the settings for future objects. If one or more objects are selected, then the dialog
displays the current settings for that object(s), and changes made are applied to those objects, but
not to future objects.

To change an existing objects drawing properties:

1. Select the object(s) using the cursor.

2. Pull down the Object menu and choose the Set Object Properties command. The Set Object
properties dialog appears.

3. Change any or all of the properties as you need, and then push the OK button.

RR-Track applies the changes to the selected objects, but they are left selected (highlighted)
in case you want to carry out some other action on them. To view all of the new changes (like
colors), deselect the objects by clicking the mouse somewhere else.

To change the default object properties for future objects:

1. Make sure no objects are selected (highlighted), and then pull down the Object menu and
select the Set Object Properties command. The Set Object Properties dialog appears.

2. Change any or all of the properties as you need, and then push the OK button.
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3. RR-Track applies the changes to the default object properties. These new defaults will be
used for any future objects.

The Set Object Properties dialog does not affect the manner in which track is drawn. When the Set
Object Properties dialog is opened with a grouped object, the starting object properties are the
current default values. If you press OK, the current settings in the dialog are applied to all of the
objects in the group; this effect is not reversible except by ungrouping the objects and resetting
them individually. The Set Object Properties dialog can be used to change the appearance of stock
objects such as trees and buildings by first adding them to the layout, and then changing their
properties with this command.

Setting track colors

You can set the colors of any, or all, track libraries by using the Set Track Colors command found
under the Options menu. When you do so, you will see a dialog like the one below:

The list box shows you all of the available

track libraries. Selecting one of these by
clicking on it with the left mouse will display

S HO tra Pencolor... | | the highlighted library’s current pen and fill
Curtis HiRail O track

Atlas HO track
LGB G-gauge track l— colors in the sample color boxes. To change
Lionel Super-0 track

[+

American Flyer S-gauge track +
AristoCraft G-gauge track ]

Lo KL .57 track the pen color, push the Pen Color button. Ina
similar fashion push the Fill Color button the
change the fill color. Both buttons call up the
standard Windows Color Chooser dialog. If
you want the change the color, select one of the standard colors and press OK, otherwise press
Cancel.

Double-clicking on one of the libraries in the list box immediately invokes the Windows Color
Chooser for the pen color, followed by the Color Chooser for the fill color.

To change the default track library colors, set the colors up in the fashion you wish using the above
instructions, and then press the Set As Default button. This writes your current settings to RR-
Track’s initialization file so that the next time you start RR-Track, these colors will be used.

Note: track library colors are not saved with the layout files, but are instead a property of the
application, and affect all layouts. Note further than putting track into a layer whose drawing and
fill colors have been set to something other than the default color, will render track in the layer
color, not the track library color. This is a way to have RR-Track draw separate loops of track in
different colors, or all sidings in colors different from the mainline.

Swapping switch machines

Some track libraries, notably Lionel® O and LGB® G allow you to change the placement of the
turnout switch machines after the track is laid. In order to change the side of the turnout that the
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switch machine is on, you use the track property inspector to examine, and change, the editable
properties of the turnout.

To change switch machine placement:

1. Position the cursor over the turnout whose switch machine you want to move, and click the
right mouse button. The track property dialog appears, showing the position, orientation, and
attributes of the turnout.

2. Find the swap switch machine check box (in the lower right quadrant) and click it with the left
mouse button to toggle it from cleared to set, or set to cleared if it is already set (note: if you
are not allowed to move this turnout’s switch machine because it does not have that capability,
this check box will not be present).

3. Press the OK button. RR-Track immediately redraws the turnout with the new switch machine
placement.

There is no limit to the number of times you may change the position of a switch machine.

for further information see:
finding out track and object properties

Tearing off menus

A handy feature of RR-Track is the ability to tear off any of the menus and leave them up on the
screen for quick reference. This is especially useful when used with the submenus associated with
the Track menu. These usually, but not always, consist of straight, curved, turnouts, and special
sections of track, and vary from track family to track family. If you have the screen space, you can
conveniently leave up the submenus for straight, curved, and turnout sections on the screen for
quick selection. To tear off a menu:

Procedure:

1. Pull down the menu you wish to tear off using the cursor and left mouse button as you
normally would.

2. Instead of selecting a command or item, move the cursor over the newly appearing submenu
and click the right mouse button.

3. A new window appears, with a small thumbtack in the upper left corner, the menu name in the
usually window name area, and the menu items in the main drawing area of the window. You
may position this window anywhere on the screen by putting the cursor in the title bar,
depressing the left mouse button, and dragging — just as for any window.

You select an item from the tearoff menu by clicking it with the left mouse button just as for other
menus. To dismiss a torn off menu, click the left mouse button with the cursor in the thumbtack
area in the upper left-hand corner. If a torn off menu has submenus associated with it (like the
main Track menu would), these may be torn off from the parent menu in exactly the same manner
as above.
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When you change track libraries, by selecting a new track system from the Options menu, all torn
off menus associated with the previous track family are destroyed.

Note: under Window NT 3.5, 3.51, and 4.0, tearoff menus are disabled since they do not function
correctly. There are some failures with repainting of tearoff menus under Windows 95.

Unjoining track sections

In the course of creating and modifying a track layout, you will have occasion to break previously
made track joints. The Unjoin command, found on both the Action menu and the shorthand menu,
is used for this purpose. This command breaks the connection between the lead selection and all
track sections joined to it unlike the Break Joint command which breaks only single, designated
track junctions. The unjoin command is useful when you wish to remove a track section that is
joined at several of its control points rather than one.

Procedure:
1. Select the track section you wish to unjoin with the mouse cursor.

2. Pull down the Action menu or the shorthand menu and select the Unjoin Selected Track
command.

3. The joints are immediately severed between the lead selection in the selected track.

Track may also be unjoined if you have the Allow breakaways option set in the Global Options
dialog and move the track at least 10 per cent of the screen size. See setting global options for
more information on this feature. The easiest way to unjoin a track section, if you have turned on
the Allow breakaways option, is to position the cursor over the track, depress and hold the left
mouse button until the ‘Move’ cursor appears, and then drag the track away, at least 10 per cent of
the screen size.

see also:
breaking individual junctions, moving track and objects, selecting track

Zooming in or out on the layout

You can change you scale at which the track layout is displayed by zooming in or out using the
four zoom commands found under the View menu, or the two zoom commands found in the
shorthand menu. The four zoom commands are: Zoom in 2X, Zoom in 4X, Zoom out 2X, and
Zoom Out 4X. Not all of these are enabled at any given time depending on the current zoom factor
as shown in the status window. The range of allowable zoom factors is 1 to 64.

Zoom in 2x: This command allows you to zoom in by a factor of two on the track layout. By
doing so, the current view becomes the last view, replacing the last view on the RR-Track view
stack.
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Procedure:

1. Select Zoom in 2x from the View menu. The cursor changes to a square with four inward
point arrows, and a zoom box representing a 2x magnification surrounds the cursor.

Move the cursor around the layout until you are satisfied with the location of the zoom box.

3. Press the left mouse button. The portion of the track layout inside the zoom box is magnified
until it fills the screen, representing a zoom in of 2x. The zoom factor in the status window is
updated to reflect the new magnification, while the cursor location is updated to reflect the
new cursor position. The scroll bars are also updated to reflect the new drawing position.
The cursor returns to the standard Windows arrow.

Zoom in 4x: This command is similar in action to the Zoom in 2x command, but instead zooms in
by 4x. By doing so, the current view becomes the last view, replacing the last view on the RR-
Track view stack.

Procedure:

1. Select Zoom in 4x from the View menu. The cursor changes to a square with four inward
point arrows, and a zoom box representing a 4x magnification surrounds the cursor.

Move the cursor around the layout until you are satisfied with the location of the zoom box.

3. Press the left mouse button. The portion of the track layout inside the zoom box is magnified
until it fills the screen, representing a zoom in of 4x. The zoom factor in the status window is
updated to reflect the new magnification, as is the cursor location. The scroll bars are
updated reflecting the new drawing position. The cursor returns to the standard Windows
arrow.

Zoom out 2x: This command is the reverse of the Zoom in 2x command, reducing the magnifica-
tion by 2x rather than increasing the magnification. When this command is selected, the center of
the current view becomes the center of the new view, while the horizontal and vertical extents are
doubled, bringing more of the layout into view. The status window is updated to display the new
current zoom factor. Like the zoom in commands, the current view becomes the last view,
replacing the last view on the RR-Track view stack.

Zoom out 4x: This command is the reverse of the Zoom in 4x command, reducing the magnifica-
tion by 4x rather than increasing the magnification. When this command is selected, the center of
the current view becomes the center of the new view, while the horizontal and vertical extents are
quadrupled, bringing more of the layout into view. The status window is updated to display the
new current zoom factor. Like the zoom in commands, the current view becomes the last view,
replacing the last view on the RR-Track view stack.
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Printing La youts

RR-Track can print your layout to any Windows supported printing device. These include dot
matrix, ink jet, and laser printers. They also include plotters that are supported by Windows, such
as those that understand the HPGL language from Hewlett-Packard. You may also print to any
device supporting the PostScript language. When RR-Track prints, it re-scales the drawing so that
all graphics is handled at printer resolution, not screen resolution. In general this results in higher
quality output and finer lines on the printer than is on the screen. The only exception is cheaper
dot matrix printers which have a resolution of 100 lines/inch or so, approximately the resolution of
the CRT display screen.

Setting up the printer

Selecting the Printer Setup command from the File menu causes Windows to display the Printer
Setup dialog for the current RR-Track printer. This dialog may also be accessed by selecting the
printer icon in the Windows Control Panel. The printer setup dialog allows you, among other
features, to select the orientation of the printer page (landscape or portrait),along with other
features specific to your printer. If you wish to change the RR-Track printer, you must Printer Info
dialog that is accessed from the Print Layout dialog. You can also setup the RR-Track printer
from the Print Layout dialog. For more information on setting up printers, consult your Win-
dows™ manual.

Procedure:

1. Select the Printer Setup command from the File menu. This displays the printer setup dialog
for the current system default printer.

2. Select the options you wish from the printer setup dialog, and click Close if you wish to retain
them, or Cancel if you change your mind and wish to return to the RR-Track main window.

Configuring the printer page layout

Selecting the Page Setup command from the File menu activates the page
setup dialog which allows you to configure the secondary features of the
printed version of the current view. The page setup dialog is shown  Other options
below: R Help... |
The check boxes control whether or not the printing credits are shown and

whether to print coordinate grid labels, and whether to show the track in black (the default), or to
print track in their set colors.

Prinier page layout

™ show layout credits
[ show coordinate labels

Procedure:
1. Select the Page Setup command under the File menu. This activates the Page Setup dialog.

2. Select the features which you wish displayed or excluded from the check box and radio
button groups in the dialog.

3. When you are satisfied with your choices, click the OK button to record these and return to
the RR-Track main window. Alternatively, if you have changed your mind and do not wish to
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change the page setup settings for the current view, select the Cancel button which immedi-
ately returns you to the RR-Track main window.

Note: if you elect to print track in color, be sure you have not chosen a dithered color for the track.
Many times printers will dither a drawing line color to non-existence, making the track disappear.

Printing your layout

A layout may be printed by selecting the Print Layout command under the File menu. When you
do so, you are shown a dialog such as the one shown below:

The Print Layout
dialog shows the
7 ]| name of the layout
Track font | and the printer it is
3200 1799 : Credits font... | going to in the
caption, has a layout
—Page selection

Frinter... | : :
@ preview window on

* only marked pages Page setup... | the left which shows a
—Change scale————— thumbnail view of

| 17.804 St scale | your layout as well as
e, | o | — an overlay of the

printer page mapping,
Help.. || readouts showing the
page sizes on both the
layout and the printer,
the current scale between the printer page and the layout, and command buttons that let you set
things like the fonts used for track labels and coordinates, the printer used, the appearance of the
printed page, and send the layout pages to the printer. When you print, your layout can be scaled
to fit on one page, or blown up to cover up to 64 pages. You have complete control over how
many, if any of these pages you actually print.

Print layout TEST1.RRT on Canon B.JC-4000

Layout preview

Layout preview: A numbered grid is superimposed on the Tayout proview
layout preview, depicting the printer pages required at the S 3
current zoom level. The example at left will be fully covered at
the current scale by using eight printer pages in portrait mode.
A given page is marked for printing if it is displayed in cross-

hatch; only those pages marked are printed. You mark a page
for printing by positioning the cursor over it and clicking the left mouse button.

To choose a page for printing:

1. Position the mouse cursor over the page you want to print.

2. Click the left mouse button to change the print marking. If the page was not marked for
printing, it will now be marked, and if it was marked for printing, it will now be cleared.
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Marked pages are not printed until you press the Print button.

Dimensions

Page sizes: this is an informational area that shows you the size of the area
that can be printed on both the printer page and what dimensions that
corresponds to on your layout. The ratio between these two is the scale,
which is shown to the right.

Printing Scale: RR-Track gives you a choice between automatically scaling
Change scale —————

the layout to the printer page to maximize the use of the page area in the
I 4.451 Set scale | . . . .
current page orientation (portrait or landscape), or printing at a fixed scale
2% |

which you select. When using automatic scaling (which is the default and is
shown at the left) the +2x and -2x push buttons allow you to increment and
decrement the zoom level by amounts of 2x, hence changing the scale by
amounts of 2 or 1/2. When you change the zoom level, all previously
marked pages will revert to unmarked since the page location will change. Zoom levels from 1 to
8 are allowed; a zoom of 8 results in 64 printer pages if you mark the entire

layout for printing. Hieme sl —

I 5.000  Auto-scale |
You can change to specifying a fixed scale by pressing the Set scale button. CAr C1e
When you do so, the scale section of the Print Layout dialog changes to look | s &1""
like that at right: Cat=z  Cid

Here you can use the radio buttons to choose fixed scales between the layout

dimensions and the printer dimensions. For example, in English units you have a choice of 1:1 (i.e.
17’ on the printer is 17 on the layout), 1:6 (1 on the printer is 6 on the layout), all the way up to
1:120 ( 17 on the printer is 10 feet on the layout). Any fixed scales which will exceed 64 printer
pages are grayed out and not accessible (most O-gauge layouts cannot be printed at 1:1 in 64 pages
or less). To go back to automatic scaling, press the Auto-scale button.

Page Selection: these two radio buttons control whether or not the entire
layout is marked for printing, or just individual pages. A/l pages marks the
entire layout, while selecting only marked pages lets you control which
pages are printed, by marking each individually as described above.

Page zelection
’7 " all pages

+ only marked pages

Command buttons

Print: depressing this button sends all of the marked pages to the printer for
Track font.__. | L. . .
- printing. You will see a dialog box that has a Cancel button to let you cancel
_Crodits font... | printing the current page. This will only work if pressed before the progress meter
Printer.__ | below the button makes it all the way to right; after that you cannot abort the page.
Page stup.. | Note that on some laser printers, you may not be able to press the Cancel button
quickly enough to abort the page.

Track font: depressing this button lets you change the font used for labeling track sections, if this
has been enabled using the Global Options dialog. See track fonts.
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Coords font: similar to the track font button, pushing this button lets you change the font used for
printing the coordinate overlay labels.

Page setup: depressing this button lets you set up the details of the page layout, controlling which
kind of coordinate overlay is used, whether a scale marker is displayed, and what kind of credits
are displayed

Printer: pushing this invokes the Printer Information dialog, shown below. From this dialog you
can change printers, reset the printer’s configuration, and preview where RR-Track will place
things on the page.

Printer Information: the Printer
Information dialog both lets you
set and configure the RR-Track
printer, but also previews where
RR-Track will place your layout

Camon BJC-4000 =

Phys: 11.0x 85
Size: 10.2x 8.0
Res: 360 x 360

MRG: D.12. 0.25

L <-Toggle | drawing and other items on the
Panter setup_.. | printer page. The caption shows

T o LFTT- the name of the current RR-Track

HP Laserlet 5P/SMP [HP) on \AHare\ printer.
HP Desklet 6BOC Series Printer on LF
HP DesklJet on LPT1: . . .
Smart Label Printer Pro on AT ortoize® The page preview window is the
large rectangular window at the
upper left. RR-Track draws the
paper size and orientation in
white, the printable area of the page outlined in dotted red, the area of the page used for the layout
drawing in cross-hatched red, the area of the page used for the coordinate labels in light gray, and

the area of the page reserved for the credits (at the bottom) in blue.

Canon BJC-4000 on LPT1:

Immediately adjacent to the preview window are a set of text displays which show you the current
settings for the RR-Track printer. These are: Phys, the physical size of the page in inches. This is
the actual size of the paper. Size: the printable area, in inches This is the maximum area that can
be used for printing. Res: the resolution of the printer in dots per inch (DPI). MRG: the horizontal
and vertical printer margins, in inches. Landscape or portrait: the current page orientation.

Available printers list: Immediately below the text displays is a list box of all the printers
currently recognized by your PC. The current RR-Track printer is highlighted. To change RR-
Track printers, double-click on the printer name in the list. RR-Track will switch to the new
printer, using the default printer driver parameters for starters, and show the new page preview
window and the new printer parameters.

Command buttons: the Toggle button lets you change between Landscape orientation and
Portrait orientation without going to the printer setup dialog. The Printer Setup button brings up
the Windows Printer Setup dialog for the current RR-Track printer. Using the Printer Setup
dialog, you can reconfigure the current RR-Track printer’s settings. Whatever you change will
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affect only RR-Track; other applications and the printer’s default settings are not affected. When
you are finished with the Printer Information dialog, press the OK button to return to the Printer
Layout dialog.

Printing tips

When setting up for printing your layout, or a portion of it, a bit of thought beforehand can be used
to set the size of the printed page used by the printer.

First, be sure you know the orientation of the printer page, as shown in the Printer Setup dialog.
Most mistakes occur when the page is set for portrait mode while you wished to print the layout in
landscape mode. Most printing is typically done in landscape mode since this best matches the
orientation and aspect ratio of the display screen. How RR-Track scales your layout to cover the
printer’s pages is in no way connected to the scaling used on the display.

In order to create a PostScript file (in this case an Encapsulated PostScript or EPS file) so that you
may take the drawing output to some other device not connected to your PC, you must employ a
small trick to make Windows create such a file. Go to the Windows Control Panel and double-
click the printer icon. The Printer dialog comes up. If you do not already have a PostScript
compatible printer set up, then press Add and select a PostScript printer from the drop-down list
box that appears. Make this printer the current default printer. The press Setup, which gives you
the Printer Setup dialog. Press Options and, in the control group governing output, select Encapsu-
lated PostScript. Be sure and give Windows a file name for the output file. Then press OK all the
way back. You default printer will now be set to a PostScript device, with the output going to a
PostScript file. Be sure and reset the default printer when you are done printing the PostScript file.

If you are printing to a printer other than a laser printer, be aware that an RR-Track printout is a
large, graphical object, and can take a long time to print on your PC, even with a Pentium proces-
sor. Typically ink jet and dot matrix printers have no on-printer rastering engine, and rely on the
host PC for all of the rendering. If you have a Canon BJC color printer, for example, and set it for
the best resolution and diffusion dithering for the nicest color appearance, a single page can easily
take 20 minutes. Once the progress meter in the Cancel dialog has gone all the way to the right,
you cannot abort the printing job except by manually resetting Windows printer queue.
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Miscellaneous

Track library initialization files

Each track library has an associated .INI file. For example, the American Flyer library, rrtamf.dll,
has a file amf.ini associated with it. All of the current libraries and their associated .INI files are
shown below:

Each of these initialization files may be edited using the Note Pad editor included with Windows
(NOTEPAD.EXE, usually found in your Accessories group). If you choose to edit these files with
a word processor such as Microsoft Word, WordPerfect, AMI Pro, or whatever, be very careful and
save the edited file as ASCII text

only. If you save it in the word Track libraries

processors native file format, RR- Lionel®/K-Line® O-gauge LNLREGO.INI
Track won’t be able to read it, and W50 /K Line® 027 gauge LNLO27.INI
all of the track prices will default to Curtis HiRail O-gauge CHRGG INI
zero. The track library initialization F - == " 0 ROSSCS INT
files are divided into four sections: GarGraves® O GARGRVINI
[straight track], [curved track], Lionel® Super-O gauge SUPERO.INI
[turnouts], and [special track]. For LGB® G-gauge LGB.INT
each type of track supported by the MicroEngineering® G-gauge MEC.INI
respective library there will be a line g7 —=mre G-gauge ARISTO INT
with an entry like Llagas Creek G-gauge LLAGAS.INI
s10= TDV G-gauge TDV.INI
American Flyer/GarGraves S-gauge | AMF.INI
with a decimal number reflecting the F 7o /Rydin std gauge STDG INI
price in dollars (RR-Track doesn’t Atlas® HO gauge ATLASHO INI
convert between currencies, but you fyeooe el e S auge MARKMHO.INT
could put in the price in pounds Marklin® -K HO gauge MARKKIIO INT
sterling, deutche marks, lire, or Mirklin® -C HO gauge MARKCHO INT
whatever and ignore the $ symbol). Hornby® OO/HO gauge TORNBYTO INT
Simply change the price to reflect Peco® OO/HO gauge PECOHO INI
the price you can purchase this track gm0 Fauge SHINGO.INT
section for. The track types are the W Rirech/pi® code 100 HO PILZ100.INI
abbreviated names that are used RailTech/Pilz® code 83 HO PILZS3.INT
when the track sections are labeled RailTech/Pilz® TT-gauge PILZTTINI
on the screen or when printing (such e N-gauge - ATLASN INI
as LGB:s1000 for an LGB® #1000 Kato® UniTrack® N-gauge KATONINI
straight section) without the Peco® N-gauge PECON.INI
prepended track family name. Tomix N-gauge TOMIXN INT
When you are finished with editing Marklin® Z-gange N ARKLINZ INT
the track prices, save the file and Peco® Z-gauge PECOZINT
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then restart RR-Track. RR-Track only reads the price information on startup. You can also change
track prices immediately by going through the Track Properties dialog (see Finding out about
track and objects for more information).

For Lionel® accessory
libraries, the abbreviated track Accessory libraries
type is the Lionel® part Lionel® pre war accessories ACPREWAR.INI
number (i.e. 300 for a Hellgate | Lionel® post war accessories ACPSTWAR.INI
bridge, 164 for a log loader, Lionel® modern accessories ACMODERN.INI
etc.). Plasticville® accessories PLASTIC.INI

. . American Flyer accessories ACGILBRT.INI
Note: for some tl‘aF:k libraries Piko® G-gauge accessories ACPIKOG.INI
there are more sections than Pola® G-gauge accessories ACPOLAG.INI

are mentioned above. There is
also a section for the default library color, as well as sections for other internal parameters.

Tips and sug gestions

Manual track joining tips

There are instances when automatic track joining is insufficient to achieve the desired track
configuration. In these cases, you must fall back to manual track joining, which is similar to what
you do with your hands when you join two pieces of sectional track (there is no analog for auto-
matic joining).

The simplest method is to move the track sections while turning on automatic track joining. When
you do this, all you have to do to join the track sections is bring the ends you wish to join within
one track width of each other ( 0.625 inches for HO-gauge, 1.25 inches for O-gauge, ctc.). See
moving track for additional information.

The second simplest method relies on the join to nearest track command which may be found both
on the Action menu and the shorthand menu called up by the right mouse button.

Procedure:

1. Highlight the track section you wish to join by selecting it with the mouse.

2. Place it close (or at least closer than any other un-joined track site) to the track section you
wish it joined (see moving track or objects).

3. Select Join To Nearest from either the Action or shorthand menu. The track will be joined,
unless RR-Track can find no unoccupied, free, joining sites that are not already connected to
the track section(s) you have decided to join. In this case you will be informed of the error,
and no joining occurs.
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Relaxation tips

Relaxing track to get good closure and minimize mismatch is a subject that could be discussed for
many pages. Suffice it to say that the quickest and best minimization’s occur with a combination of
RR-Track computation and input by you, the user. Here are a few tips to help you out:

(1) Don’t expect to make up 3 inches of error with only three sections of track. There is a
limit to how much ‘slop’ each section of track can absorb and you will have to be the judge of what
that limit is. If you don’t mind a lot derailments, and having track come apart under the pounding
of the trains, then perhaps you will be comfortable with 0.2" per track section (this is close to the
physical limit given the size of the connecting pins). If you like smooth operation, then you will
want to get the track ends as close as possible to the ‘ideal’ condition (zero mismatch) as you can
before you started relaxing the track.

(2) Choose track sections on both sides of the closure point. If you have a joint mismatch of
1.0inches, and select six track sections on the right side for relaxing while only one on the left, then
most of the error will have to be made up by moving the six sections leftward. This will both take
longer and be less accurate. If possible, put an equal number of track sections on each side of the
closure point.

(3) Don’t choose too many track sections. Each track section represents three ‘degrees of
freedom’ to the relaxation engine. If you choose 25 track sections for relaxation, then the relax-
ation engine will have 3 x 25 = 75 different ways to manipulate the track sections. It is a funda-
mental theorem of numerical computation that the more freedom you give a system of objects, the
less sensitive the system will be to achieving the correct solution. Of course, you have to consider
the comments of (1) also; you can’t choose too few track sections either. I have successfully used
up to 18 track sections, but a better working limit would be 8 or 10.

(4) Start out allowing large maximum track displacements ( in the Relaxation Constraints
group), and then steadily rein the process in. Usually the first few iterations can be run with
everything ‘wide open’ (i.e. 0.5" displacement, allow both rotations and translations, etc.). Then
begin to close the maximum displacement down, first to 0.25" and then 0.1". Usually, by the time
the maximum track error is less than 0.5" you can set the maximum displacement at 0.1". At this
stage you can take iterations five at a time using the x5 button.

(5) Pay attention to the final error report. Ifthe residual track mismatch energies are low (at
zero error you would have zero energy) but one of the tracks has an angular error of 6°, you are
likely to have derailments at that junction. You may have to back up and start over, repositioning
some of the track sections (this can be done manually by using the Allow Individual Moves control
in the Global Options dialog).

The more relaxation of track mismatches you do, the more adept you will become at this process
which is as much an art as it is a science.
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General tips

(1) Use the zoom-in and zoom-out commands and the view stack. I have found it to be
effective to start with a large overview, not necessarily of the entire layout but a large fraction of it,
and then zoom in to where I want to do some work, the return to my overview using the Last View
command under the View menu. Occasionally I move around the layout at high zoom factor using
the scroll bars, but I find this less effective.

(2) Don’t always work with Selections Include Grades turned on. The problem with this
option is that it will only choose track either on the same elevation or same grade as the track under
the cursor (when you double-click). I generally work using the extended selections set to Selections
Include Joints since this is the most general purpose of the three, and only change to one of the
others when I need to.

(3) Use Align to Nearest Track. A use this command, under the Action menu, to find out where
to place a curve when I am closing a loop, or lining up turnouts, to place a couple of long straight
sections on both sides of the closure point, letting them overlap and graphically show me the
intersection. I can then place the curve or turnout I need pretty accurately by the ‘calibrated
eyeball” method, especially if you zoom in on the intersection. Be wary of zooming in too far on
curves though; Windows graphics engine has trouble if the center point of a curved arc is too far
off screen, and throws in the towel by not drawing the arc, leaving you with nothing to show you
the location of the curved section. When done, just delete the unneeded alignment tracks, and
replacement them with properly cut sections.

(4) Work with AutoJoin turned on. I always use the AutoJoin mode, and override this as
necessary by hitting the escape key as needed, to temporarily turn AutoJoin off. Move the ends
you want joined as close as possible, and then click the mouse. AutoJoin can fail if you are trying
to add track in a densely populated area with a number of loose ends; sometimes the end you
aren’t watching is closer to another section of track than the end you are watching.

(5) Make use of Copy, Paste, and Duplicate. I use the Copy/Paste combination frequently to
duplicated single or multiple sections of track that I will be adding several times (such as yard
lines), and use the Duplicate command to replicate track sections that I only need one or two
copies of (such as 90° and 180° curved arcs of track).

(6) Add elevations and grades last. It is usually better to design all, or almost all of the track
plan before you begin raising/depressing track sections. Introducing elevations and grades always
adds to the complexity of the layout, and makes it more difficult to change design parameters later
(short of removing the entire elevation, which you can do by either using the Remove Elevation
command or Zero Track Height command).

(7) Use multiple drawing layers. Setting up even simple, small layouts with multiple layers is a
real help. You can put scenery in a layer, accessories in a layer, track in a layer. In this way you

can set the track layer to inactive so that you can see it but you can’t select it so that it doesn’t get
in your way when you are setting up accessories and scenery. This same thing is true for scenery:
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you can draw some scenery, then set that layer to inactive, and then adjust track and/or accessory
positions as necessary without the scenery getting in the way.

(8) Use the track wizards. Even if you don’t agree with the solution that the wizard comes up
with, especially when using stock track, it is a starting point which you can then manipulate to get
something more in line with what you want. The track wizards will always seek to use the largest
radius curve they can fit it whether you choose stock curves or radius curves. The wizards allow
you to rapidly close loops and gaps in complex track configurations simply by snapping a measure-
ment to the track endpoints.
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Appendix
Tutorial on custom curve design

If you are using a track library where flexible track (usually referred to as FlexTrack) is available,
such as Curtis/Ross/GarGraves® for O-gauge or LGB® for G-gauge or Atlas for HO gauge, it
speeds up the layout process to use the existing tools in RR-Track to reduce the trial-and-error
component of bending your own curves. The following is a quick tutorial on methods I use for
designing custom curves. Of course, you still have to bend the track to the design specifications,
but that is another story.

We will use a typical scenario, a turnout to a parallel siding on a thru-track, as shown below:

For this example I have used
— | Curtis/Ross/GarGraves® track in

110 24l40" 200" 0O-gauge, but the principles apply
,//—/‘:_ﬂ"/‘: 500" | jyst as well to other gauges.
< Using the ruler function, the
separation between parallel
tracks is 5.00 inches (close to the O-gauge working minimum), and the separation between the
turnout and the parallel siding is 24.49 inches horizontally and 3.00 inches vertically. The turnout
is a Curtis/GarGraves® standard turnout, with a separation angle of 11.0°. So, to start we know we

need a right-hand bend of 11°, with a total length of around 25 inches.

The next step is to set up two tangents so we can construct the curve. For this purpose I use
GarGraves® 36 inch straight sections, and temporarily join them to the two free ends of the siding
as shown below.

The next step is to use the
1 E measuring tool to measure
/” YT along the tangents from the
15.70% track ends to the intersection
point, to see which is the
longest leg, and to get an idea
of the total arc length. These two measurements are shown in the example; 9.01 inches on the

short leg from the siding to the intersection, and 15.70 inches from the turnout to the tangent
intersection (it helps to zoom way in to make these measurements).

This tells us that we will construct the curve out of two sections of track: a curve with an arc
length of approximately 18.0 inches ( 2 x 9.01) and an arc angle of 11°, and a straight section about
6.7 inches ( 15.7 - 9) in length. Before building and placing this curve, highlight the temporary
straight that is connected to the parallel siding (the upper one) and delete it. Then, to get the curve,
select the Custom Curve command under the Curtis/Ross curves section of the track menu, and set
the following values in the dialog: length 18.0 inches, angle 11.0°, direction RIGHT. Attach this
trial curve to the siding as shown below:
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The new curve is shown in
red for clarity. Zoom way
in and closely examine the
free end of the curve to see
how well it lines up with
the temporary straight
joined to the turnout (in this example more than good enough). Now use the measuring tool in its
snap-to-track mode (ALT-key) to measure the distance between the free end of the curve and the
turnout: 6.72 inches.

T
L

Before building this cut straight, delete the last temporary GarGraves® straight connected to the
turnout. Then select the Custom Straight command under the Straight section of the track menu,
and choose 6.72 inches for the length. Press OK and join the new straight track in the gap between
the siding and the turnout. The final assembly is shown below:

!

custom straight

CUSToM curve

o =

with both the new curve and the new straight indicated. Adding up the straight and curved
sections, we have a total track length of 6.72 + 18.00 = 24.72 inches. While this was a particularly
simple example, bear in mind that any gap may be closed using a combination of a custom curved
track and a straight track.

Designers with track libraries of Curtis HiRail, Ross Custom . =
Ross Custom Switches tunout biansition curve B

Switches, or GarGraves Trackage will find some special track

Tuinout

sections in these libraries. These are called Turnout Transition : E(.:)";eg':'e haeng
tracks, and are compound track sections consisting of a unified inmm w04
straight and curved section that will bring out the spur for some | peniars | | O 45"

of the prototypical turnouts to fixed track centerline spacings. () Premier g | | 050"

When you choose a Turnout Transition track, you will see a o it O other

dialog like that at right: 0 right - E

Select the turnout you want to create a transition track for by

using the radio buttons in the Turnout group to the left, where

you also choose whether this track is to fit a left or right-hand turnout (not a left or right-hand
curve). Choose the centerline spacing you want using the radio buttons in the Centerline Spacing
group: choose other and then manipulate the up/down spin buttons to get a spacing other than the
fixed ones shown. Press OK when you are done, RR-Track calculates the required track angles
and lengths and places the new track section under the cursor as for any other track section. Press
Cancel if you don’t want to add a turnout transition track. Turnout transition track sections are
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created using a combination of an O-80 (40 inch radius) curve of the required arc length for the
chosen turnout and a straight track section of the required length for the requested centerline
spacing. Note: in track libraries that contain track wizards, the entire above procedure can be
automated simply by snapping a measurement between the track ends and choosing one of the
available track filling methods.

Creating benchwork

Many layouts are not strictly rectangular in shape, but are L-, C-, or U-shaped, or some more
complex arrangement. It is a good idea to draw in the boundaries of your benchwork in order to
act as a guide for laying the track. RR-Track will not stop you from laying track outside of the
bench work boundaries, but at least you will be able to see where the edge of the layout is sup-
posed to be.

We will start with a 20" x 12' layout which is composed of 4' x &' sections; you could use any sizes
but these will illustrate the basic idea. Start by creating a 4' x 8' unfilled rectangle. First, to make
things easy, pull down the Options, select the Snap Size command, and choose a snap size of 6
inches. This will restrict the rectangle’s size and position
to 6 inch boundaries, making it easy to both create and
place it. Next, let us create a benchwork layer. Pull down
the Options menu again and choose Layers..., and then
add a layer called ‘benchwork’. Before you close the
layers dialog, make the benchwork layer the working layer
by double-clicking on it. Then pull down the Objects
menu and select Basic Shapes|Rectangle and create a 4' x
8' rectangle, as seen at left:

I have set the rectangle color to blue, and the line size to 2 pixels to make it easier to see; you can
do this or not as you like. Next, duplicate the first
rectangle by either drawing another (repeating the process
previously described), or by selecting the rectangle and
choosing the Edit|Duplicate command. Then rotate this
rectangle by 90°, and place it so that the two rectangles
look like that at right:

Now, duplicate the 4 x 8 rectange three more times, and
create an additional 4 x 4 rectangle and place as shown.
Note that we
have a perimeter layout, 4 feet deep everywhere with a
total length of 32"

In order to get more usable space for inside curves, I have
added small 45° sections to the three inside corners. Next,
create a new layer, just like you did before, but call it
‘walkway’, and make it the working layer. Then, keeping
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the snap size set at 6 inches, draw a filled polygon (by pulling down the Objects menu and select-
ing Basic shapes | Filled polygon ) that covers the space not covered by the 4 x 8 tables. When you
are done, you should have something about like that shown below where I have colored in the
walkway light gray.

To make the walkway become a non-selectable back-
ground, pull down the Options menu and choose
Layers... When you see the Layer Setup dialog, double-
click on the ‘benchwork’ layer to make it the working
layer, and then set
the ‘walkway” layer e
to inactive as shown Hﬁym‘ﬁ_ ‘

at right:

Now we are going to go into one of the 4 x 8 rectangles
and draw in the actual bench structure. Zoom in on one of them and set the Snap Size to 0.5
inches. Then draw a vertical, filled rectangle that is 48 inches tall and 1.5 inches wide (this is the
dimension of a standard milled 2x4 stud). Duplicate this four more times (either by using the
Duplicate command or by using Copy and then Pasting four times). You should end up with
something that looks like that at left. I have colored the 2x4 structure brown, but you can color it
anything you like. Next, create a pair of horizontal 96 x
1.5 inch studs and place them at the top and bottom of the
4x8 rectangle. Finally, draw in four 1.5 x 3.5 inch
- nominal 2x4 legs and you should have something like that
_ atright.

_ Here I have
. placed the legs
. in the corners
and then
grouped the entire assembly into one unit (you group
objects by selecting them and then pulling down the
Action menu and choosing Group objects). Grouping it

& : ]

is required if we are to replicate it and place it
in the other positions. Now, select the com-
pleted bench section and replicate it four more
times, replacing the other 4 x 8 bench sections
= you already made. You can paste in a fifth 4 x
8, then ungroup it, edit it, and regroup it to
make the single 4 x 4 section at the lower right.
When you are done, you should have something
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like that at left {bml bench08.bmp} As a final step, you can pop up the Layer Setup dialog (either
by going back to the Options menu or double-clicking on the layer pane in the multifunction status
bar) and change the ‘benchwork’ layer to hidden so that it is out of the way and you can begin to
lay track in a new layer that you may want to call ‘track’. That is left as an excercize for the
student. If you are using ‘L’ girders rather than 2x4s, then just draw in the top dimensions of the
girders rather than the 2x4°s that [ used. You can draw the benchwork to any level of detail that
you want, and nothing stops you from also including a benchwork wiring layer, or any number of
wiring layers up to the layer limit of 64 total layers.
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Software License

RR-Track™ 3.02 copyright 1994 - 1997 by Russell S. Becker
R & S Enterprises
all rights reserved.
all versions

License agreement: This is a legal agreement between the purchaser and R & S Enterprises, a private
company under the laws of the Commonwealth of Pennsylvania. If you have purchased a licensed version
and do not wish to abide by the terms of this agreement, return the diskette and all accompanying items,
manual, etc. to R & S Enterprises for a full refund.

Use of this application for any period of time implies acceptance of the license terms. RR-Track™ is only one
possible method for toy train layout construction. No claims beyond those explicitly stated are made for the
accuracy of this software. This application is provided AS IS with no warranty expressed or implied.

A single user license permits users to use RR-Track™ only on a single computer. Licensed users may use the
program on different computers as long as the program is not used on more than one computer at a time.

Site license or network use requires a separate license. No one may copy or distribute any portion of the
registered documentation, files, or executables except for registered users with the express purpose of
backing up these files for personal use on a single computer.

Notice of copyright: This is a copyrighted program. This version is copyrighted by Russell S. Becker and
has full protection under United States and international copyright law. This program is to be sold only under
written agreement between R & S Enterprises and the distributor. This program is licensed for use only by
the purchaser on a single computer. Copying, distribution, or use by any person, business, corporation,
government agency or any other entity without explicit written permission from R & S Enterprises is strictly
prohibited and may subject the user to prosecution under copyright law.

GENERAL TERMS: R & S ENTERPRISES HEREBY DISCLAIMS ALL WARRANTIES WITH RESPECT
TO THIS PRODUCT, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. SHOULD THE
PRODUCT PROVE DEFECTIVE IN ANY WAY THE PURCHASER ASSUMES THE RISK OF SERVICING,
REPAIR, CORRECTION, INCIDENTAL, OR CONSEQUENTIAL DAMAGES.

LIMITATION OF LIABILITY: RR-Track™ IS PROVIDED COMPLETELY AS IS. R & S ENTER-
PRISES HEREBY LIMITS ITS LIABILITY TO, AT R & S ENTERPRISES’ SOLE DISCRETION 1) THE
ORIGINAL PURCHASE PRICE OF THE SOFTWARE OR 2) REPLACEMENT OF A DEFECTIVE DISK.
PURCHASER OF SOFTWARE AGREES NOT TO HOLD R & S ENTERPRISES AND IT’S OWNERS
LIABLE FOR ANY DAMAGES WHATSOEVER BEYOND ONE OF THE TWO REMEDIES DESCRIBED
ABOVE. FOR REFUND OR REPLACEMENT, RETURN YOUR DISK TO THE ORIGINAL PLACE OF
PURCHASE.
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